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Chapter 1 Introduction

Chapter 1 Introduction

PediTree is a database management program designed specifically for genealo-
gists and family historians. The facilities it provides can be grouped into three
main categories:

Data Entry: feeding information into PediTree from the keyboard or from
another file, for instance a GEDCOM file.

Data Analysis: finding out new facts about family relationships by giving
PediTree the task of analysing your research, by searching and sorting.

Display: printing tables, charts and trees that show the results of your research.

A database is ‘a collection of related information’. The contents of a card index
is a database; a family tree is also a database because it contains pieces of infor-
mation that are related, in this case by family links. A family tree database may
be extended to include photographs and other related information, perhaps sound
recordings. It can also contain associated source information from which the
family tree has been constructed, such as details of certificates, parish register
entries and census returns. There is more about PediTree’s databases in chapter 2.

A About this Manual

This is a reference manual about the features and operation of PediTree, which
assumes you have installed and become familiar with the basic operation of the
program. There is a separate Getting Started Guide that describes how to install it
and provides two hands-on tutorials to introduce you to the program and the way
it works.

Having reached some familiarity with PediTree, then this manual provides infor-
mation in depth about its operation and facilities. It starts off with a chapter about
Pedigree Software’s Family History Databases, with particular reference to the
design that is supplied as a basis for your own information storage. Next come
suggestions about how you can use this design to store your own information.

PediTree’s unique flexibility comes from the technique it uses to display informa-
tion from its database, either on the screen or in printed form. This flexibility is
provided by its own script language, used both in displaying the information and
in selecting record(s) to be displayed. This script language is described in a chap-
ter on Picture Scripts and Expressions.

You will know that PediTree uses a number of different displays (or windows) to
view and manipulate the stored information. The three principal such displays fea-
ture in the next chapters about the Family display, the List display and Editing
Records. Within these displays, PediTree makes extensive use of context-sensitive



Chapter 1 Introduction

or pop-up menus. These are obtained by clicking the right mouse button on the
display area in question; they are all documented in these chapters.

Here is an annotated view of PediTree’s main display that identifies the principal
elements.
Main Menu Toolbar
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Other more general operations are provided from a conventional Windows main
menu across the top of the screen. The main menu entries are all described, as are
the functions they provide that are not already covered in the discussion on dis-

plays.

Aspects of printed output are covered in the next three chapters, about Ancestor
and Descendants Charts, Reports, Tables and Trees. The matter of exchanging
Family History information with others is the concern of the GEDCOM standard,
which gets its own chapter.

Finally, a number of miscellaneous matters are covered in appendices.

B Reading this Manual

To help you read these instructions, some typographic conventions are used
throughout to distinguish elements in the text:

Names of windows; menu choices, etc.
Things you type, and the text of picture scripts.
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The common operation of working through cascading menus in Windows is
depicted as, for example, Start > Programs > Pedigree > PediTree .

C Getting Help

As is usual with a Windows program, comprehensive on-line help is available:
From the main Help menu
By clicking on Help buttons in some places
By pressing the F1 key
In the Edit display, by right-clicking on a field name.

The last three produce help relevant to the context in which they are used. The
on-line help has the usual Contents list and Index to assist you to find information
about matters of interest. The on-line help is likely to be more up-to-date than the
printed manuals.

Pop-up hints appear as the mouse pointer is moved over the various display ele-
ments.

Contacting Pedigree Software

If you are unable to find the answer to a question from the manuals or on-line
help, or if you encounter a fault in the program, then please contact the author and
supplier, Murray Kennedy. Have available details of the version of the program
(from Help > Version); the database version (from Options > Definitions) and the
version of Windows you are using.

Email: MurrayKennedy@btinternet.com

Telephone: 01386 556649

Fax: (none)

Post: Pedigree Software, The Granary, Ryelands,

Wyre Piddle, PERSHORE, WR10 2JG, UK
Pedigree Software’s web-site provides news of latest versions and upgrades:
http://www.pedigree-software.co.uk/

Pedigree Users Group

This flourishing users’ group provides a quarterly newsletter, an e-mail discus-
sion list and has many members who are pleased to help users in their locality.
More information is available from their web-site <www.pugweb.org.uk>, or the
Membership Secretary, 19 Lombardy Close, Leverstock Green, Hemel Hemp-
stead, HP2 4NG, England, email <membership@pugweb.org.uk>.

10



Chapter 2 Family History Databases

Chapter 2 Family History Databases

A Introduction

PediTree stores your family history information in a database. You can have a
number of different databases, but only one at a time can be used by PediTree.

Two databases are supplied with PediTree, each of a different design: Royal03,

used for a tutorial in the Getting Started Guide; Elton55as a basis for your own

databases. Elton55 has some information stored in it, but PediTree provides the
means to create your own empty database from Elton55.

Pedigree Software’s databases are specially constructed to hold family history
information. Such information is primarily about relationships between people.
Each person has two parents and any number of marriages (or partnerships), each
of which can result in any number of children. These databases record people,
marriages and the links between them. You don’t have to worry about how this is
done — the program does it for you — but knowledge of the link arrangements will
be useful to you when using PediTree.

Each database design incorporates several types of record, each with its own
fields to hold the information. The design also specifies how the information is to
appear on the screen or in printed form. The mechanism for this, called picture
scripts, is the subject of chapter 4. Both the database design (in terms of record-
types and their fields) and the associated picture-scripts can be changed to give
modified or new designs.

The database design is stored in a file named control.ged that resides in a folder
with other database files (see chapter 13 section D for more on files used).
Although this file has the file-type .GED, it should not be confused with other
GEDCOM files of the same type that can be exported from and imported into
PediTree. File control.ged contains no family history information.

Types of Record

PediTree’s databases have at least two types of record: Person records and Mar-
riage records. (By convention, PediTree documentation always capitalises record-
types.) These hold information about individuals and their families respectively.
There are usually more types of record. In Elton55, for example, there are also
Source records holding information about the documents that have provided the
information about individuals and their families, and Census records for details
from 19th/20th century census returns. It is possible to define and use up to
seven types of record in one database. In fact, Pedigree Software’s databases can
be altered in many ways to suit your particular needs, if the designs provided
prove to be inadequate.

11



Chapter 2 Family History Databases
Records and RINs

Each Person record holds information about one individual; each Marriage record
holds information about a family of two parents, their children and details of their
marriage, if any. The Marriage record has no information about the individuals
involved, simply /inks to the relevant Person records. These links use the Record
Identity Numbers (RINs) of the records involved; a RIN is allocated by PediTree
to each record when it is created. As p

) . erson Record
well as being used to link records, the  Fjelq Type Tag
RIN is often displayed with details

parents Marriage (link) FAMC

from a record. marriages Marriage (link) FAMS
. . . sex sex (choice) SEX

When RINs are displayed in PediTree, forenames  toxt FORE

they are prefixed by the first letter of  gyrname text SURN

the record-type, that is, P(Person), prefix text PREF

M(Marriage), S(Source), C(Census)  Postfix text POST
and so on. This prefix makes the RIN  Nickname text NICK
. s p lakes _title text TITL
unique for use as a hot link in the Detail pjrth event (group) BIRT
Box display (see chapter 5 for details). christening  event (group) CHR

If two record-types start with the same ~ death event (group) DEAT
letter, then the second one will be low- 2ur@ event (group) BURI

’ education text EDUC

er-case; the first, upper-case. The hot  occupation  occupation (group) OCCU
link is case-sensitive, so will continue  residence residence (group)  RESI

to work in this circumstance. More than noftes Iton?text gggﬁ
. . retnum ex

two recgrd-types startmg with the same -, event (group) WILL

letter will confuse PediTree. sources Source (link) SOUR
. adoptedBy  Marriage (link) ADOP

Fields censuses Census (link) CENS

Within each record there are a number objects object (group) OBJE

of named fields to hold elements of the AGE date AGE

information to be stored. These fields changed changed (group) CHAN

are defined by the record-type, but can

be changed by the user if required. Marriage Record

Field Type Ta
Here are the fields of the Person and ! yp . 9
Marriage record-types in the supplied ~ husband Person (link) HUSB
Elton55 database wife Person (link) WIFE
: children Person (link) CHIL
. marriage event (group) MARR
Field Ty pes . divorce event (group) DIVO
The first column for each record-type is adopted Person (link) ADOP
the field-name, which you see in the div logical (choice) DIV
Edit display and use elsewhere, as will \r/]\(ljltf:SSumame ;[ce>|)1<tgtext \lilvg"I:lE
be described. Theisecond column isthe orim text REEN
field type. The third column is the objects object (group) OBJE
GEDCOM tag for each field (GED- sources Source (link) SOUR

changed changed (group) CHAN

12



Chapter 2 Family History Databases

COM is the subject of chapter 12). The possible field-types are:-

Text of up to 255 characters. Can be used as a sort-key.

Dates with day, month and year, preceded by qualifiers (before,
circa, after), for example, bef. 3 Jul 2004. Quarterly dates
are also accepted, e.g., Q2 1971, used for GRO index entries.

text
date

Can be used as a sort-key.
longtext  Text up to 4090 characters.

choice Selection from a user-defined list of words, for example sex
[M or FJ, logical [Y or N]. Can be used as a sort-key.

group A user-defined group of fields of any type except group. See

examples below.

link A link to another record-type. These fields hold the RIN of the
linked record, but this is usually displayed as details from that

record.

In the Person record, the first two fields are links to Marriage records, the third a

choice called sex. Birth, christening,
death and burial are all the event group

Person Marriage Person
of fields; other groups used are occu- records record records
pation, residence, object and changed. i
The Marriage record has the first three =~ |marrages parents
fields as links tp Person rpcords, for Alan Roe Bernard
the husband, wife and children respec- Roe
tively. If there is more than one child, Pl
then the children field is repeated as P3
needed to accommodate the links for husband
up to twenty children. This linking wife
between Person and Marriage records children
is shown diagrammatically opposite: children
this is the marriage of Alan Roe and Ml
Susan Sharp Wlth two of the.lr children, - oo T parents
as in the Getting Started Guide book-
let. Susan Frances

Sharp . Roe
All fields in records can be repeated P2 Persoz/il::l]f smage P5
(up to 255 times) where the informa-

tion to be stored makes this appropri-

ate. So for example, a person with three marriages will have three marriages
fields to link to three Marriage records. Or you can have several occupation-

13



Chapter 2 Family History Databases

group fields to record an individual’s progress in their working life. However,
fields within a group cannot be repeated.

Group Fields

Here are the definitions of the groups and the other two record-types defined in
Elton55. When editing a group field, the fields of the group appear in a horizontal
grid, not vertically as shown here.

Event Group Source Record
Field Type Tag Field Type Tag
date date DATE type text TYPE
place text PLAC date date DATE
notes text NOTE title text TITL
source Source (link) SOUR refnum text REFN
. text longtext TEXT
O_ccupatlon Group Individuals Person (link)  INDI
Field Type Tag place text PLAC
title text TITL censuses  Census (link) CENS
place text PLAC county text CNTY
from date FROM marriages  Marriage (link) MARR
to date TO objects object OBJE
org text ORG author text AUTH
source Source (link) SOUR publisher  text PUBL
notes longtext NOTE
Object Group changed changed CHAN
Field Type Tag
date date DATE
title text TITL
file text FILE
format text FORM
Changed Group Census Record
Field Type Tag Field Type Tag
date date DATE refnum text REFN
time text TIME forenames text FORE
notes text NOTE surname text SURN
relationship text RELA
Residence Group status text STAT
Field Type Tag sex sex SEX
age text AGE
I(r)om g:t: _IT_(R)OM occupation text OCCuU
dwellin text DWEL countyBorn text CNTY
oad text ROAD born text BORN
locality ~ text LOCA country text CTRY
town text TOWN notes longtext _ NOTE
county text co source Source (link)  SOUR
postcode  text POST individual ~ Person (link)  INDI
country text COUN

source Source (link) SOUR

14



Chapter 2 Family History Databases

Storage

All the files comprising one database are stored in one folder, which carries the
name of the database with an extension of .ped, .pdg, .pdh, .pdj or .pdm. (So
Elton55 is stored in folder Elton55.ped.) Within that folder, each record-type has
its own set of three files. The storage mechanism is designed to be efficient for
sparse data that is typical of historic information; only fields containing informa-
tion take space. The standard database format can have up to one megabyte of
information for each record-type. Where this is insufficient, then formats that
allow up to 3, 4, 6, or 9 megabytes are available. However, the increased maxi-
mum sizes are at the expense of more space for small records; in the case of the
two largest sizes, the database can no longer be read by PediTree’s predecessor,
Pedigree for DOS. Whichever size is chosen, the maximum number of records
for each type remains 32,767.

B Database Designs

As mentioned above, PediTree can be used to modify the database design, by
altering the record-types and their fields. The information above was for one
design, called Elton55. The other database supplied, Royal03, is different in several
ways. Users of Pedigree for DOS may have databases based on other designs,
called Families and Census. It is possible to use PediTree databases for other
purposes entirely: membership records, job progress information and country
walks, for example, are known uses. The next section has some information about
changing the record-types and fields.

Here is a summary of the principal Pedigree Software database designs:-

Design Person & Source Record Census Record  Repostry Record
Marriage Record

Families Yes Yes

Census Yes Yes Yes

Royal03 Yes

Elton55 Yes Yes Yes

Fam55 Yes Yes Yes

All PediTree databases must have Person and Marriage records. Elton55 is a
development from Census, where the main difference is in the picture scripts.
Fam55 is supplied with the utility program GedUtils and is specially designed to
receive information from converted GEDCOM version 5.5 files. (See chapter 12
for more about this.) It has additional Groups and the Repostry record-type for
information about document repositories (record-offices and so on). The misspelt
name (Repostry) is to comply with the eight-letter limit for record-types!

15



Chapter 2 Family History Databases

C Changing Database Designs

Information about changing picture scripts is in chapter 4. Changes to record-
types and groups are carried out using the Options Definitions dialogue obtained
from the main menu Options > Definitions. For an existing database that contains
information in any of its record-types, you can only add new fields or change the
GEDCOM tags. A newly-created database, however, has no such restriction; you
can delete or re-arrange fields and change their type, as well as adding new fields.

Because PediTree is a Family History
database program, there are a few
remaining restrictions. You must not

Mandatory Fields

Person Record

. Field Type Ta
alter the mandatory fields in the Person yp _ _ g
and Marriage record-types in any way: ?naar?r?atZes m:::::gz 8:2:8 Eﬁmg
the first five fields of the Person record- ¢ sex (choice) SEX
type and the first three fields of the forenames  text FORE

Marriage record-type, as shown oppo-  surname text SURN
site. These must be in their normal :
positions and have the usual types and  Marriage Record

tags (as you will see in chapter 12, the  Field Type Tag

FORE and SURN tags aren’t actually  nysband Person (link) HUSB

used). wife Person (link) WIFE
children Person (link) CHIL

Before attempting any change to the

definitions of an existing database,

make sure that you have an up-to-date back-up copy. Even when working on an
empty database, take regular back-ups if you are making changes in several
stages. Always check your changes by closing and reopening this database.
Then close PediTree and use Pedigree for DOS to open this database, and close it.
(Pedigree has lower limits which could be upset. If Pedigree fails, return to make
corrections in PediTree.)

Definitions List Dialogue
The version of the database that you
are using is displayed at the top left of

this dialogue. This information is T Mﬁ;im Il
. . DE-ERonSS 305 = Soinee 3
stored in the Person PLANdetailBox e :
. . . Types |["=PIF
picture script in the form ‘DB= name’. et
Choice Types [

If you change the data definitions, then
edit this picture script to give your
database a new version name.

The three buttons in the centre allow
you to choose Record-types, Group-
types or Choice-types for the list dis-

16



Chapter 2 Family History Databases

play on the right. On entry, this list display shows the record-types defined in this
database; an ‘empty’ entry at the end allows the addition of a new type.

Click on an entry in the list box to see the definition of that Record-type, Group-
type or Choice-type. For the first two, the list then shows the field-name, the
field-type and the GEDCOM tag. If the field-type is a Record-type (link), Group-
type or Choice-type, then clicking on it will change the list to the definition of the
type in question. For the Choice-type, the list shows only the choice-words.

Right-click in the list to get a pop-up
menu with the following choices:

Help : on standard field names will be
found in the on-line help. If this word
is used in different contexts, then
hypertext links to all contexts will be
shown too. Your own field names
cannot be shown, resulting in a mes-
sage suggesting that you contact the
vendor for an updated file. Please
don’t contact Pedigree Software if this
message appears in these circum-
stances!

Print : this table of definitions, but

you must first choose the portrait orientation yourself with Print Setup.

Change Definition : enables you to
alter the definitions in the list; the col-
our of the list changes to remind you.
A right-click produces a pop-up menu
with two added entries: Add field
name; Save changes. If there are
records in the database, then you can
only change the GEDCOM tag or add

a new field at the end of the definition.

You must choose Save changes (or
press key F9) to keep any alterations
you have made. When you do this, the
database will be closed and re-opened.

g
Marriage Field type |GED =
? Help | husband Person hush
wife Person wife
Becord Types || child Perzon chil
i event marr
Fir T | divorce event divo
adopted Person adop
5 div logical div
Choice Types wifeS text WSn
notes I note
refnum . text refn
objects nhiact bie
sources 0P on refrum our
changet FErint portrait han
T LChange definition
=
Marriage Field type |GED =
? Help | husband Person husb
] wile
Becord T_vpegl children Person chil
marriage event marr
Group Types | divorce event divo
adopted Person adop
. div logical div
Hinfre= Ugpres | WifeSurname text Wwin
notes longtext note
refnum text refn
objects ghissl ~hie
sources ﬂt.alp on ref.num .
changed Frint portrait n
v Change definition
Add field name
Save changes F9

Alternatively, to abandon your changes, press the Esc key, or right-click and
choose Change definition again to clear the tick-mark.

17



Chapter 2 Family History Databases

Note: each type of data definition has to be changed separately and saved by
pressing F9 or right-clicking and choosing Save changes, before looking
at another type of data.

The changes you make affect only the currently-open database. If you have other
similar databases to which you want to make the same changes, you will have to
modify each one individually. Alternatively, for each existing database, you can
export the information as a GEDCOM file, make a new empty database from the
modified one and import the GEDCOM file into the new one.

Changing Record-type Names

Click the Record Types button then right-click Change definition. Double-click a
name and edit it. Do not alter Person or Marriage. Changing a record name will
automatically be applied to all existing uses of the old name. Changing the
‘empty’ name will allow a new record type to be added after pressing F9. A new
set of files will be created and default picture scripts for list and detailBox created
for you to expand. This has few side effects. Click the new record again to add
fields to it, as below.

Changing Group-type Names

Click the Group Types button then right-click Change definition. Double-click a
name and edit it. Changing a group name will automatically be applied to all
existing uses of the old name. Changing the ‘empty’ name will allow a new
group to be added after pressing F9 Save. A single picture script called ‘brief’
will be created. This has few side effects. Click the new group again to add fields
to it, as below.

Changing Field Names and Tags

Click a record-type name or group-type name to show a list of field names, field
types and GEDCOM tags. Right click to change definitions. Changes to types of
fields can only be done in a new database. Changes to field names or GEDCOM
tags can be made by double-clicking on that cell.

Duplicate names and tags within the same type of record or group will produce an
error-message. However, one or more GEDCOM fields that you want to omit
from exported files can have a tag of ‘X’.

Name changes have widespread effects on picture scripts, which will have to be
changed individually. Use PedSpecs (see chapter 4 section L) before making
such changes to understand what these effects may be. You can edit the affected
scripts later in this session, otherwise they will produce error-messages on reo-
pening this database. PediTree will cope with scripts in error by showing an
empty panel when they are used.

In a new (empty) database, a right-click brings up a menu with additional entries:
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Insert field : insert a field in the mid-

) refnum text refn
dle of the list objects l% object obje
delete objects : remove a field. sources I-T_I_ - - R

Help on objects

Move row : to enable moving of changed e s
fields; this entry will show a tick and a &

i . . gt v Ch definit
the first column is highlighted. To E dZ?QT 4 S
move a field, drag the name into a new SR T
position with the left mouse button. Insert field
When finished with all moves, right delete objects
click to remove the tick by Move row. Move row
Changing Choice-type Words Save changes F3

Click the Choice Types button and then
a particular choice type such as sex or
logical. If you want to add a new one, then right click to choose change defini-
tion and edit the spare ’empty’ name to one that you want to create. Press F9 to
save it, and then click again to add word values to it.

Most of the other actions with a right click are similar to those for field types
above, except that Move row is not available.
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Chapter 3 Using the Databases

A User Databases

Most users’ databases will be based on one of the supplied designs, with or with-
out modification. Many users will start using the installed copy of Elton55, and
produce new databases from this design with appropriate names.

What should be included in a single database? The simple answer is all the people
and relationships that may comprise a single interrelated group, such as all those
uncovered in studying the ancestry of one person. Reasons for using more than
one database on a single study include separating documented facts from sus-
pected information; having a copy of the main database for experimenting with
changes to definitions (Records, Pictures, Table and Reports); trial imports of
information from other sources, such as the IGI; too much information for a sin-
gle database (more than about 10,000 records or 1 megabyte of data in the stand-
ard database format, 30,000 records and 3-9 megabytes in other formats).
Unrelated applications will always merit their own individual databases.

B Using the Elton55 Design

The following sections describe the use of the fields in each record-type and
group of the Elton55 application design, which is the most common basis for
user’s databases. Certain fields are marked with an asterisk (*); these fields are
common to other packages (such as Personal Ancestral File). Some of the sug-
gestions set out below are designed to ensure easy transfer of information both
between PediTree users and to other packages.

Person Record

There should be one Person record for each individual in the database. If you
find a duplicate, then you may want to ensure that one of these has all the links
and data fields before removing the other. The fields in this Person record are:

parents : a Marriage record link that is maintained from the PediTree Family dis-
play, and not in an Edit display. This is the other half of the Marriage.children
links. It is important to remember that parents is a link to a Marriage record, not
to two people.

marriages : Marriage record links that are maintained from the PediTree Family
display, and not in an Edit display. This is the other half of the Marriage.husband
or Marriage.wife link. There is another marriages field in the Source record.

*sex : either M or F! If unknown (“one of seven children”), leave blank.

*forenames : enter in full with conventional initial capital letters, e.g. Colin
John (not COLIN...). If initials only are known, enter in capitals without full
stops, e.g. C J . If unknown, leave blank; in this case, picture script name will
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add the RIN to the surname to distinguish them. Any prefixes or nicknames go
elsewhere (their own fields).

*surname : enter in full with conventional initial capital letters, e.g. Smi th, not
SMITH. (The current database designs display such surnames in CAPITALS,
however they are entered.) If the surname begins with Mc or Mac, then enter it
exactly as it is to be displayed, e.g. MCCRACKEN. For someone who changes their
surname, use that by which they are most commonly known and put other ver-
sions in a Note. If unknown (e.g. wife of an ancestor), leave blank, except when it
is desired to enter a second marriage and nothing is known of the first, when ?
must be entered in the first. Any Titles or suffixes (junior or 3rd) go elsewhere,
perhaps in postfix.

prefix : Dr, Sir, Lord, Lt CoT, Rev and so on go here.
postfix : RN, BSc, MP here. Can also be used for a qualifier such as of Cleves.

nickname : for familiar names by which the person was known: perhaps a fore-
name other than the first, a diminutive, etc.

*title : either for parts of the names, such as junior, or for hereditary titles like
Prince of wales. But Chairman of Boots or Vicar of Bray are Occupations.
(See Occupation group).

education : for schools, University etc., entered as text e.g. Oxford 1919-23.
This field may be repeated, one school, etc., per field.

birth:

christening: otherwise called baptism of a child

death:

burial : each containing the Event group fields date, place, notes and source. See
Event Group later in this chapter.

occupation : is recorded in some detail in this group field, which may be repeated
as necessary for successive periods. See Occupation Group.

residence : this group records a dwelling-place of the person. It is structured to
hold a modern British address, so that it can be used for addressing letters. (Ear-
lier versions of this group have phone in place of source and have a different
order of the fields.) This group should be repeated for each separate residence.
The fields are shown in Residence group below.

*notes : this field has a variety of uses. The most important use is for information
about the content of other fields: alternative names and spellings, uncertainties
and so on. Unlike other fields, notes are usually sentences and should therefore
end with a full stop or other punctuation. A separate notes field may be used for
each subject, in which case it is useful to start each with a subject heading, e.g.
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Surname: sometimes spelt Handcock. or Forenames: later McDon-
nell Longuet. This also helps to identify the content of the notes on the edit
display without having to expand them first. But you can put all your notes in a
single field if you prefer.

*refnum : for your own reference numbers, if you use them. Although PediTree
allocates its own Record Identification Numbers (RINs), these are not permanent.
In particular, if you export a GEDCOM file and then import it into another data-
base, the RINSs are likely to alter. So you may prefer to allocate your own num-
bers.

will : outline details of the person's will; use the date field for when probate was
granted. See Event Group below.

sources : this is a link to a documentary source for information about this person,
other than that about events (birth, etc., or will), occupation or residence. For
example, you may only know this person exists from someone else’s Will.

adoptedBy : a link to the marriage of the adopting parents.

censuses : link to a Census record(s) related to this person.

objects : object Group used for images or sounds about this Person.

AGE : do not use; leave empty. This field is an anchor for age calculations.

changed : changed group, with date and time automatically updated whenever
the record is updated by PediTree. You can add your own notes if you wish. If
more than one occurrence, only the first is updated automatically.

Marriage Record

A Marriage record is created automatically by PediTree when people are placed
in both the “father” and “mother” locations on the main screen, with or without
children also being present. This does not necessarily indicate that a formal mar-
riage has taken place!

husband : link to a Person record, maintained from the Family display. There
may be no husband or one.

wife : link to Person maintained from the Family display. There may be no wife
or one.

children : links to Person maintained from the Family display. There may be no
children, or up to 20.

marriage :
divorce : the remarks about date, place, notes and source entries for Birth, etc.
above also apply here (see Event Group below). Enclosing the notes in parenthe-
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ses “(...)” e.g. (common Taw) or (Tiaison) makes them appear in printed
reports and alters m. to = in Trees and Reports.

adopted : a link to an adopted child. To distinguish such children from true
descendants, they should not be added to the list of children on the family dis-
play, but linked to this field of their adoptive parents’ marriage. The reverse link
is from the AdoptedBy field in their Person record. This field can be repeated as
needed for multiple adopted children.

div (divorced): this is a logical field (Y or N) that is present only for compatibil-
ity with Personal Ancestral File. Use the divorce field instead.

wifeSurname : the previous surname of the wife where this is not her birth sur-
name, for example, where a widow re-marries using the surname from her previ-
ous marriage.

notes : notes about a family or marriage that are not specific to the wedding or
divorce.

refnum : your own reference number for this record.

objects : object group for images or sounds about this family, such as wedding
photos.

sources : link to documentary source not specific to the wedding or divorce.

changed : changed group, with date and time automatically updated whenever
the record is updated by PediTree. You can add your own notes if you wish.

Source Record

Used to record documentary sources from which details of people and relation-
ships have been obtained. Links established between source records and the
related person and marriage records permit the authorities for the information to
be traced. Certain types of source record may refer to several people, especially
wills and family Bibles. The information in the source record should allow the
original document or reference to be traced if required.

type : an abbreviation for the type of source. A suggested list of the most com-
mon ones is:

BT Bishop's Transcripts

census

cert Certificate of birth, marriage or death

family knowledge

GRO B General Register Office Index: birth

GROM General Register Office Index: marriage
GROD General Register Office Index: death

1GI International Genealogical Index (LDS Church)
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MI Monumental Inscription
PR Parish Register Entry
will

date : date of the event identified in the source.

title : further identification of the source beyond that given in field type, which is
used in the cite picture in the Person Detail Box.

refnum : reference number of the source.
text : the text of the source, if a copy of the document is not available.

individuals : link to the Person record of the people named in this source. This
field is repeated as required.

place : place of the event identified in the source.
county : county of the event identified in the source.
censuses : Census link, entered after creating Census records.

marriages : this Marriage record link is only entered when this source record is
the source of the marriage or divorce event

objects : object group for images or sounds about this Source, such as group pho-
tos.

author : the author of this Source, for GEDCOM conformance.
publisher : the publisher of this Source.

notes : about this Source.

changed : changed group, updated when this record is edited.

Using Source Records
There are two ways in which source records can be used. The first is to provide a
general heading, applicable to a number of actual documents. For example:

type: cert
text or title: certificates held by Geraldine Roe

This assumes that Geraldine (the family genealogist) holds a file of certificates
that document a number of people and events. The same approach may be used
with wills, family Bibles and the like. Each person and event documented in this
holding is then linked to this single source record. Using title rather than text will
cause it to appear when cited in the Person Detail Box.

The second way is to have an individual source record containing the relevant
details for each document or index entry. This is appropriate where a copy of the

24



Chapter 3 Using the Databases

source document is not held. It may also be appropriate for particular wills etc.
that document a number of people or events. Particular examples are:

type: GRO B (similarly for GRO M or GRO D)
date: Q3 1911

refnum: 6b 102

individuals: (link to person)

place: Newcastle u Lyme

type: census

date: 3 Apr 1871

refnum: RG10.9999.p99

place: 675 High Street, Worthing

county: SSX

A further use for Source records is for letters that you want to send once and keep
for as long as necessary, filed by person or date. The fields are used as follows:

type: Tetter

date: (when sent)

title: (for your own identification)
refnum:

text: (text of the letter)
individuals: (link to addressee)

place:

The actual letter is produced by the letter Report, which you will need to alter to
contain your own name. In this, the salutation “Dear Mr.Smith” is worked out by
the Person picture script named salutation. You will see that it uses the
Person.title if you have filled it in, with the surname. If you want to address the
person more informally, then enter Person.nickname and the salutation will be
e.g. “Dear Joe”.

The picture script tries to be clever with the title if it is absent from the Person
record. Males will be Mr; females will be Mrs or Miss depending on whether you
have recorded a marriage.

Multiple Source Citations from Group Fields

PediTree databases cannot have repeated fields inside a group like an event. This
means that only one Source record can be linked to each event. The following
notes give some advice on circumventing this constraint.

Obviously, if the information is about birth or christening/baptism or whatever,
each source should be linked to the appropriate event, or just linked to the general
Person.sources — for which you can have 250 sources!
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If the source information gives conflicting date or place, then you can create more
than one birth (or whatever) event, linked to that source.

If the information is identical, then you can create a birth.note with a reference to
that source in the form:-

Source: AS123 ref:23/ABC45

where AS123 allows PediTree to hot link to that source RIN, as long as it stays
the same, and ref 23/ABC45 is your unique reference to that source in case the
RINs get renumbered. This method allows several sources to be linked to one
event.

Note: see chapter 12 section G for future possibilities.

Keep each Source citation to a separate line in birth.notes or whatever event,
occupation or residence for which you want multiple sources. Make it the last
lines if you have notes about the event itself. (A ‘Source citation’ is the way in
which we refer to a Source record detail through its link, RIN or GEDCOM xref.
from an event etc. or in this case by the example line.)

Census Record

This design has been produced especially to hold a lot of census information,
such as that available from the 1881 CDROM or the 2% 1851 sample (see Com-
puters in Genealogy Sep 1994).

The census document can be described in a Source record, as detailed above. It
can then be linked to a number of Census records, one for each line (individual).
A field in the Source record, called censuses, has been provided for this purpose.
In the Census record-type the fields relate directly to the familiar census layout
and are:

refnum : a serial number, so that lines can be kept in order when sorting. This
needs to be a fixed size number (001, 002..010...101) in order to sort correctly.

forenames
surname

relationship : use one of [head wife son gson dau gdau m-in-Taw].
status : use one of [m u wid wdr].
sex : use one of [M F], derived from the column in which the age is entered.

age : use the following symbols if the age is not just a simple number of years:
[y md > <], for example: 2y 3m or < 5y (less than 5 years old).

occupation : use lower case and be as standard as possible.

countyBorn : Chapman code (e.g. DBY WAR).
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born : parish.

country : use the international 3-letter code in capitals, or else type it as seen.
notes : conditions like blind, and born abroad.

source : Source record link from the document.

individual : link to Person record, if you know this Person already.

See the Getting Started Guide, chapter 6 section E for a tutorial on entering cen-
sus records.

Event Group

Used in both Person and Marriage records, this has the following fields:-

*date : enter as known. Year only (1994); month and year (Apr 1994); day
month & year (9 Apr 1994) are all allowed, as are anniversary dates (9 Apr).
Use the prefixes c. (=about), bef. (=before) and aft. (=after) as needed.
Potentially ambiguous dates before the calendar change may be entered as dual
dates, e.g. Feb 1741/2, (which comes after Dec 1741, but before New Year’s
Day on 25 Mar 1742). PediTree also allows e.g. Q1 1938 for dates obtained from
the GRO Indexes (Q1 = Jan-Mar...Q4 = Oct-Dec). But how to indicate that e.g.
the person has died, but you have no idea when? The death.date bef. 1994
might be safe for Uncle Fred, b.1870?

*place : enter the place where the event occurred; but here is a minefield! How
do you describe it? There should be enough information to enable someone unfa-
miliar with your family or the locality to identify the place correctly. For compat-
ibility with other packages, such as Personal Ancestral File, it should be written
like an address on one line with up to three commas separating the elements, e.g.
St Mary, walcot, Bath, SOM. The place-names used should be contempo-
rary with the event described, even though this makes it more difficult to check
with modern maps. Abbreviations should be avoided, but standard codes like the
B.S. county (Chapman) codes can be used. In the above example, SOM = Somer-
set, correct for 1811, now again correct; in between came AVN = Avon. Overseas
locations will need the country as the last element. As before, no comments or
notes in the field.

notes : for supplementary information about the date and place entries or about
the event, such as age at death. Enclosing these notes in parenthesis (...) ensures
that they appear in printed reports. This is useful for such things as birth.notes
such as illegitimate (i11eg.) or (baseborn: given name John Doe);
christening.notes (given name: John Roe); for burial.notes (cremated:
ashes scattered at ..., MI at ...).
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In a Marriage record, use the marriage event notes with (brackets) to record, e.g.,
(common Taw) so that the picture scripts will show an equals = symbol in place
of m..

source : this is a link to a documentary source that is recorded separately.

Occupation Group
title : of job or skill.

place : of employment.

from :
to : starting and ending dates. These can be problematic for a single census entry;
use e.g., from: bef. 1861.

org : employer or organisation.

source : link to a documentary source that is recorded separately in a Source
record.

Residence Group

from :

to : starting and ending dates for residence at this location. (See comment under
Occupation group above).

dwelling : house name

road : number & road name

locality : district as fora
town : town normal U.K.
county : county address
postcode : or zipcode

country : -

source : this is a link to a documentary source that is recorded separately in a
Source record.

Object Group

This holds a reference to a file containing an image or sound recording. Both can
be referenced in Detail Box swipes. Images can be shown in Wide BRIEF Trees
and Reports. Although references to other types of file can be placed here, this
might cause problems if information is transferred to another program using
GEDCOM.

However, other file types can be used in any text that appears in a Detail Box. If
the type used is a registered type in your Windows set-up, the file can be opened
automatically by swiping them forwards. The path or filename must start with
one backslash(\) or it must follow a drive identifier like c:\. See main menu File
> check Files linked for a method of checking these entries.
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title : title of photo or recording.

date : date of recording (not in GEDCOM standard).

file : file path with filetype such as .bmp .BMP .wav .WAV or .jpg .JPG
format : format such a bmp or wav file (GEDCOM standard).
Changed Group

Any manual edit of a record in PediTree will update the date and time in this
group. The Replace Text function (global edit) or GEDCOM import do not
update this group.

date : of the last edit of the record.
time :  of the last edit of the record.

notes : any comment you want to make.
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Chapter 4 Picture Scripts and Expressions

There are various places in PediTree where you type some text including field
names to specify what you want done. These texts are known as expressions.

To sort a list you type a series of field names. These can be fields in the records
you are sorting, or they can be fields in linked records. For example, Person
records can be sorted by the field name surname; Marriage records can be sorted
by husband.surname in the linked Person record.

To filter, i.e. to select some records from a list, you type a comparison, also
known as a logical expression. Records are selected if the comparison is true.
The simplest filter expressions have a field name and the selection criteria, for

example surname = "Smith". A filter can use a linked field,
husband.surname = "Smith". Then several comparisons can be combined.
For example surname = "Smith" or husband.surname = "Smith" finds

people called Smith either by birth or by marriage.

To alter the way information is displayed or printed you change a picture script.
At its simplest a picture script is a series of field names and group names. For
example, the picture script forenames surname birth death produces the
display Susan Sharp ¢.1840 27 May 1875 in Brighton. (In this, c. is the standard
abbreviation for "circa" before a date; the word ‘in” comes from a subsidiary
named picture script built in to PediTree and used by default.) You immediately
want to put in ‘born:” and ‘died:” or abbreviations for them. Then you find that if
there is no information about the birth, you would like the christening details,
with appropriate text. Then perhaps add ‘Dtr. of” father.forenames father.surname
(but make it ‘Son of” if the sex is Male). Facilities for all of this are available in
PediTree picture scripts.

A Picture Scripts

A picture script tells PediTree how to display a certain record-type, group, or part
of a tree plan. There are several kinds of named picture script that form part of a
database definition:

1. Plan picture scripts used to show a tree plan in the list box, or set the line style
when drawing trees. These are to be found under Person picture scripts, having
names prefixed with the letters PLAN.

2. Record picture scripts used to display information about people, marriages and
other records on the screen. These picture scripts can also be used in print func-
tions — for use on Trees, Charts, Tables and Reports.

3. Group picture scripts can only be used from other picture scripts, e.g. each time
an event is mentioned in a Person picture script.
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Picture Script Components

A picture script consists of a list of components on one or more lines. Within the
script, line breaks have no effect on the output, so they are usually arranged for
easy reading by humans, consistent with no line being longer than 255 characters.
Here is an example picture script illustrating most possible components (Person
picture script ‘families’):-

1f sex=m then wifesFam(marriages)
else HusbandsFam(marriages)

end

if marriages.children present then

end
The possible components of a picture script are:

field names
variables

literal text

newline character
picture script call
conditional phrase
if statement
separator statement

The result of the picture script is the concatenation of the results of all the compo-
nents in the order given, with spaces between them according to rules to be stated
later. Each of these components will now be discussed in turn.

Field-names: a field name is replaced by the contents of that field. If a field is
repeated, then the result is a list of the contents of all the fields, separated by the
separator characters (see below)

Every picture script operates in a known context of either a group (such as event),
a record-type (such as Person), a plan, Tree or Chart. For a group or record-type,
any of the field names of that group or record-type can appear on their own. So,
for example, in a Person context, forenames, surname, notes are all valid
field-names. Where the field-name is a group, then the group fields can be named
after a dot, thus birth.date. Similarly, link fields that point to other record-
types can be used to name fields in the other record:
marriages.wife.surname. This can go as far as you want, so
parents.husband.parents.husband gets the grandfather of the present Per-
son (if any). (There is a limit of seven names connected by dots.)

For plans, Trees and Charts, it is necessary to use the variables descendant for the
Person fields and treemarriage or spouse for the Marriage fields.

If a field-name in a script is in capitals, then the result is capitalised.

31



Chapter 4 Picture Scripts and Expressions

Prefixing a field-name by $ makes the result the Soundex equivalent of the field.
(See chapter 13 section E Soundex). This is usually used for surnames, i.e.,
$surname.

Prefixing a field-name by # makes the result the number of fields of this name.
This can be used in conditional tests and in displays. For example, the Marriage
picture script issue:

if #children=0 then "no children found"
else "and had"
if #children=1 then "one child: "
else #children "children: "
end |
end
which might display 3 children: .
Variables: like field-names, but built into PediTree. See below for a list.
Literal text: anything enclosed in "quotes" appears verbatim in the output.
Newline: the character | starts a new line in the output.

Picture script call: “sending” a link or group field to a named picture, so that its
result is added to the output. For example, in a Person context:

name Chusband) sends the link field husband to the picture script called
name.

detail(birth) sends the group field birth to the picture script called detail.
name () sends the current record to the picture script called name.

Conditional phrase: other elements, including at least one field-name, all in
square brackets [...]. This material is only displayed if there is information in any

enclosed field-name, for example, the script [ |" b." normal(birth) ]
will only produce output if there is information in the birth group. However, the
script [ if birth present then | " b." end ] will not produce any-

thing even if birth information is present, because there was no variable data to be
printed from within the brackets. The script [ if birth present then | "
b." birth.date end] would be acceptable, but the ‘if birth present’ and
‘end’ are redundant.

If statement: this has the following syntax:

if <condition> then <statement;> end
or
if <condition> then <statement;> else <statement,> end

32



Chapter 4 Picture Scripts and Expressions

The <statement;> section of picture script following the then will only be dis-
played if the conditional expression <condition> is true. Otherwise, the
<statement,> section following the else will be displayed, if present. Conditional
expressions are described below.

Separator: when a field occurs more than once in a record, each occurrence is
displayed, separated from the next by a set of characters, by default a new line.
To change this, use the following syntax:

separator = for example separator = ",
or
separator = | to use a newline as the separator.

The separator string of characters must not be longer than 5 characters, but
PediTree does not check this.

The list of components above are concatenated with spaces between them accord-
ing to the following rules:

1. If the last character of the first item is alphanumeric (including foreign
characters) and the first character of the second item is either alphanumeric or an

‘opener’ character [ ({<" ] , then a space is inserted.

2. If the last character of the first item is a ‘closer’ character [ )1>" ] and the
first character of the second item is alphanumeric then a space is inserted

3. Otherwise, no space is inserted.

Variables

PediTree maintains a number of values which you can make use of. These
include the generation and strip numbers in tree plans, as well as various values
for use on printouts. All of these values are called variables. The variables that
represent records can be used in the same way as the links mentioned above. For
example,

spouse. forenames

treemarriage.divorce.date

Although number is not a standard field type, some variables represent numbers
and can be used in expressions.

Here is a complete list of named variables used in PediTree.

today a date variable containing the current date from your PC's
built-in clock. When used on its own in a script, always dis-
plays the current date. In conditional expressions, can be
changed in the Options > Dates dialogue. Its format is then
YYYYMMDD=, e.g. 20040813=
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showrins

generation

strip

descendant

spouse

spouses
father
mother
treemarriage

childnumber

marriagenumber

treeref

a logical variable which contains Y if you have chosen to
display RINs.

the generation number of a person or marriage This can be
used when sorting or filtering tree plans, as well as in pic-
ture scripts used for trees or charts.

the strip number of a person or marriage.

the descendant on a tree or chart, also valid in other Person
contexts.

the spouse on a tree or chart, also valid in other Person con-
texts.

the spouse of this person.

an individuals’s parents.husband

an individual’s parents.wife

the marriage record on a Tree or Chart

the number of the current person on a tree or chart
(1 = eldest).

the number of the current marriage (1 = first).

a reference to a position within a tree (e.g. A2:13). Treeref
is slightly more complex than the other variables. When
used within a tree picture, it contains any positions on the
tree where the person (or marriage) is duplicated. This could
happen if cousins marry, for instance. To inform you when
someone appears on a tree more than once, the picture
scripts in Elton55 use the following :

[ "also at" treeref ]

When treeref is used within a filter, table, or report, it contains all the positions on
all the trees that include the particular person or marriage. It is used to cross-ref-
erence people with the trees which contain them.

A treeref consists of a capital letter from A onwards, for the plan, followed by the
generation number, a colon and the strip number, e.g. A5:7

A plan can be given a second lower-case letter if it is a plan restricted by second
plan to limit the descent and ascent to a particular family line. This does not
affect the treeref which only uses the first (capital) letter.
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Reserved Picture Script Names

Certain named picture scripts are required for the correct operation of PediTree.
Those marked * below must be present; the other names are reserved for particu-
lar purposes.

All record-types:
list * used for showing record summary in a list.
detailBox * used for the Detail Box display.

links for making two-way links between records, and the check DB
function.

All groups:
no reserved name, but one default picture script is required.

Person record-type:

child * for children on the family window.

parent * for mother, father and grandparents on the family window.

marked* for showing the marked Person.

BORN for selecting the birth or christening field for use in age calcula-
tion. See section E below for information about age calcula-
tions.

GEDCOM for GEDCOM version 5.5 export.

Marriage record-type:

familyMar * for marriage event detail in the family display.
GEDCOM for GEDCOM version 5.5 export.

Source record-type:

GEDCOM for GEDCOM version 5.5 export.

Plan lists:

list * used for showing plan summary in a list.

DetailBox * used for detail in the lower area of a list.

lineUp for colour and width of lines above or left of nodes in trees and
charts.

lineDown for colour and width of lines below or right of nodes in trees
and charts.
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B Conditional Expressions

Conditional (or logical) expressions, or comparisons, can have one of two values
- true or false. They are used in filters and picture scripts.

Simple Comparisons

Simple comparisons are in the form below, where f must be a field whilst g can
be field or a literal. A literal must be surrounded by "quotes" unless the field fis a
date, a RIN or a choice field.

f=g equal to

f<g not equal to

f<g less than (f cannot be a choice field)

f>g more than (f cannot be a choice field)

f<=¢g less than or equal to, or f before g

f>=¢g more than or equal to, or f after g

fbetweenx andy trueif f >=x and f<y  (f cannot be a choice field)

flike g f sounds like g (using the Soundex code)

f contains g true if text f includes text g

f absent true if field f or link f or group f is not present in a

record

f present true if field f or link f or group f'is present in a record
When comparing text values, the comparison is made alphabetically, with case
differences (lower/upper) being ignored. So, for example, "colin" = "COLIN"
is true.

For more complex expressions (e.g. in filters) it is necessary to provide literal val-
ues. These can be text, dates, numbers or choice-words:

text in quotes ¢.g. "Joe"

dates as entered on an edit display e.g. 9 Oct 1768

numbers e.g. 87

choices written out in full e.g. F (female)

When comparing dates, they must be identical to be equal, i.e.
2 Nov 1907 <> Nov 1907 is true

If any part of the date is missing, then that date is assumed to be the earliest pos-
sible for comparison purposes, i.c.

2 Nov 1907 > Nov 1907
1 Jan 1876 > 1876
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The words before and after may be used instead of <= and >= respectively.
For example, the following should hold true.

birth.date before death.date

Note that when the death.date is absent, this test is false. This is because PediTree
takes the earliest possible date: the year zero. Hence you must be careful when
using expressions involving dates.

To save typing, the following is useful:
a between b and c
This is shorthand for a after b and a before c. Note that b and ¢ must be literals.

To find out whether a field is present or absent in a record, you can use the fol-
lowing:

field-name present
e.g. marriages present finds out whether someone married.
field-name absent
e.g. birth.date absent finds whether someone's birth date is unknown.
Note that these are shorthand versions of the following:
f present is equivalent to #f <> 0 (number of occurrences of f not zero)
f absent is equivalent to #f = 0
Finally, there are two logical expressions which only work with text :
contains  finds out whether one piece of text includes another
Tike compares two names based on whether they sound alike

An example of the first is forenames contains "John", which would match
"John", "Andrew John", and "Johnny".

The like operator is based on a system called Soundex, which classifies letters
together which sound alike. So,

forenames 1ike "Alice" would catch Alice, Alison, Alistair
forenames Tike "Joan" would catch Joan, John, Jean, Jane
surname Tike "smith" would catch Smith, Smithe, Smythe

It is particularly useful with surnames that vary in spelling. See chapter 13 section
E for information about Soundex.
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Complex comparisons - AND OR NOT
A complex expression is a set of simple logical expressions linked by the words
not, and and or.

The not operator simply reverses the result of a test. For example,

not a < b isequivalenttoa >= b

not a contains b is true if a does not contain b

not surname like "Smith" catches all people whose surname does not
sound like Smith

It can also be combined with and and or.

The and operator takes the result of two simple expressions and is true if both
expressions are true. For example,

forenames contain "John" and surname = "Smith"

will be true for "John Smith" and "Johnny Smith" but false for "David Smith",
"John Brown" and "David Jones".

The or operator takes the result of two simple expressions and is true if either
expressions are true. For example,

forenames contain "John" or surname = "Smith"

will be true for all the above cases except for "David Jones", where neither simple
expression is true.

Date Comparisons
For comparison with fields of type date, you can use full dates (3 Apr 1947) or
year only (1947), but you cannot use month and year only (Apr 1947).

Comparisons based on whole years are calculated on the start of the year, so
birth.date > 1832 will include all of 1832, but not exactly 1832 without a
day and month. Conversely, birth.date = 1832 means only dates entered as
1832, and does not include any other dates in months in 1832.

PediTree treats bef.1832 as before 1832; after 1832 and circa 1832 as
after 1832.

Alternatively, PediTree allows specific dates to be entered in the YYYYMMDD?
form inside "quotes". When each birth.date or any other date is examined, it is
put into this textual format for comparison. The before after and about (circa) are
added to the date as one of the characters <=>7 where = is added to dates without
a prefix. These cause dates to be ordered into the following sequence for sorting,
indexing and comparisons:

18320000< bef. 1832
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18320000= 1832
18320000> aft. 1832
183200007 c. 1832
18320100< Dbef. Jan 1832
18320101= 1 Jan 1832

So a comparison that says birth.date > 1832 is evaluated as birth.date
>"18320000="" and will exclude 1832; to include it, say birth.date >=
1832.

PediTree will also allow the use of the contains operator on this date format. If
you want to find circa dates then birth.date contains "?" will find all
birth.date(s) that are about or circa.

Finally, quarter dates are evaluated with the month and day set as follows:

Q1 1832 "183201qQ1"
Q2 1832 "183204Q2"
Q31832 "183207Q3"
Q41832 "183210Q4"

which allows a search like birth.date contains "q", but the sequence of
sorting such dates will be about one month into each quarter.

C Useful Filters

Used in filtered searches (see chapter 6 section C), filter scripts are simply condi-
tional expressions that will evaluate as true for those records you wish to find or
select. Here are some useful examples.

Person or Marriage Lists
Extract people or marriages that appears on any tree:

treeref present
Extract people or marriages who appear on trees A or C:

treeref contains "A" or treeref contains "c"

Person Lists
Extract unrelated people:

parents absent and marriages absent
Extract people who married more than once:
#marriages > 1
Extract people who did not have any children:

#marriages.children = 0
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Extract people who did not leave a male child:
not marriages.children.sex = M

Extract people whose spouse shared the same surname:
surname = spouses.surname

Extract people and their spouses with surname Kennedy:

surname ="Kennedy" or
marriages.wife.surname ="Kennedy" or
marriages.husband.surname ="Kennedy"

To select all the Person records who were alive (to the best of recorded knowl-
edge) at whatever you have set as today (but not now=none), assuming you have
based your database on Elton55:

age between 0 and 110

and death.date absent and burial.date absent

or age between 0 and 110 and death.date >today
or age between 0 and 110 and burial.date >today

Marriage Lists

Extract marriages where either spouse marries more than once:
#husband.marriages > 1 or #wife.marriages > 1

Source Lists

Extract sources which mention someone who has RIN 154:
individuals.rin = 154

Extract sources which mention someone who appears on tree B

individuals.treeref contains "B"

D Tree Line-style Changes

Above each descendant or ancestor on a Tree, there is a line up to a horizontal
line for the parents’ generation. Similarly there is a line down to the next genera-
tion.

It is possible to change the colour (most effective, with more varieties), width and
type of line style on each descendant by using some special picture scripts in the
list of Plan picture scripts. Databases based on Elton55 have these scripts already.

For example the PLANLineUp picture script could be

if descendant.parents.marriage.notes between "(" and ")"
then
"Tine=|" end
if Treeref contains "A" then "color=Red width=2" end
and the PLANLineDown picture script could be
if treeMarriage.marriage.notes between " (" and ")" then
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~_"line=|" end )
if treeMarriage.treerRef contains "A" then
"Color=red width=2" end

These assume that you have made an Ancestors Plan for yourself or your children
as Plan A. If not, use List > Choose to erase any existing plan A before creating the
new Ancestors Plan A.

To produce the line style changes, there are three commands for the tree proces-
sor that must be in double quotes. The first one of a type will override later ones
of the same type.

Line= followed by

dot; too small to have much effect on printing.

! dash dot; too small for printing

| dash; good generally, but may not be noticed in the short LineUp.
dash dot dot; too small for printing

width= followed by one digit to increase the normal line width (2 or more will
increase the number that you may have specified in the font menu item.

Color= followed by one of the values shown below. Note that the English
spelling of colour will also work, and most colours will work with only the first
letter except for Gray and Blue. An invalid letter will not change the colour from
the default colour selected by your background font.

Any of these commands can have values as fields. (e.g. "color=" refnum) so
that you can colour your lines of descent with a suitable refnum starting with a
letter representing a colour.

Aqua Navy Gray  Silver
Blue Olive Green Teal
Black Purple Lime  White
Fuchsia Red Maroon Yellow

E Age Picture Scripts

PediTree can calculate the age of an individual from their birth or christening date
in two ways: either at a given date (Age Now), or at the date of an event in their
life (Age Then). Both calculations require a picture script called BORN to pro-
vide the base date. This picture script is defined in Elton55 as:

if birth.date present then
birth.date

else
christening.date

end
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Age Now

The date to be used to display an individual’s age is selected by choosing Options
> Dates from the main menu, then selecting a date from the resulting Options Dia-
logue. Selecting Now=none turns off the display of age now.

To display age now you can use the field AGE in any Person picture script, or
descendant. AGE. In Elton55, it is used in the Person name picture script so that it
shows against all names:

if death.date>today or burial.date>today

0; death.date absent and burial.date absent and age< 110

then

[ ll{nOWllAGE"} n ]

end
The use of {braces} is a personal choice and the word ‘now’ is used to avoid con-
fusion with ages calculated from an event date, where the word ‘aged’ is used.

The variable today is altered by the Options dialogue. It takes the format
20031122= (22 Nov 2003 exact date)

3

but the ‘=* sign will be absent at the start of a session and when setting
Now=none. This can be used to prevent showing ages and comments when no
date has been selected. e.g. following other conditions:

if today contains "="then "{now dead}" end

Another method to show {now dead} when a date has been set for today, compat-
ible with Pedigree for DOS, which works when BORN is before today is shown
here:
if AGE>0
then if death.date present and death.date < today
or burial.date present and burial.date < today
or AGE>109

then "{now dead}" end
end

Age Then

Using the AGE field in a picture script after another date field causes the display
of the individual’s age at that date. This is usually in a picture script for a group,
such as event, occupation or residence, to show the age when an event took place.
The Elton55 database has a version of the detail picture for each of these groups
which has been called ages. These are the contents of these three picture scripts,
which use variable descendant to reference the Person whose age is to be calcu-
lated and either date, from or to define what is meant by then:-

ages(event):

if notes between "(" and ")" then notes date ["in" place]
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else date ["in" place] notes end
if date present then [" {aged"descendant.age"} "Jend
cite(source)

ages(occupation):

normal ()
if from present then [" {aged"descendant.age"} "Jend
cite(source)

ages(residence):

dwelling road locality town county postcode country
[ll(ll .From II_II tO ll)ll

if from present then [" {aged"descendant.age"} "Jend
cite(source)

In the case of marriages, there are two main people to get ages for, so it is not a
good idea to use ages(marriage) for this event. The Elton55 database uses the
Marriage picture scripts below to show the ages of husband and wife.

MarWife(Marriage):

if marriage.date present then

[" {aged"husband.age"} "Jend

if margiage.notes between "("and")" then " = " else
llm. llen

if #husband.marriages>1 then ["("marriagenumber")"] end
normal(marriage) 1% wife present then " to" wifeName()
ifdmarriage.date present then ["{aged"wife.age"}"] end
en

MarHusb(Marriage):

if marriage.date present then

[" {aged"wife.age"} "Jend

if margiage.notes between "("and")" then " = " else
m."en

if #wife.marriages>1 then ["("marriagenumber™)"] end
normal(marriage) " to" name(Chusband)

if marriage.date present then ["{aged"husband.age"}"] end

You can use these picture script names in the detailBox picture script for Person
as follows:

name() title [|"ref:" refnum] tree()
[| treepar()]

ages(occupation)]

"b." detail(birth)]

"bapt." ages(christening)]
"educated at" education]
families(Q]

"address: " ages(residence)]
"d." ages(death)]

"bur." ages(burial)]

"will" ages(will)]
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[| notes]
separator=
cite(sources)

separator=|

[| "Mentioned in:"|censuses]
[| "objects:"objects]

F Links picture script

Main menu File > Check database can check all records that have a user-specified
two-way link between two types of record. This check requires a special picture
script called ‘Links’ for each record-type to be included in each database defini-
tion.

When Check database is checking through each type of record, it will report or
repair links in the related record(s) that it finds, not the current record. So, for
example, if it encounters links in two sources fields in a Person record, it will
check that the corresponding individuals link in each of the two Source records is
present.

These links picture scripts are also used when records are updated, to form the
other end of the link. For example, entering a sources link in a Person record will
automatically insert the corresponding individuals link in the Source record.

Database definition Elton55 already has these links scripts, as printed below.

Person Links
sources.individuals
censuses.individual
adoptedBy.adopted

Remove the first line above if you do not want to link back from a
Source.individuals field to all Person records. This applies if you use general
Source records such as ’family knowledge’, ‘parish register’, ‘IGI’.

Note: links to Source records in groups such as events, occupations and resi-
dences do not maintain the Source.individuals links.

Marriage Links
adopted.adoptedBy

Source Links
censuses.source

Note: Source.individuals does not maintain the reverse link, because it is used
for too many different kinds of links from Person.

Census Links
source.censuses
individual.censuses
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G Hot Links

Links formed from one record to
another can be selected by swiping
selected text with the mouse in order
to change the Detail Box to show that
record. This is particularly useful for
showing Sources for each event. The
Detail Box picture script must cause :
the RIN to be shown immediately after J=eizh 2 g cwee] ok |
a caret symbol (*). This character used

as a hot link marker can be altered in the Options dialogue, but this would involve
you in altering all picture scripts to correspond, so is not recommended.

Databases based on Elton55 have these scripts already.

H Picture Script Editor

After selecting Options > Picture scripfs... from the main menu you will see group,
choice and record names listed at the left of an editing window. They are fol-
lowed by all the Tables, Reports, Charts and Tree picture scripts. Plan picture
scripts are prefixed PLAN in Person picture scripts.

The last record, group and choice will show ‘empty’. This in readiness for adding
a new one: see chapter 2 section C.

Select a record or group (not a choice) and you will see a list of the picture script
names as tabs along the top of the window. If there are too many, click on the top
right arrows to shift them along.

To change to a different field type, click on Other types as a tab or as a button.
All Tables, Reports, Charts and Tree picture scripts are checked for syntax errors
and can be viewed and tested.

If the memo window is not grey, then you can edit the picture script. (See the
illustration on the next page.) Changes will only be saved if you click Test or
OK. Save any changes and close the window by clicking OK; close the window
(abandoning any changes) by Cancel or pressing the Esc key.

Click on the Test button to test the picture script with the current record of the
type that is currently selected.

Groups can be tested if there is a field of that group-type in the currently-selected
Person record; the first field of that type that is present is used. If you want to test
an event such as death, but not birth, filter a Person list with the script birth
absent and christening absent and death present, and click on one that you want to
test before using Options > Pictures scripts > event.
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event group picture script ages
'-\Dther typeszbrief xnormalxdetailkagm,‘GED RBIHT KCHH KDEAT KBUHI EWILLKMAHH RDIV}
hl‘l notes betueen "™ and "1" then notes date ["in" place] else date ﬂ

["in" place]l notes end
if date present then [" {aged"descendant.age"} "lend
citelzource)

picture scripts?
date

place

notes

source
DESCENDANT
SPOUSE

]

OtherTypes | Test |

Conditions | xl:ancell 0K |

Click the Conditions button to select an operator such as = <> for use in compari-
son of fields.

Amend the script by clicking at any point in the text and editing it.

Click the Fields button (as shown above) in order to show a Field list in this type
of record or group that can be picked and inserted into the script after the point
where the cursor is. If the field is a group or a record, then another list of the
fields in that data type will be shown until you have selected one of the elemen-
tary fields. The whole hierarchical compound value expression is made up of the
names separated by full stop symbols.

The top item of link or group selection will be the name itself for use on its own.
It will use the default picture script which is the first picture script for that record
or group.

If you click on the top item when it shows picture scripts? then a list of the script
names is shown for you to pick from. This will be inserted after the cursor posi-
tion with the group or record name in brackets. The choice can be restarted by
clicking the Field button again. The helpful hint will keep a note of the com-
pound field that you have built so far.

Test your script with the Test button and it will be changed for this session of
PediTree. Use the main menu File > save lists and defns. to update your database
permanently.

If the debug option is checked (ticked) in the Windows menu, then the Diagnos-
tics log will be filled for the application developer’s use.
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Make Windows > debug ticked and then test a script. All new line characters ( | )
will have the picture script name output too, before the new line. All separa-
tor= commands will have the picture script name enclosed in {braces}. Picture
script names are suffixed by the first letter of the record type to distinguish them,
apart from the top level. Look at the Diagnostics log if you want to get micro-
scopic detail, but turn debug off before normal use. You can save the diagnos-
tic log file which contains details of your database when it closes.

If you set the Windows > debug check mark, then the names of picture scripts
used will appear interspersed with the resulting picture script in the test — or in
subsequent Trees, Reports, Detail Boxes, etc. This is intended to help you dis-
cover which picture script names are used inside a complex script, and where
they affect the script.

Be sure to turn debug off after use! It will fill the log list/ file if nothing else!

J Picture Script Errors

If you see a box showing a syntax error when loading a database, the Diagnostics
log will keep a note of which picture script was faulty. If the error was at the end
of a long script that was last edited in Pedigree for DOS, it is possible that a line
in the script is over 255 characters. If so, then using Pedigree for DOS, edit that
picture script and press the Enter key at a suitable point to break the script into
shorter sections. Other common mistakes in scripts from Pedigree for DOS are
‘contain’ instead of ‘contains’ and too many ‘end’ statements.

Other errors can be corrected and tested in PediTree, but remember to save them
using the main menu option File > Save lists and defns immediately or when clos-
ing the database.

Note: if you have a script error, amend it and test it, your changes are saved
only when they are all successful for that picture script. That means
that you have to repeat earlier

corrections at present.
iDther Iiﬁes xbrief ?\nolmaxdetal }\ggﬁGED KBIRT KEHH JDEAT fEUF
K PICtu re Scrl pt Name Efl_ngte? he%ueen " ?d "1™ then note  APpend e date
ags in" place] notes en
Changes or Additions if date precent then [" uged"demndmm—l. e

citelsourca)
To change or add picture scripts,
choose Options > Picture scripts from
the main menu. You can only change
picture script names for records or
groups, but not reports of any type.

Select the tab for the picture script that
you want to rename, or any script if

you want to add (append) a new script
name to the end of the script name QtheiTypes Tet | Puep| Fews |
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tabs. New script names are never inserted, except before the record EDIT or
PLAN scripts, because EDIT and PLAN scripts must stay together.

Right click anywhere in the tab line for a pop-up menu for Append or Rename (as
shown), once a tab has been selected. Right-clicking on one of these existing
script names will make an edit box open on the line of tabs for you to type the
new name and press Enter or Esc. Then use the script editor to enter your new
script.

You cannot delete a script name. It is best to change its name to ‘empty’, and
delete its script text, so that you can reuse this entry to make a new script later.

L PedSpecs Utility Program

PedSpecs is a viewer for the specifications of PediTree database designs. Its pur-
pose is to help the understanding of the database designs, particularly the picture
scripts that control how the stored information is displayed. Such understanding
helps when changes to the design are contemplated. No further instructions for
PedSpecs are provided here; it has its own on-line documentation.

If you didn’t install it from the CDROM with PediTree, there is a Windows ver-
sion of Colin Liebenrood’s PedSpecs which you can download from

<http://wiki.pugweb.org.uk/>.

PedSpecs for Windows is a development of PedSpecs for DOS that originally
provided this function.
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Chapter 5 Family Display and Detail Box

The Family display shows three generations with a husband and wife in the cen-
tre. All people can be selected for use by other features such as Ancestors’ Charts
by a single click and the Detail Box will be filled. The marriages of the parents or
grandparents can be selected too. The person or marriage thus selected becomes
the current record of that type.

+ Family of “M051 Captain Mark PHILLIPS “P129 & Anne “P039

Captain Hark PHILLIPS “P129
2 children

—

#hilip “POGOr

Arne  “PO89,PHILLIPS, LAUREHCEr

Anne “P089 Princess Royal ;I
(2 partners)

dau.of “M029 Philip “P060 & Elizabeth Il “PO67 1
b.1950

{aged 23} m.[1] 14Nov1973 to Captain Mark PHILLIPS “P129 {aged 25}
div.1992 and had 2 children:
1. Peter PHILLIPS “P130 [15Mov1977]
2. Zara PHILLIPS “P131 [15May1981)
{aged 42} m.[2] 12Dec1992 to Tim LAURENCE “P154 {aged 37} no children.
hanged:24Jul2004 21:28

A Using the Family Display

Double click on a child, a grandparent or a grandparents’ marriage to redisplay
the window with that person or couple in the centre. Children will be shown with
an = sign if married, with a + sign or left-facing triangle if they have their own
children, so that you can see which ones to expand.

Grandparents that themselves have parents will be shown with a right facing tri-
angle.

Note: If a vertical line is shown instead, use Print > fonts to select Family
fonts. Ensure that the Terminal font is chosen for triangles or another
font for < or > symbols, and click OK, or perhaps change the size of the
font too. Returning to the Family display, double click a parent to
refresh the display, and hopefully the display will look similar to the
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illustration. If you have not chosen Terminal font, then close the DB
and when it reopens, the triangles or faulty symbol will be replaced in
child and parent scripts by < and > symbols.

Several Marriages

Where a husband or wife has more than one Marriage record, which may include
common law liaisons, a set of tabs will appear below their name box (as for Anne
in the illustration). Click on each one to reveal the appropriate partner and mar-
riage detail; the children will also change. If there are too many marriages, then
arrows will appear to select more tabs. You may need to stretch the Family dis-
play to see these.

If a child is in the wrong sequence by birth or christening date, and the database
was based on Elton55, then the child number shown in the left column will have a
question mark (?). See Family Updating below for how to drag them to the cor-
rect sequence.

If the database was based on Elton, Elton55 or Royal03, an asterisk * may be shown
before the name of any Person who is on Plan A. Normally the first plan made
will be an Ancestors plan for yourself or a descendant, so that your ancestors are
marked with an asterisk for ease of browsing around the family. This will also
cause red blood lines to replace blue lines in charts and trees for these people. See
chapter 4 section D for more information on line styles.

The family selection can be backtracked by clicking the down arrow in the top
border. Then you can retrace your steps forward with the up arrow. The last eight
families are memorised in a circle.

The Family display can be stretched horizontally when you drag the left or right
hand edge. Drag the bottom edge to change the size of the Detail Box.

To view more than nine children, you can resize the Detail Box. Hover the
mouse over the horizontal line below the family until it changes to double bars,
then drag it down to reveal more than nine children without reducing the font
size. If the Detail Box disappears completely, then select a parent by a click,
close the Family display, then click on the show family button on the Toolbar to
open a new one.

B Family Pop-up menu
This will be shown by a right click on any members of the family or their mar-
riages. There are more entries in this menu when in Edit mode. Some of the

entries carry the identity of the record involved (e.g. P1; M3), indicated by the
shorthand /d below.

Note: the illustrations overleaf show pop-up menus for both View (left) and
Edit modes (right). Only one such menu can appear at a time.
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Mark Id (person only) : will ‘mark’ the I Coptain ork PHILLIFS 129
Person chosen ready for placing them in an |
empty family position. A marked Person

record will be shown on the Toolbar, using

the Person marked picture script.

14MNov1 97 3 div.1982 *MO51 .

; ; RIN select.. FilN select. .

Note: a left- or right-click on the marked ;Efms?“ Edit M51
person entry on the Toolbar will Grid M1 GridM51
make that record the current one. A = detaiBax Print ::;"i:;a‘“
left-click will also allow you to hide e B e
this entry if you wish. _— Find in index

RIN select : brings up an edit box in which

you can enter a known RIN and press Enter to
position the Family display to that person or mar-
riage. Press Esc to return to the existing display.

Edit Id : brings up an Edit display (vertical) for the

| firme  “POEY,PHILLIPS, LAURENCER
current record. On an empty position, /d will be

I3

‘none’; in Edit mode on a person position, this will ' E&";;; [T marre
become ‘new person’, thus allowing the addition of EdPs E‘I:E:;I;ct...
a new record. B e
. . S ) ibeth I zﬁfpfr detailBox Piirt
Grid Id : brings up a Grid display (horizontal) for Find in indes draw Bepot...
the current record. On an empt ition, Id will b > LR
: . pty position, fa Wil BE ptain Mark PHILLIPS *F jnsert mariage
as for Edit /d above. ';T] ;;:;a P':ilge
. . . . I .
Both the Edit display and the Grid display canbe = UAIRENE P14 sar RIS |

used to change the record when in Edit mode.

detailBox Print : will print the contents of the Detail Box, but not limited to its
size on this screen. It uses the current print set-up.

draw Report : the Family display will be replaced by a Report. This display will
have tabs across the top for the Reports available for the type of record that you
had selected. Click on the Back tab to return to the Family display. See chapter 10
for Report printing.

Find in index : locates the current record in an index and brings up a List display
of that index, with the record highlighted.

Edit Mode

The following additional entries are present when in Edit mode:-

Detach Id : (here Id is a spouse or a child) detach a child from their parents’
family, or a spouse from their other half in the marriage. If you intend to place
the detached person elsewhere, then Mark them first. When detached, only the
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link is removed; this person remains the current marked person, ready for placing
in a new relationship.

Insert Id : insert a new child or marriage in between existing entries. Select the
child or marriage before which the new entry is to come, then right-click and
choose this option. (There are other ways to add a new child or marriage after any
existing ones).

Delete 1d : delete the record of the person or marriage. Unlike Detach above, this
removes all links and the record entirely from the database.

Add marriage : add a new marriage after any existing ones for this person.

Place Id : place a previously-marked person as a child or a spouse in an empty
position. Here /d will identify the person to be placed

C Family Updating when in Edit mode

If a child is in the wrong sequence by birth or christening date, and the database
was based on Elton55, then the child number shown in the left column will have a
question mark (?). To move a child within a family, drag the child number (using
the left mouse button) to the correct position. The rows will be interchanged on
screen before you are asked to confirm the rearrangement. Then the child num-
bers will be recalculated and the database updated.

The Family display will show an empty box . Family of “M029 Philip_“P0S0 & Elizabeth Il “POS7
for another child of the family, unless you
have just switched on Edit mode. If there is no
space for the last child, double-click the father
or mother to refresh the display. You cannot
have more than 20 children in a Marriage.

Eduard

To insert a spouse, merely edit the empty per-
son and a Marriage record will be created. Al sclect.,

Edit new Perzon cess Royal
When placing a Person who has been marked = [E#nenfesn
in a List display, you may discover that it can’t
be done until they are detached from a similar )

. . . . {aged 23} m.[1] 14Nov1973 to Captain Mark PHILLIP!

relationship. For instance, a Person with par-  div.1992 and had 2 children:
ents already can’t be placed as a child. Detach
them first. The message “Marked person is their own parent” will appear if you
try to place a parent as a child in the same family.

n ilip “POG0 & Elizabeth Il “POG7
b.1950

To see or change the full marriage details of grandparents, first double-click to
bring them to the parents’ position in the centre of the display.

If you place a spouse, then if they were already married, this will become the last
of their marriages. This can be used to rearrange the order of their marriages.
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Detach them from an earlier marriage, and when you place them again, that will
become their last marriage — with any children of that marriage. You cannot
insert an existing marriage, only detach and place all the children and other
spouse after inserting a new Marriage record as above.

D Detail Box

Each of the main displays has a facility to show the full details of a selected
record in a bottom panel called the Detail Box. This uses a picture script called
DetailBox for each record-type to define how the record is displayed.

In the List display, if this is showing a plan, then the PLANdetailBox picture
script for a person is used. This shows the database version in the form YMM,
e.g., DB= Families.412 for Dec.’94 (if this is defined in the database).

If you right click in the List, Family or Chart display, you can get a pop-up menu
and can choose to print this Detail Box using the heading and body font.

A left click will zoom the Detail Box, expanding the width to full screen. It will
then use the font selected in the Print menu for the Detail Box. Another click (or
the Esc key) will return the Detail Box to its original size. In the List or Family
displays, key F4 will toggle the Detail Box between zoomed and normal size.

The usual movement keys can be used to browse the text in the Detail Box.

If you right click within the detail box, you will be able to use standard Windows
select, Cut, Copy & Paste to transfer data within PediTree or to other Windows
applications.

Hot Links

If you have set Options > RINs shown and are using a suitable database design
(such as Elton55), then the RINs are shown preceded by a caret (*), e.g. “P123.
This format acts as a hot link to the record in question. Position the I-beam cursor
just to the left of the caret, press the left button, move the cursor to the right over
the RIN, then release the button (this process is called swiping). The Detail Box
will change to display the selected record.

A filename can appear in any text field. Any such filename should start with an
optional drive specifier followed by a backslash, e.g. \pedigree\cottage.bmp
or c:\pedigree\henryviii.jpg. Swiping such a filename in the Detail Box
will cause files of type BMP or JPG will be displayed by PediTree. They will be
displayed at their actual size, not scaled to fit any particular space. Other file
types will activate any associated application to “display” the file. For example,
type RTF will normally open WordPad; DOC files will invoke Word (if
installed); WAV files will be played as a sound clip, and so on. Ensure that you
only select the exact \path\filename when swiping. Files not found will be noted
in the Diagnostics log for investigation later.
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The List display is probably the most used facility to browse through or select an
individual record of any type. Any of the available lists may be selected for
display from the main menu List > Choose or the corresponding button on the

toolbar (|E]).
A Types of List

There are nine different types of lists that may be shown in the List display:-

1. An Index on a single record-type,
headed e.g., ‘List 1 Indexed ....". This
is the only type of list that stays up-to-
date as you make changes to your data-
base. Created by List > Create Index
with one or more keys specified.

2. A filled list of a single record-type,
headed e.g., ‘List 2 Filled....”. Created
by List > Create Index with no keys
specified, or by filtering another list.

3. A sorted list of a single record-type,
headed e.g., ‘List 3 Sorted...”. Created
by sorting another filled list or index.

[_[O] =]

f. List1 Indexed with 8 Person records
Index using surname.forenames.birth.date,
;]

ROE “F0
Alan ROE "P001 [bapt.170c11§35-14May1910]
Bernard ROE “P003 [17Dec] 865]
Charles Henry ROE *P004 [1869)
Frances ROE “P005 [1867)
Malcolm ROE “PO0O7
Susan SHARP “P002 [c. 1840-27May1875]
Tessa TILMAN “PO06
{End of List] Indexed with 8 Person records}

Alan ROE “POD1 =

son of “MO03 ROE “PO08

farmer at Worthing [1862-] [aged 26}
b.in Slindon, Sussex
bapt.170ct1835 in Slindon, Sussex

{aged 26} m.17Jun1862 in Slindon, Sussex to Susan SHARP “P0O02
[c. 1840-27May1875] [aged 22) and had 3 children:
1. Bernard ROE “P003 [17Dec] 865 in Worthing. Sussex

source” 5002 cert.) m. to Tessa TILMAN “PO0G

When re-opened, this type will appear as a filled list.

4. An Ancestors Plan, headed e.g.,
‘List 4 AncTree ....". This is a plan for
a tree of ancestors, created by choosing
List > Ancestors plan (or the corre-
sponding Toolbar button |£F ).

5. A Descendants Plan, headed e.g.
‘List 5 DescTree ....". This is a plan for
a tree of descendants, created by
choosing List > Descendants plan (or
the corresponding Toolbar button

)
6. A list of Places, headed ‘Places’,
created by List > Places List or List

Places from the pop-up menu in the
Choose List dialogue.
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1. List2 AncTree A for 18 generations Irulh\l:hmle; “Foag

15:3 Victoria “PO02 5
16:2 Edward VIl “P004 & Alexandra of Denmark “P016

16:3 Alexandra of Denmark “P016 & Edward VIl “PO04

17:2 George V “PO18 & Mary of Teck “P019

16:4 Francis “PO87 & Joan “PO86

14:5 George Il “PO71 & Sophia Charlotte of Mecklenburg-Strelitz “PO7
14:6 Sophia Charlotte of Mecklenburg-Strelitz “PO72 & George |Il “PO7
15:5 Adolphus “P0O77 & Augusta of Hesse-Cassel “POB4

14:7 Frederick LANDGRAVE of Hesse-Cassel “P140 & Caroline of Nas:
14:8 Caroline of Nassau-Lusingen “P139 & Frederick LANDGRAVE of F
15:7 Augusta of Hesse-Cassel “POG4

16:6 Joan “PO8E

17:5 Mary of Teck “P019

18:3 George V1 “PO62 & Queen Mother Elizabeth BOWES-LY'ON “POG

18:4 Queen Mother Elizabeth BOWES-LYON “POGE & George V1 “POE:
19:3 Queen Elizabeth Il “PO67

20:2 Charles “PDBB

{end of list2 of 42 Person records}

George V1 “POGZ
b.1695

(CI[E%

d.1952 [also at A18:3)

m. Queen Mother Elizabeth BOWES-L'YON “PO66
d.30Mar2002 [also at A18:4]

DE=Royal0307
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7. A list of Dates, headed ‘Dates’, created by List > dates List or List Dates from the
pop-up menu in the Choose List dialogue .

8. A list of text entries, created by List > Find text or Find text from the pop-up
menu in the Choose List dialogue.

9. A list of text entries, created by the Replace Text function (see chapter 7 sec-
tion C).

Types 1-5 are stored in your database and will be available if you come back to it
in another PediTree session. Types 69 are not stored and are lost when you
close the List display or leave PediTree.

The format of the display for types 1-5 is determined by the relevant picture
script named list from your database; for 4 & 5 (known by the shorthand plans)
this is the PLANlist script found under the Person record.

Single click an item in the list to select it and show it in the Detail Box, which
works in the same way as that in the Family display. The highlight will be placed
on the current record this type, which is normally the last one selected.

Double-click an item to bring up the Edit display.

Use the RH scrollbar to quickly move down a list. PediTree adds lines to the list
by paging in about 100 lines at a time. (This setting can changed from the
Options dialogue, obtained by Options > Seftings.) If the visible part of the list has
to be extended, then move the mouse into the List box and you will see the scroll-
bar move to your current position in the extended list. Alternately using the
scrollbar and the List box will move the visible section. You can press the End
key to go quickly to the end of the list; Home to the beginning; the Page Up and
Page Down keys have the expected effect.

B List Pop-up Menu

A right-click on any list entry (but not # List] Indexed with B Person records
. . . Ind i .fo Wbirth.date.
the heading-line) will pop up a context || ROEBIOD.
menu. The entries in this menu will Bemard ROE P00
. . Charles Henry ROE * i Fi
vary depending upon the type of list Frances ROE “PO0S [ Sovefu e 52D . »
. d Malcolm ROE *POOT Gy soiecr .
and whether you are in Edit mode or Susan SHARP PU0Z g pon
. . eSS
not. The following paragraphs give {End of Listl Indexed ) }
. . . . Filered seach .
brief descriptions of each possible o RO T =
entry. s0n of "M003 ROE “F Saitst
farmer at Worthing [1 drawTable
. : 3 b.in Slindon, S
Mark Id : (person list only) will bopt 170611835 in Slindon, Sussex
‘mark’ the Person /d ready for plaCng {aged 26} m.17Jun1862 in Slindon, Sussex to Susan SHARP “P002

: : L [c. 1640-27May1875) {aged 22} and had 3 children:
them in an empty family position. A 1. Bernard ROE “P003 [17Deci 865 in Worthing. Sussex
source” 5002 cert.] m. to Tessa TILMAN “PODB
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marked Person record will be shown on the Toolbar, using the Person marked
picture script.

Save list text, GED.. : save the list to a file in various formats. A sub-menu will
allow you to choose from text, GEDCOM 4 Pedigree or GEDCOM 5.5. A stand-
ard Save As dialogue will be shown with a warning if you want to overwrite an
existing file. The text form has a maximum line-length of 255 characters.
Choosing GEDCOM 4 will save the list records for import to another Pedigree
Software database. To save the list records for import to other software, choose
GEDCOM 5.5. This option will only be available if your database is suitable; see
chapter 12 section D.

If you draw a Table (see below), then you will have options for saving as an
image, or in tab-delimited, RTF or CSV formats.

RIN select : brings up an edit box in which you can enter a known RIN and press
Enter to position the List display to that person or marriage. Press Esc to return to
the existing display.

Find record-type : (for indexes and P T Y ——
sorted lists only, not plans, places or
dates) find a record by sort-key. You
will see the names of the key fields to
be typed. Type some letters and the list
will move to that position. Separate
fields with a comma, and the program -

will insert a space before the comma. |F,'.,":,r..| Pt
When you have found the record you
want, click on the list entry to hide the
key-finder box and show the Detail
Box again. Press the Esc key to return
to the list without completing a find.

Index using surname.forenames,birth.date,
ROE “PO0&

Alan ROE “P001 [bapt.170ct1835-14May1910)
Bernard ROE “P003 (1 7Decl B65)
Charles Henry ROE "PD0A [1869)
Frances ROE “PO0S (1867

Susan SHARP “PO02 [c. 1840-27May1875]
Tessa TILMAN “PO06
{End of List] Indexed with 8 Person records} %

To repeat a similar find, before clicking on an entry or pressing Esc, select the
key text by swiping the mouse over the first part, then press Ctrl+C to copy it to
the Clipboard. On the next find, paste it into the key, using Ctrl+V.

If the first key is a date, then you must type the 4-digit year first, then the month
and day numbers if required. You will be prompted YYYYMMDD to overtype.
You can add the suffix to the "yyyymmdd=" format, where = means exact, <

before, > after, and ? circa.

Note that if a key is a number, such as a RIN, then you must enter zeros to make
it up to 5 digits.
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Edit Id : if an entry is highlighted, then an Edit display for that record will
appear. Double-clicking an entry will usually have the same effect.

Grid Id : if an entry is highlighted, then an Grid display (horizontal) for that
record will appear.

Filtered search : (index or filled lists only) allows you to select records from the
current list by using a Filter or conditional expression. This option brings up the
Script Edit display for you to enter the script to be used. See section C below.

Volumes : (plans OHIY) will display a t List2 AncTree A for 18 generations from Charles “P08B M= E
grid of the tree layout, as shown here.  [free i 2 s [ 5 2
3 10 97+0=33 98
CllCl'( on any of the? cellls to return to ] s5e0=32 195
the list. At first, this grid shows the hz | 93+0=31 94
: : 13 f+0=21 72
layout using RINs , in the fqrm | svicos 7o .
descendant + spouse = marriage, 15| 140=1 2 71v0=27
e.g. 122+123=37. You may need to Ho—| s e
widen columns (by dragging the divi-  [iz_| 6240=19 66
sions in the header-row) to see the I 60+0=29 = &7

whole of each entry. The overall depth
and width in strips of the tree can be .

George VI “PDG2
clearly seen. b.1895

d.1952 [also at A18:3)
. m. Queen Mother Elizabeth BOWES-LYON “POGE
After a Tall or Wide Tree layout has . 30Mor2002 also at A16:4)
been displayed, the volume grid will 4
show the number of lines of text in
each box, with the maximum number

shown at the top of each strip.

EF
e

]

detailBox Print : will print the contents of the Detail Box, but not limited to its
size on this screen. It uses the current print set-up.

draw Report : the List display will be replaced by a display of a Report. This

display will have tabs across the top for the Reports available for the type of
record that you had selected. Click on the Back tab to return to the List display.
See chapter 10 for Report printing.

Sort list : (not for plans) a new list will be created from this one selected, and
keys to sort it on can be chosen, unless this was a Places or Dates list. These lat-
ter types are automatically sorted on their initial characters. For other types, see
chapter 8 section E Index Create for the method of selecting the sorting keys.

Tall Tree : (plans only) the list screen will be replaced with a diagram showing
the layout of a Tall Tree. See chapter 11 for more information on Trees.

Wide Tree : (plans only) the list screen will be replaced with a diagram showing
the layout of a Wide Tree. See chapter 11 for more information.
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Draw Table : (indexes and filled lists only) the List display will be replaced with
a display of a Table. This display will have tabs across the top for the Tables
available for the current type of record. Click on the Back tab to return to the List
display. See chapter 10 for information on Tables.

Insert Record : (Edit mode in indexes, filled lists and plans) brings up an Edit
display to create a new record of the same type as the list. This doesn’t work for
Marriage records, which are created in the Family display.

As you cannot display an empty list, the first record must be created using the
main menu Edit > Edit record > Insert.

Delete Id : (Edit mode only, in indexes, filled lists and plans) will delete the high-
lighted record in the list and in the database. Any links between Person and Mar-
riages records such as parents and children and marriages and husband and wife

will be unlinked at the other end. From a plan list, a Person record will be deleted.

C Filtered Searches

A filter is a test that is applied to every record in a list. All the records that pass
the test are put in a new list. Starting from an index or otherwise unfiltered list,
you can apply up to four filters in sequence. These will be numbered Filter 1°,
‘Filter 2° .. ‘Filter 4’. Once you have a list that has all four filters, the Filtered
search option in the pop-up menu is disabled.

A filter comprises a conditional expression that is typed into a Script Edit box.
After typing the script, click on Test (to verify your typing) or else click OK. If
you click Cancel, or OK without entering a valid script for the filter, or if no
records are matched, then either no list will be created, or one marked ‘erased’ in
the Choose List dialogue.

The new list will be displayed with a heading showing how many records were
found by selecting records from the old list. As the old list is still there, you can
move their List displays to compare them.

All lists with their keys and filter scripts can be seen by using Options > Picture
scripts.

To help you write a filter, you can use the Fields button which provides a list of
fields for the current record type or group. Select one of these by clicking and it
will be inserted into your filter or show you another sub-field. The helpful hint
will remember how far you have got. At the bottom of every list of fields there
are one or more pseudo fields that show information derived from real data,
which can be used in your filter scripts. See chapter 4 sections B & C for more
on the conditional expressions and useful filter scripts.
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Filter Examples
Here are a few examples of filter scripts:-

surname like "smith"

This would find all people with surnames which sound like Smith e.g. Smythe,
Smyth.

forenames Tike "John" and surname Tike "Smith"
not surname contains "Jones"
birth.date after 1700 or death.date after 1700

sources present and ]
not sources.individuals.RIN contains RIN

treeref contains "A" or treeref contains "b"
You can save a filter for alteration next time by copying it to the Windows clip-
board. Then you could even paste it into any text field in a spare record for use in

another PediTree session when you can update the database. Otherwise, just
copy it from a previous list by clicking Other types.
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Adding new information or amending existing information in records is carried
out using several different displays. The two basic editing displays are the Edit
display and the Record grid. Both of these can be produced from either the List
display (double-click on an entry or use the pop-up menu), the Family display
(pop-up menu) or the main menu Edit > Edit record. A subsidiary display for edit-
ing in specific circumstances is the Text display.

An alternative method of making a number of changes is to use Replace Text.
This is an extension of the Find Text facility that operates on either a list or on the
whole database. It is described in section F below.

A Edit Display

The Edit display has the field names in
the second column, the information in
each field in the third column and flag
characters in the first column. The top
row shows the record-type and RIN.
You can scroll vertically if necessary
to see all the fields.

Where the field contents is too long for
the display, the text is truncated. Group
fields are shown in summary form,
indicated by a + in the left column.
Click on the + to expand the group and
show its component fields. Fields of
the longtext type, such as notes, also
have a + sign to their left; click on this
to display or edit the text in a Text dis-
play. Any field showing a + in the left
column must be expanded before it can
be edited, as in the second illustration.
Choice fields, such as sex, are marked
by a c in the left column; pressing
Enter on a choice field will bring up a
list of possible entries.

1o
Fields Data for Pesson 1 ﬂ
©|sex M
forenames | Alan
sumame Roe
prefix
postfix
nickname
title:
+ | birth Slindon, Sussex
+ | christening 170et1835; Shndon, Sussex
+ |death 14Mayp1910; Brighton, Sussex
+ | burial
education
+ |occupation 1 |Shop assistant; Slindon; 1862; Roe's Drapers
+ |occupation 2 |Draper; Worthing, Sussex; 1862
+ |residence
+ |notes christening: source. parish register at West Sussex Rec
refrum =
+ | birth Shindon, Sussex
+ | chrigtening 170ct1835; Slindon, Sussex
- |death
date 14May1910
place Brighton, Sussex
notes
Tource
+ |burial

If you are in Edit mode, then the fixed row and columns will be in your choice of

colour, not grey or button colour.

Fields can be edited as described below. To save your changes, press key F9, or
use the pop-up menu. Although the record will be changed immediately, other
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open displays like lists, charts, etc., may have to be made again before the
changes appear.

Field Editing

To add information or change any field, move to that field. If it has a + to its left,
then click on that (or press Enter on that line) to expand the group or longtext
first. When editing a field, if a flashing cursor is visible then the normal Windows
editing rules apply. You can use the normal short-cut keys to copy, cut and paste
to/from the Clipboard, or the pop-up menu for the same functions.

Press key F9 to save your changes, either in a Text display or the Edit display.
From the Edit display, key Ctrl+S or F9 updates the database on disk. Alterna-
tively, key Esc will abandon your changes, as will using the close button to close
the Edit displays. You may be asked to confirm that you wish to abandon your
changes. See also Validation below.

Edit Display Pop-up Menu e
A right-click on a field-name (not on =t palefeml 1
the data) in the Edit display will bring ~ Zsmesju
up a context (pop-up) menu, with a o
number of options. These depend upon e
the type of field, whether it contains  FE=——__
information already and the View / g
Edit mode. IS oe icars
:—i Sppend rew dhrstenng 2 :::;EK
Note: the illustration shows four dif- Mo Pewowey | eGSR | e
ferent pop-up menus; you can G e
only get one at a time. i : [——
 [sceupation 1 5ho aristan-Siedon: 1862: Rae's Diapes P
. Fliopsin Aimtc L s
These are the options:- e hm S i
+[motes regites ot West Surtes Fecod Dffice
abandon Esc : abandon the changes == 20
made so far, if any. Iy
[ [stotey E

Edit Panel : leads to a submenu; see
section C Edit Panels below.

Save Ctrl+S or F9 (Edit mode only) : save the changes made and close this dis-
play.
Help on /d : display on-line help for this field: Id is the field-name. This only

works for standard fields in Elton55; any fields that you add will produce a warn-
ing message instead.

Append new Id

Insert new Id (Edit mode; field or group containing information) : add another
field or group. Insert adds before the present one; append adds after it.
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Delete Id (Edit mode; one of a set of repeated fields or groups) : remove this field
or group.

Repeat text F3 (Edit mode, non-group field) : copy the information from the
same field in the last record edited into this field; zext is the information that will
be copied. If none, this choice will be disabled

Pick from list Ctrl+P (Edit mode, choice field) : for a choice field (such as sex),
marked ¢ on the left, , brings up a list of possible entries. A click on any entry in

the list will insert it into the field; press Esc to close the list without changing the
field.

Pick from list Ctrl+P (Edit mode, place field) : brings up a display of place-
names, which will contain those defined earlier by yourself; see Place Fields
below. A click on any place-name in the list will insert it into the field; press Esc
to close the list without changing the field.

Pick filename Ctrl+P (Edit mode, ficld named file in a group) : browse for an
image file of type BMP or JPG, or a sound file, with a standard Windows Open
File dialogue. See the Objects File Field paragraph below.

Place link to Id (Edit mode, empty link field, relevant current record defined) :
copy a link to the relevant current record into this field. /d is the link that will be
copied. The current record is the most-recently selected record of the type appro-
priate to this link field.

Link to new #ype record (Edit mode, empty link field) : create a new record and
link to it; #ype is the record-type. You will be asked to confirm the creation of the
new record.

Edit linked #ype record (Edit mode, non-empty link field) : open an Edit display
on the record identified in this field.

Text Display

For fields of type text with more than twenty characters and for longtext fields,
this display provides the ability to enter or change the text. This is the only way
that longtext fields can be edited; for text fields it removes the constraint of a sin-
gle line of limited length. You can choose the font used in this display: see chap-
ter 8, section G, sub-section Fonts.

Text will be shown word-wrapped in =ioix|
the window. Press Enter to start a new [as—| " mpdmpionimiemini
paragraph. It is recommended (but not | ;fem=—d """

essential) to leave one space after a Zleeemain 2 1

comma, semicolon; and two spaces o

after a colon: or a full stop/ period. A w | |
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space ensures that word wrap will occur after a word or comma.

To close the Text display, press F9 or click on the - at the left of the Edit display
behind it.

Validation

When you save your changes, some validation checks may be performed. If there
is a picture script named validate for the record-type being edited, this script will
be applied to the record. Any output from the script will be shown as a message
and you will be invited to choose between saving your changes anyway or cancel-
ling (to correct an apparent error). The Elton55 database design provides valida-
tion scripts that check for apparent inconsistencies between dates in the records.

B Editing Specific Field Types
There are special techniques or formats involved for certain types of fields, as
will now be described.

Choice Fields

Pressing the Enter key (or Ctrl+P) brings up a pick-list of the possible values.
Click on the desired entry, or move to it and press Enter, to select that entry.
Click outside the pick-list, or press Esc, to close the pick-list without changing
the entry.

Text

A single field of less than twenty characters can only be edited in the single line
of the Edit display. The text will scroll as you type. Once the text in a single field
is longer than twenty characters, you can use the Text display to view or change
the text. To obtain the Text display, click on the + to the left of it, or press Enter.

A field of type text is limited to 255 characters (about four lines); you will be
warned when you reach this limit.

Long Text

Can only be edited in a Text display, produced by clicking on the + to the left of
it, or pressing Enter. The standard Windows editing techniques can be used. Up
to 4096 characters are allowed in longtext fields.

Dates
Dates may be entered with:

a prefix such as bef. b. aft. a. abt. cir. c.
a day number 1-9, 01-31, or without a day.
possibly followed by space.

a month name such as Jan-Dec, JAN-DEC.
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possibly followed by space.

a year such as 1842 or two digits representing 1900-1999 (unless you have
changed the base century in Options > Dates).

possibly followed by a stroke (/) with a dual year which must be consecutive
from the full year (e.g. 1741/2, 1749/50, 1499/1500). In this case, the
month should be January, February or March to represent the pre-1752 calen-
dar which did not start a New Year until March 25th. Only the later year will
be shown in the yyyymmdd date format.

The year can be omitted if both day and month are entered, for an anniversary
date.

Quarter dates used in UK General Record Office entries can be entered as, for
example:

ql 1877, Q2 1877, bef. Q3 1877,q4 1877

Object File Field

The field file in the objects group is treated specially. Press Ctrl+P on this field,
or right-click and choose Pick filename Ctrl+P to browse for an image file of type
BMP or JPG or a sound file with a standard Windows Open File dialogue. After
choosing your file, double-click on it, or click the Open button. The chosen file
will then be displayed or played.

A confirmation dialogue will ask for Yes or No for storing this path and filename
into the field.

If you prefer to type the entry in this field yourself, then note that it must be an
absolute pathname, meaning that it must start with a backslash (\), optionally pre-
ceded by a drive specifier, for example, \pedigree\cottage.bmp or
c:\pedigree\henryviii.jpg.

Place Fields

Any field having the GEDCOM tag

PLAC, usually called place, will have =10l x|
an additional entry in the pop-up menu Fields al Erig
produced by a right-click: nickname Terthing. Susser
Pick from list Ctrl+P: brings up a dis- [~ -

play of place-names, which will con- " [ehristening

tain those defined earlier by yourself; dale 17

see chapter 8 section E Place Name place sii

Pick-list. A click on any place-name in e

the list will insert it into the field. See souice

the example opposite. + |death 14
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Link Fields
Link fields will have two additional entries in the pop-up menu produced by a
right-click:

Place link Id : copy a link to the relevant current record into this field. /d is the
link that will be copied. The current record is the most-recently-selected record of
the type appropriate to this link field; if none, this entry will not appear.

Link to new #ype record (empty field only): create a new record and link to it;
type is the record-type. You will be asked to confirm the creation of the new
record.

Non-empty link fields will have an entry Edit linked #ype record, which will
open an Edit display on the record identified in this field.

Typing a RIN into a link field is not recommended. It is much easier to use Place
link to insert a link to the current record of the appropriate type, having first found
the record in a list (or elsewhere) and selected it by a click to make it the current
record.

C Edit Panels

There are a lot of fields in some of the standard record-types, not all of which can
be seen in the Edit display without scrolling. For some data entry or editing oper-
ations it is convenient to show only some fields, perhaps in a different order from
that defined. Edit panels allow this to be done: you can choose which fields to
display and in what order. Up to six Edit panels can be defined for each record-
type in a database.

To select an existing Edit panel, right-click in the Field column of the Edit dis-
play and choose Edit Panel from the context menu. This will produce a sub-menu
that will have the names of any Edit panels defined, plus <all fields> (the default
Edit display) and Modify Panel. Choosing a defined Edit panel will apply that

-ipix
Fields Data for Source 3
type census|
date 03Ap1871
refnum RG10.9999.p99
place 675 High Street. Worthing
censuses 1 Cl1=census 03Apr1871 Alan ROE head age 35 Draper
CEensuses 2 C2=census 03Apr1871 Frances ROE dau age 4
censuses 3 C3=census 03Apr1871 Charles Henry ROE son age 2
censuses 4 C4d=censzus 03Apr1871 George ROE brother age 32 Grocer
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selection to the Edit displays; its title bar will show the name of the selected panel
in brackets, thus: [census], as in the illustration on the previous page.

To change an existing Edit panel or define a new one, choose Modify Panel from
the context sub-menu. This will put up a Change Edit Panels for record-type dia-

logue.

Change Edit Panels Dialogue

This dialogue allows you to modify existing Edit panels or add new ones.

Select a panel to be modified in the list

under Edit Panels. The first choice,
<all fields>, cannot be modified.

Edit Panels

Record Fields

Panel Fialds

MHame o Souwce For census

<all Heldsx
The right-hand list, Panel Fields, shows - Sy e
the fields selected by the chosen Edit county = pia
Panel. (This list is not shown for <all o [ censuses
fields>). The middle list, Record Fields, st 4|
displays those fields in the current e puvther
record-type that are not in the Panel changed
Fields list. ==

114 I Cancel

To add a field to the panel, select it in
the middle list, then click on the P but-
ton. Similarly, to remove a field from the panel, select it in the right-hand list and
click the <« button. You must have at least one field in an Edit panel.

To change the order of the fields in the panel, drag them into the required position
in the right-hand list, using the knobs in left margin.

When satisfied, click the OK button to return to the Edit display with the modi-
fied panel selected. To abandon your changes, click the Cancel button.

To rename a panel, click the Rename Panel button. You can then edit the name of
the selected panel. Panel names must be between one and eleven characters.

You can only modify one panel before clicking OK. Selecting another panel first
will lose the changes you have made; you will be warned first.

Some fields in the Person and Marriage record-types are not normally included in
an Edit panel, as they should only be changed in the Family display. However,
you may be advised to include them in order to repair a damaged database. These
fields are:-

parents; marriages.
husband; wife; children.

Person record-type:
Marriage record-type:
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To add a new Edit panel, click the Add Panel button. You can then insert its name
in the blank at the bottom of the Edit Panels list, before adding and arranging the
fields as described above. Finally, click OK to record the new panel. You can
have up to six Edit panels for each record-type in a database.

D Using the Keyboard

All editing functions can be carried out using the keyboard alone, except selecting
and modifying Edit panels. Some of the keyboard alternatives to mouse functions
have been mentioned in the preceding text, but here is a complete list.

Use the up/down arrow or Tab keys to move between fields.

On a field marked +, Enter or F4 expands the Group or opens the Text display.
On a field marked -, Enter or F4 collapses the Group.

Oln a text field of more than twenty characters, Enter or F4 opens the Text dis-
play.

In the Edit display, Ctrl+S or F9 save changes and close the display; Esc to aban-
don changes.

In the Text display, F4, F9 or Esc return to the Edit display.

In a pick-list, use up/down arrows to select, Enter to choose; Esc to leave the
pick-list without making a choice.

In Edit display or Text display, F3 or Ctrl+R copy the data from the same field in
the last-edited record of this type.

The standard Windows keys Ctrl+C (copy), Ctrl+X (cut) and Ctrl+V (paste) oper-
ate in either Edit display or Text display.

The following operate only when appropriate:

Ctrl+A: append another field after the current one.
Ctrl+D: delete a field.

Ctrl+E: edit a linked record or link to a new record.
Ctrl+I: insert another field before the current one.
Ctrl+L: place a link.

Ctrl+P: bring up a pick-list or File Open dialogue.

E Record Grid

A horizontal display of the fields in one or more records that allows the content of
these records to be edited. A Record grid can be obtained from the Family display

m joccupation -

farmer;Worthing

Foe :Slindon, Suss 170ct1835:Slindon, Su 14May1910;Brigh

i
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Each field in the Record grid operates in much the same way as in the Edit dis-
play, described above. A similar pop-up menu is available on each field.

The Record grid has a column for the RIN followed by the fields or groups in the
record. The width of each column is roughly the size of the biggest field in any
cell of the grid. You can widen any column by dragging the column up to the
next one, by getting hold of it in the top dark grey heading row. Drag the win-
dow using its title. Scroll the fields sideways and stretch the window edge to get
the shape that you like.

Double-click on a group field (such as birth) or a multiple-occurrence field to
obtain a Detail grid.

If you are in Edit mode, then the fixed row and column will be in your choice of
colour, not grey or button colour. You can edit the record directly in the grid, but
you will probably find it easier to use the vertical Edit display. Right click on the
row and choose Edit to obtain this alternative.

Detail Grid
A horizontal display of one or more ovent detail for Alan ROE “PO01 N
group fields or link fields that allows :":‘ date _;'I“: - notes |
irtl {Slindon, Sussex
the contents of these fields to be christening |170ct1835  Slindon, Sussex
edited. death 14May1910 Brighton
burial
Multiple occurrences will be shown in  [will

the first column with a description
(e.g. occupation 1). When recording
alternative values for the same attribute, the preferred or most likely value should
occur first. This does not apply to different dated events like several occupations,
but would be used if there were two sources for births with the same or different
dates.

For multiple link fields, you can re-
arrange the order of the links in the
record by dragging the entries in the
Detail grid into the wanted order and
confirming the new arrangement.

Censiss links for_“SU06 1871 cems s 1ol R 10,9599 p39 675 High Stieel, Woithing
[census  [census links omSowrce |
censuses] of 4 |C1= “C001 census 1871 alan ROE “PO01 head age 35 draper
censuses? of 4 |C2= “CO02 census 1871 Frances ROE “PO0S dir age 4
censusesd of 4 |C1= “CO03 census 1671 Chardes Henry ROE “PO04 son age 2
censusesd of 4 |C4+ “CO04 census 1671 Malcolm ROE “PO07 brather age 37

F Replace Text

This extension of the Find Text function (see chapter 8 section E) allows you to
replace the text found by a second string provided by you. As for Find Text, you
can either search the records in an existing list (index, filtered list, ancestor plan
or descendants plan), or you can search all records of all types.

Caution: this function changes your records in a way that cannot be undone.
Make certain that you have an up-to-date back-up of your database
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before using the Replace Text function. Otherwise, if it has unex-
pected results, it may be difficult to repair the damage done to your
database.

1. It is sensible first to do a Find operation on the same basis before the Replace
operation, to verify that you will be making the expected changes. You can keep
the resulting Find list display for comparison with the result of the Replace opera-
tion. (See Find Text in chapter 8§ section E)

2. You must be in Edit mode to use this function.

3. To replace text in the records in an |
existing list, choose List > Choose... or ~ J82 10228181

. .
click the Choose List button on the 0g =
speed bar to bring up the List dialogue.

Findwhat:  [land T Eind Next
Replace with: |gr0md Replace

|
Right-click on the required list and | e |
choose Replace text... A Replace dia- _Replced |
logue will appear. Go to step 5. - T Mathcase _ Corcel |

1

D Help

4. To replace text in all records of all
types, choose Edit > Replace text... from
the main menu. A Replace dialogue will appear.

5. Enter the text to be replaced in the Find what: box. You may enter up to 60
characters. The case of the text is ignored (that is, draper will match draper,
Draper or DRAPER) unless you tick the Match case box. To include a newline
character in the text to be found, use the | character.

6. Enter the replacement text in the Replace with: box. You may enter up to 60
characters. The replacement text may be empty or contain only one or more
spaces and will be used to replace that matched; using an empty replacement text
effectively deletes the matched text.

7. Click Replace All (the Find Next and pirmpmpmiry

Replace buttons may not be used). If
you have used the | character, you will [{§55 cumame in Frederick GROUNDGRAVE of Hesse Cassel “P140
be asked to conﬁrm that you mean thlS :ﬂﬂ%i;;:mar::ln“\'gl:]l;m GROUNDGRAVE of Hesse-Cassel “P141
as a newline character, not | literally.

YOu Wlll be asked to COnfiml that ou ames IV STEWART of Scotground “P108 [also at A4:6) =
y m. to Margaret “P109 and had one child:
have a back-up copy, then all text 1. James V STEWART of Seotground “P107 (-1542) m..

. d.1513 in Flodden
fields will be searched and any changed:16Aug2004 18:03

matched text will be replaced. A new
Replace list display (as here) will
appear with the results of the replace- 4
ment.
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Note: this example shows a potential disaster: the replace has operated on
part of a word, which might not be what was intended. However, the
replacement text has at least matched the case of the original.

8. You can click on entries in this list display to see the record in the Detail Box
below. There may be several entries for a single record if the text was found in
several different fields in that record.

9. Right-click on a list entry to see what additional functions are available. One
possibility will be Save list text, GED..., which will allow you to save the list as
text, in case you want to incorporate it into a document or use it in another way.

Note: if any fields that are part of the key(s) of an existing index are altered,
the index is not re-sorted to reflect the change. If you see that this is
possible, delete the affected index and recreate it.

10. The Replace list is not stored by PediTree, so will be lost if you close it or
leave the program.
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Chapter 8 Main Menu Choices and Functions

PediTree has the conventional main menu bar at the top of its main window. This
chapter describes these menu entries and choices and gives information about the
functions provided.

A File Menu Choices
Open : open a database. If you already have an

File Edt Lst Prnt Options
Open...

opened database, the existing database will be Close DB

closed, and an open database dialogue shown for Save lists + defns.

choosing another one. See section B Open a Data- Quit DB

base below. Toolbar button =] has the same effect. Save As GEDCOM. . 3
Export Web Pages

Close DB : close the currently open database, per- Import »

haps to allow Pedigree for DOS to be used, and check DB

return to PediTree after closing the database in Ped- BTEER FEE AL

igree. See also GEDCOM Back-up in section B ﬁ;ﬁga’ces

below. Print window 3

Save lists + defns : save list and script changes, Dos

commit any outstanding database record changes, Exit

but flo not close the. database. This save function is 1 Cpedigree\FAMEX PED

carried out automatically every five minutes when 4 CA\pedigres\large pda

you are not making changes to lists or scripts, but
this choice lets you save important changes immedi-
ately if you wish.

Quit DB : close this database without saving lists and script changes; only data
changes are saved. Use this rarely, if you want to abandon any changes to scripts
or lists you have made. Lists could become wrong, but can be fixed by the next
use of choose list.

Save As GEDCOM : save a GEDCOM file of the whole database. See
chapter 12 for details of this function. To export only part of the database, use
the List display pop-up menu or the Choose List dialogue pop-up menu item to
export GEDCOM from one list only.

Export Web Pages : create files for a web-site. See Web Output in section E
below for more information.

Import > GEDCOM : read a GEDCOM file and store the information. See chap-
ter 12 for more information.

Import > CSV : read a CSV file and store the information. See CSV Import in
section B below.

check DB : check the integrity of the database, correcting errors if you are in Edit
mode. See Check Database in section B below.
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check Files linked : examine each field of type text or longtext, including field
objectfile, for a file name like \path\filename.type and verify that this named file
is present. See Check Files Linked in section B below.

Check Dates : check vital dates in the database. See Check Dates in section B
below.

New DB. : make a new database from the one that is presently open, copying its
definitions. See New Database in section B below.

Print window : this has two sub-menu options; both use the printer dialogue to
allow you to change orientation as it will try to fit the screen or window to your
page:
1. Print the whole of the screen. This is what is copied to the clipboard if you
press the Print Screen key.
2. Print the active Window. This is what is copied to the clipboard if you
pressed the Print Screen key whilst holding Alt down.

If you want to copy and/or save the screen or the window, press Print Screen as
above and paste it into a picture image editor or other program.

DOS : temporarily leave PediTree to use the MS-DOS command prompt. Type
EXIT to return to PediTree.

Exit : identical to the effect of closing the application window with the X button
in the top right corner. See GEDCOM back-up in section B below. Toolbar but-

ton j‘u

At the bottom of the File menu, the last five different databases that you have
opened will be listed for you to choose to open again.

B File Menu Functions
Here is more detail of some of the functions reached from the File menu.

Open a Database
Use the Open File Toolbar button g, < [vaio] - 7 Help
or File > Open... or choose one of the
last databases listed at the bottom of :

the File menu. S oo

=10] x|

The first two options will bring up an

Open Database dialogue. It should list

the databases in the same folder as

your last database, but you may have

to double-click on the parent folder to redisplay all its databases. Double click on
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a .ped, .pdg .pdh .pdj or .pdm database, or on the drive to select another direc-
tory. Click on the disk letter for another disk drive.

The hour-glass cursor will show while a new database opened. All the picture
scripts are checked for correct syntax, and an error message may warn you to
look at Alt+H G for diagnostics or just Alt+O P for the picture scripts in error. If
there are no records or some other peculiarity on loading, see Options > Defini-
tions. The last list used will be shown first, but overdrawn with a Family display
for the family in use when this database was last closed.

New Database

Use this after opening a database to make a new empty database with the same
data definitions, picture scripts and reports.

In this dialogue, check that the folder
name is the one where you want the
new database. If not, then navigate the
folder structure to select the folder.
Do not choose another database folder,
or else the new database will be filed
inside it!

Type a unique name (of up to 8 char-
acters to keep compatibility with Pedi-
gree for DOS), or longer for PediTree
only. Choose the radio database type
button .ped 1Mb unless you need more
than 1Mb of data in any of your types
of record. Click OK to create the new
database. See chapter 13 section D for

information about maximum data sizes.

CSV Import

Enter new name
Chpedigree Roe

23 elton55.ped
3 royal3.ped
xq
j.) Keep index keys, but sowdawn impart
DBtype
= .ped IMb " OK
© .pdg IMb
" .pdh AMb
© .pdj 6Mb
" .pdm IMb X Cancel

CSV stands for Comma Separated Values. The term is used to describe a type of
text file that can be used to transfer information to and from so-called flat file
databases. In PediTree’s case this means a single record-type, such as Source. A
commonly-used form of flat-file database is a spreadsheet, which is often used for
transcriptions of family history information, such as church registers or monu-
mental inscriptions. PediTree can export a Table as a CSV file.

Here is an example of a CSV file:-

forenames,surname,Birth date,Birth place,Birth notes

Ann,Allen,c. 1725,

Lydia,Cambridge, 26 "JuT 1782, London, "year uncertain,

inferred from age in census"

73



Chapter 8 Main Menu Choices and Functions

This has a heading and two records of five fields. You will see from the heading
and first record that the fields are separated by commas, hence the name of this
type of file. The first record has two empty fields, but the comma-separators are
still there. The second record has the last field in quotes "...", because the text
contains a comma and also a new line. Some CSV files have all fields in quotes,
not just those containing commas. Not all files have a heading, as in our exam-
ple.

Importing a CSV file into PediTree is similar in some ways to GEDCOM import.
After choosing Import > CSV from the File menu, you can choose the file to import
from a standard Windows File Open
dialogue. Having done that, a CSV
Import display appears, as shown here.

Field Tilesin lst Live 7 loport 139 1ccouds toAlecordtpe [Foon 7]

The list shows the fields of the chosen T | TugntFiy [T
CSV file, with the target PediTree field i ::.

for each, that is, the field into which it bithdae _Yowdsa |
will be imported. Initially, all the tar- e e
get ﬁelds shqw as f(none)’, meaning aﬂmw:::um

the import will be ignored. To proceed, s -
you need to choose first the target —
record-type, then the target field for [
each incoming field that you wish to Saveckira
. Read complete in 0.00 seconds

1mport. Ta enabie Imper, set Tagalls] and E made

In this example, there are no headings in the CSV file, so the field-names are

taken from the first record, as is apparent. To correct this, click on the Field Titles
in 1st Line box to remove the check-mark. The fields will then be named ‘Field 1’
and so on and the number of records to be imported is increased by one, as in the

next illustration.
N recoeds o Alece ,m‘—L‘
Both record-type and target field are e bt

chosen from drop-down lists, by click-
ing on the down-arrow to the right of
their list boxes. After you have chosen
the record-type, the Target Field drop-

bt place
et e
chiistening dale

chiistening place.

down list is populated with the possible TR iere) =
fields. All fields for that record-type o e

are shown, including those within B
groups, but excluding link-fields such St
as source. You cannot import into Savectons |

Fiead complets in (.00 secands
Toerable Import, 26t Target(z) and Edit mode
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link-fields. The example here shows the Target Field list dropped down, also the
revised field names.

Click on each import field in turn to choose the appropriate target. To assist you,
you can display the information in the chosen import field by clicking the View
data button.

Once you have made your choices, you can save them by clicking on the Save
Actions button. A standard Windows File Open dialogue allows you to choose a
filename for this, which will have the extension .CSA. You can then reload these
choices at a future time (by clicking the Load Actions button), rather than having
to make your selections all over again. The information saved includes the set-
ting of the Field Titles in 1st Line box, the record-type and all target fields.

It only remains to click the Import button. This is disabled until you have chosen
at least one target field and are in Edit (update) mode. If the target record-type
already has records, then you will be asked to confirm that you have a back-up of
your database before proceeding. A program failure during import could corrupt
your database: you have been warned! PediTree saves your import settings in file
default.csa, then imports your chosen CSV file into your database. CSV Import
is very fast and a completion message will say if any errors have been detected.
Clicking a Finish button will close the CSV Import display and update PediTree’s
indexes.

If any errors were detected then the Diagnostic display will open to show them.
Here is an example entry, which identifies the affected record both in the data-
base and in the imported file:-

CSV Import Error in Person RIN 18, group birth, field date: invalid

month 05 MAG 1938
Data line 23: 05 MAG 1938

Using CSV Import

That concludes the description of the CSV import process, which is much less
complicated than that for GEDCOM files. So what can you use it for? Not for
transferring lineage-linked information, for which GEDCOM is the appropriate
choice. As indicated above, CSV import cannot handle links between records,
only unlinked records of a single record-type. It might be used to copy source
records from one PediTree database to another, using a suitable Table to export
the records in CSV form. More commonly, it may be used to import information
transcribed or downloaded from elsewhere. Examples of which this author is
aware are monumental inscriptions transcribed into a spreadsheet and BMD
records downloaded from the Web. For example, you can download records of
Births, Marriages or Deaths from the website FreeBMD
<http://freebmd.rootsweb.com/> in a form that can be copied and pasted into a
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spreadsheet. After a little manipulation, the records can be saved as a CSV file
and imported as source-records into PediTree.

Check Database

Use this function regularly, as it proves that you have no badly corrupt records. It
is strongly recommended that you also use Export GEDCOM regularly, as this
proves every field of every record.

Check database will check all records, and report any links missing between par-
ents’ Marriage records and children, or husbands and wives and their Marriages.
It will also report in Diagnostics two-way links that do not have a corresponding
link back to the record. These can be specified simply in a special picture called
‘links’; see chapter 4 section F for more details. In Edit mode, it will repair two-
way links. The errors are shown in the Help diagnostics log, which can be saved
and printed outside PediTree.

An exceptional report is:

PediTree v3.285 DB2002 04/08/04 15:26:55
C:\PEDIGREE\roe2.ped last saved by 2.6N at 325 updates
176 Person records in file size 19 kb

67 Marriage records in file size 8 kb

6 Source records in file size 8 kb

18 Census records in file size 8 kb

PediTree C:\PEDIGREE\roe2.ped+325 checked 04/08/04 15:27:11
but not in update mode

linkMissing(M1.children, add P3)

1 missing links in Marriage.children from Person.parents
chkDBmsg(M1.childrenl) Zero link
linkMissing(P1.parents, add M3)

2 missing links in Person.parents from Marriage.children
linkMissing(P1.censuses, add C1)

There is one corrupt children entry in Marriage record M1, which should point to
Person P3; one missing parents entry and one missing censuses entry in Person
record P1.

Running again in Edit mode corrects these errors:-

PediTree C:\PEDIGREE\roe2.ped+325 checked 04/08/04 15:27:51
linkMissing(M1.children, add P3) added

1 missing links in Marriage.children from Person.parents
chkDBmsg(M1.childrenl) Zero link deleted
linkMissing(P1.parents, add M3) added

2 missing links in Person.parents from Marriage.children
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linkMissing(P1.censuses, add C1) added

Check database also checks indexes for the correct order of the records they con-
tain. If any index is found to have records in the wrong order, then PediTree will
offer to correct this. It is recommended that you click Yes to allow this to be done.

In additional, check database verifies some aspects of the data files, including
their information about free space within the files available for re-use. This infor-
mation can be corrupted by any program or machine failure. Any problem is
reported with a recommendation to use the separate Database Utility program to
check and correct it.

Check Files Linked

This function examines each field of type text or longtext, including field
objectfile, for file names like \path\filename.type optionally preceded by a drive
identifier like c: . For each such file name found, PediTree checks that the file is
present on the machine. Any not found will be displayed in a new List display in
the same form as for the Find text function.

Date Check Facility

This facility extends the checking of vital dates in PediTree records. Some
checks are performed using the validate picture scripts, but these are limited in
extent. The new facility duplicates and extends the checking, as will be explained.

What are the vital dates in this context? They are those associated with birth,
christening, marriage, divorce, death and burial. These are vital in two senses:
they are concerned with life and death; they are very important in family history
research. There are other dates in the usual family history records: information
about occupation, residence and wills often have associated dates, but we haven’t
attempted to include such dates in this checking process.

As mentioned earlier, some checks are made using the validate picture scripts in
database design Elton55 v611. If your database has these validate scripts, then
these checks are also done when editing records, thus providing immediate warn-
ing of some possible errors. Otherwise, they only show up in the Detail Box
when affected records are displayed.

In the Check Date process, many of the checks duplicate those implemented in
the validate picture scripts, but go further in testing against minimum and maxi-
mum ages. As the new tests do not depend upon the validate scripts, they work
with any database.

The intention of the checking process is to alert the user to possible inconsisten-
cies, oddities or errors in the dates present. It is all too easy to mistype a year or
misread an old document, so any check that might reveal this is potentially useful.
In initial tests, the year 1899 was found entered as 1989, making the person con-
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cerned exceptionally old at death! Children or marriages in the wrong order also
show up; it may be that their dates came to hand only after their names were
entered, when the fact that the order was then shown to be wrong went unnoticed.

Like Check database, Check Dates is

on the File menu. Choosing this brings Mo e o) oo
up a dialogue where some parameters
of the checking process are displayed
for review (and change, if desired);

see the illustration opposite. The set-
tings in this dialogue are remembered O Rora oo
by PediTree for all databases.

Farent's minimum age at birth (years) |-|3
Mother's maximum age at birth (years) Isu

Minimum age at mariage (years) |15

Birth/Christening missing
Once the settings are satisfactory, a Death/Burialmissing I

click on Run starts the checking proc-
ess. As it runs, the current record

Close | Help

number is shown at the bottom of the
PediTree window. On conclusion, a List display shows the results.

The variable parameters set some limits for dates. Maximum age sets a limit on
the age of a person, so that suspicious birth/christening or death/burial dates may
be detected. Parent’s minimum age at birth and Mother’s maximum age at
birth control checks on the given parents’ ages when a child is born. Similarly
Minimum age at marriage sets a limit on this for both spouses. If a person’s
record has no birth or christening date, then the relevant checks cannot be per-
formed, of course; you can chose to have this situation reported. Similarly, no
death or burial date prevents any check of maximum age. Again, you can choose
to have this situation reported, with no report being made if the person might still
be alive (birth/christening known and age at the date of checking less than the
maximum set).

In order to illustrate the way to use date checking, here is a tutorial based on a
demonstration given by Murray Kennedy during the PUG meeting at Oxford in
November 2009. You should all have the Royal03 database and may or may not
have worked through the tutorial in the Getting Started Guide. If you haven’t
done that, you need first to do just one section (Chapter 3 section J 3) before try-
ing the steps in this article. To save you hunting out the Guide, here it is:-

Inserting a marriage: in exactly the same way as you can insert children, you can
insert marriages. You can try this on the best example of multiple marriages —
King Henry VIII. Right-click on the father position in the family display, choose
RIN Select..., type in 112 and press Enter. As before, you will see only five mar-
riages; select the 4th (to Catherine Howard) by clicking on that tab. That’s wrong
— his 4th wife was Anne of Cleves. Right-click on Henry, choose Insert mar-
riage. He now has six marriages. Right-click on the blank spouse, choose Edit
new person and insert details of Anne of Cleves (1515-1557); the ‘of Cleves’
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goes in the postfix field. Edit the marriage to add the date (1540). If you now
click on Henry’s 5th marriage, you will see that this is now, correctly, to Catherine
Howard.

Having done that, now run the date check on the database:-

Choose File > check Dates to get the Date Check dialogue. This shows the
default settings as above. Change any that differ, please, then click on Run. This
will produce a List display of the results, as shown here.

-[ol x|
Results of Date Check
P109: Father's age at birth suspicious

P112: Father's age at birth suspicious

P112: Marriage 5 looks bigamous

P118: Father's age at birth suspicious

P142: Mother's age at birth suspicious

P146: Mother's age at birth suspicious

M40: Child 3 out of order

[ results from Date Check]

Now we need to investigate the reason for each line of the list and make an
appropriate correction. Note that when a date is changed the Date Check results
are not automatically updated. You need to re-run the check to see the effect of
your endeavours.

We now need to investigate each of these reports, starting at the top. To under-
stand the reason for the suspicion about the Father’s age, we need to see the
Family display concerned. It will be easier to interpret if RINs are displayed, so
visit Options and ensure there is a tick against RINs shown. First, click on the
top line (P109:....) of the Date Check Results to make that the current Person.

There are two ways to bring up a Family display for the current Person. Either

you can click on the tool-bar button 3= , or you can press key F8. However,

these two provide slightly different results. Clicking on the tool-bar button will
bring up a new Family display showing the current person, keeping any existing
Family display, whilst pressing key F8 replaces the current Family display with
the new one. Unless you want to compare two Family displays, pressing F8 is
more convenient, as it causes less clutter of open displays.

So press key F8 to bring up a Family display for Person P109: it’s Margaret,
daughter of Henry VII. Double-click on Henry VII to bring him to the central
position, so you can see his dates and those of his four children, as here. Accord-
ing to this, he was only four when Margaret was born; Arthur P118 and
Henry VIII P112 also appear in the list above. Research shows that Henry VII’s
birth date is wrong: it should be 1457, not 1485.

79



Chapter 8 Main Menu Choices and Functions

2, Family of ~HB40 Henry VII ~P110 & Eizabeth ~P111

So right-click on Henry VII P110,
choose Edit P110 and correct the
birth-date. Note that the Date Check
Results list hasn’t changed; you will
need to re-generate it for this to hap-
pen.

stenry VL1 P10

Ehizabath of York “F111

Before doing that, fix the other suspi- i

cious birth ages: in the results list click ‘z"“h:"il’i:?.'?'??E":‘:’.‘E‘%‘h};“?ﬂ;‘:ﬁ""‘".‘13 S
R . Henry 2 -1547] fage m. 1509 to Catherine
On 1?142: MOFher S age"" the];l pre.ss F8 1:;‘::.’1]?] m.1533 to Anne BOLEYN “P114
again. This time the mother is Wil- IS o P g 25
helmina of Baden P145: her birth is o Corarne
shown as 1756, when it should be
1788, affecting her two children in the
Date Check Results list. As before, bring up the Edit display for her and correct

the birth date.

d. 1509 [aged 24

Now it is worth re-running the Date Check, when only the bigamous marriage
and the child out of order remain. Let’s look at the latter first, so click on it and
again press F8. In the resulting Family display, child 3 (Margaret) is marked with
a question-mark, which is PediTree’s way of indicating that she is in the wrong
position. Looking at the birth-dates of the children, you can see that she should
come before Henry VIII. Fixing this is easy: press and hold the left mouse-button
on the 3? and drag it up so that the dark line that appears is above the 2, then
release the mouse-button. Click on Yes to save this reposition and the job is
done: the question-mark has gone.

Lastly, the bigamous marriage needs investigation. Again, clicking on the report-
line and then pressing F8 takes us to the Family display for Henry VIII with his
six marriages. Clicking in turn on tabs 4 and 5 shows that both marriages are
dated 1540 and that to Anne of Cleves has no divorce date, nor has she died. So
PediTree understands that both marriages are concurrent, hence the message. To
fix this, we need to sharpen up the dates and add that of Anne’s divorce.

Click tab 4 (for Anne of Cleves), then right-click on the marriage and choose
Edit M61. Change the marriage-date to 6 Jan 1539/40 and add the divorce-date
of Jul 1540.

Why 1539/40 — are we not sure? No, this is an old-style date, as at this time in
England, the new year started on March 25. So Anne would have known this as
January 1539. To make this clear for dates in January-March before 1752 in Eng-
land, the convention is to show them in the dual-year form. PediTree understands
this and works on the later year to correspond to modern usage.
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If we were now to re-run the date check, the report would still appear, as Cather-
ine’s marriage is dated 1540. In fact, you also get a message about marriage 5
being out of order. This is because the date 1540 is before 6 Jan 1539/40 in
PediTree’s view. A bare year corre-
sponds to the day before 1 January; 4 Farmily of ~H1061 Hery VIIL "P112 & Anne ~P151
month and year with no day corre-
sponds to the day before the first of the lﬁ i
given month. We need to sharpen up N O —
the date of Catherine’s marriage: click
on tab 5, right-click on the marriage, e
choose Edit M44 and change the mar-
riage date to 28 July 1540. Here is part
of the Family display after these B
changes have been made. If you now  son ot 140 Heary vit “P110 & Elizabetn P11

1491
run check dates once more, you should g Tl b TS

i i div.1533 and had one child:
get [NO querles n Date CheCk] N 1. Mary | “P119 [1516-1558) m. to Philip Il of Spain “P120
{aged 42} m.|2] 1533 to Anne BOLEYN “P114 and had one child:

That completes the tutorial presenta- s 5 153t o Johe SEYMOUR-PT15 and had one ehild
tion of dealing with Date Check mes- i i mif) setameasrarto aane “P151 aged 25)

sages in the Royal03 database. dl::;::i Eﬁn'f."s_f'éi{ffuﬁ"m i0 Catherine HOWARD “P116 no children
There’s Just one other date-related d‘rg:‘f’l ?:g};:.[sbsj}l 543 to Catherine PARR “P117 no children.

. . . ObjectsipedigreeiHennyVilljpg
issue that arises in the use of the Date  changed:1oNov2009 18:26

Check: you need to be careful about

the sequence of dates for a person when you are uncertain of them. For example,
if you have a birth date of 3 Jun 1836 for an individual (not you!) and a death
date of 1836, then this will produce a query in date check. The answer in this
case is to enter the death as aft. 3 Jun 1836. In the case of Anne of Cleves, we
could have entered her divorce date as bef. 28 Jul 1540 and got the correct result.
The same technique works for quarter dates taken from GRO information: born
Q3 1882, christened aft. Q3 1882 is OK.

GEDCOM Back-up

There is an option automatically to export a GEDCOM file when closing a data-
base, if any records have been changed whilst it is open. This is intended as a
safety feature, to provide a semi-automatic back-up of your data. An additional
benefit is that during a GEDCOM export, PediTree reads every record in your
database, which will verify that there is no corruption of the records.

This option can be set from the main menu Options > Settings; by default it is off
(no export), but the setting is remembered by PediTree between sessions. If it is
on and records have been altered, then the export will occur whenever the data-
base is closed, namely a) on using File > Close; b) on opening another database
(which implies closing the present one); ¢) on leaving the program.
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You will be presented with a Save File dialogue, to permit you to choose folder
and filename. See chapter 12 section D GEDCOM Export for the subsequent
steps.

C Edit Menu Choices

The Edit menu choices are detailed below.
Some appear only when PediTree is in Edit List Prirt Dptiors ‘Wwindow Help

mode. v Update[Edit) mode

. . FEarmily
Update (Edit) mode : switches between E it record m
View mode and Edit mode (when you are EW R T
allowed to update the database). When Edit Femkos e
mode is selected, there is a tick against this I
menu entry and the colour of the fixed row F,. 1

and column on an Edit or Grid display will |

change to make it obvious which mode that

you are using. The toolbar button provides

the same function: 3| in View mode; in Edit mode.

PediTree opens each database in View mode — meaning that data records cannot
be changed, although lists and picture scripts can be. Use Options > Settings to
reach the Options dialogue to change the session default to always Edit mode.

You must have a valid PediTree registration file to edit a database of more than
150 records. See chapter 13 section C for details.

Family : select a new family for the display, based on the currently-selected per-
son and their own marriage or their parents’ marriage. The Toolbar button is 3=

Edit record : any record can be cho-

sen by clicking on this menu item, then
the record-type in the sub-menu. A Susan SHARP “P002 [c. |/ Record Index Number

Select RIN dialogue window shows the | "t et 4f8) 2| =
current RIN for this record-type, but . Insert 2 tev

this can be changed by entering a
number or by spinning the current RIN
digits. Details of the selected record

will be shown. Note that the spin box
increase and decrease arrow boxes maybe wrongly blank, but will still work.

In Edit mode, an Insert button will be present, allowing you create a new record
before editing it. Marriage records cannot be inserted, as they must be created
from the Family display. Person records too should be created in the Family dis-
play unless you don’t want to enter any relationships at present. Records can also
be inserted from a List display, by using the List pop-up menu.
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New Family (Edit mode only) : open a Family display with no members, permit-
ting you to start entering the members of a new family, unrelated to those already
entered.

Replace Text : search the whole database for given text and replace it. See chap-
ter 7 section C.

D List Menu Choices Lst Print Options Window
The List menu choices are as follows:- Choose...
. . Ancest lan...
Choose... : brings up a Choose List dialogue to D cESieE pEn
. .. R X X escendants plan...
permit you to select an existing list to display in a Relationshi
. . . . . ationship...

new List display. See Choose List Dialogue in ind =

tion E below Jom e
sec ' Erase lists. ..
Ancestors plan... Places List
Descendants plan.... : these two options bring up dates List
a dialogue that allows you to create a new Ances- Find texdt...
tors or Descendants Plan. This plan will be dis- find cument record in index
played in a List display, enabling you to produce Islands + Web

drop-line Trees. See section E Create Descend-
ants or Ancestors Plan below

Relationship... : calculate and display the relationship between two individuals.
See section E Calculate Relationship below.

Index create.. : bring up a List dialogue that enables you to create a new index.
See section E Index Create below.

Erase lists... : brings up a Choose List dialogue, in which any one of the lists can
be selected for erasure, by clicking anywhere on the line. Click OK in the ensuing
message-box to erase it, click Cancel to keep it. Click X (close window) to finish
erasing. The remaining lists are not moved up, in order to retain the same List
numbering during this PediTree session.

You can also erase lists from the context menu of the Choose List dialogue.

Note that if your first few indexes get out of date, you can erase and then recreate
them one at a time. PediTree will choose the first empty position when you make
a new list, thus creating the new index in place of the old one.

Places List : creates a new List display for the place names in all records. This
list is kept only for the current session of PediTree, but can be saved from the List
display context menu, either as text or as a Places pick-list (see section E Place-
name Pick-list below).

dates List : creates a new List display for all dates in all records. This list is kept
only for the current session of PediTree, but can be saved in text form from the
List display context menu.
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Find text... : search the whole database for given text and display a list of the
entries found. See section E Find Text below for more details.

find current record in index : locates an index entry for the most-recently
selected current record and highlights it in a List display. If no appropriate index
is available, PediTree will prompt you to create one. The Toolbar button E!
performs the same function.

Islands+Web : provides functions related to Relationship Islands, including the
generation of files for web-sites. See Relationship Islands and Web Output in
section E following.

E List Menu Functions

Choose List Dialogue

Shows a list of the currently-available
lists, so that you can select one for dis-
play or other operations.

To choose a list, click on the line con-
taining the type of record and the order
that you want. A new List display will
be created and the list will be filled.
See chapter 6 for information on the
List display. If necessary, widen the
columns by dragging the column divi-
sion line at the top ]l 2

The list has these headings, but scroll left if you cannot see them:

List number of this list

Type record type

Method of making this list, such as:-
Anctree an Ancestors Plan
DescTree a Descendants Plan
Fill in order by RIN
Index sorted as specified

Size number of items in this list

Key(s) and filter(s) Keys that this list has been indexed or sorted on, and fil-
ter scripts that were used to select these records from all
the records of that type.

A right-click on a line in this dialogue will bring up a context menu, as shown in
the illustration. (Two are shown, one for View mode, one for Edit mode, but only
one is available at a time). This has the following choices:

Help on 1d : provides on-line help for the selected list.
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Print this summary : print this list summary, using the current printer set-up.

Erase list n : erase the selected list. After confirmation, this line shows ‘erased’
for the remainder of this PediTree session.

GEDCOM list export : export this list as a GEDCOM file. See chapter 12 sec-
tion D for more information.

List Places : creates a new List display for the place names in the records in this
list only. The resulting places list is kept only for the current session of PediTree,
but can be saved from the List display context menu, either as text or as a Places

pick-list (see section E Place-name Pick-list below).

List Dates : creates a new List display for all dates in the records in this list only.
The resulting dates list is kept only for the current session of PediTree, but can be
saved in text form from the List display context menu.

Find Text... : search records in this list for given text and display a list of the
entries found. See section E Find Text below for more details.

Replace Text... (Edit mode) : search the records in this list for given text and
replace it. See chapter 7 section C for details.

To remove the Choose List dialogue, click the close-button X in the top-right
corner.

Index Create
An index is a list of all of the records =

. . . s 1o index on zon [Fattype  [6ED ]
of one type that is kept in a particular l"‘uf_: . N vl B I;".':;.‘ W e
order. It is the only type of list that is e B
updated when records are changed or “; = pute iy
added to the database. %ﬂ :...;"" = E‘
A List dialogue is displayed, showing Em % :_‘:'
the record-types available. Choose a o i
record-type as a basis of the new b oo
index; the dialogue will change to Bro  Gen o
. adophedily Hasiiage adop
show a summary of the new index e B =
(called temporarily ‘ViewIndex’), the o tomn oo
sort keys and the fields of the chosen ™ -

record-type.
If you click OK now, a list of type fill will be created, rather than an index.

To create an index, you must specify one or more sort keys that will determine
the order of the records in the new index.
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1. The field Key 1 is highlighted. Click on a field in the record to complete the
key details. If that field is a link to another record, its fields will be shown. If
that field is a Group Type, then the fields in that Group (event, occupation or resi-
dence) will be shown. Continue clicking until you have chosen an elementary
field, with a data type such as date, text, or RIN.

2. PediTree will put that key into the left-hand index keys cell and move down to
the next empty cell. The right hand data definitions grid will change back to the
record-type for the index. To add another key, repeat the above process.

3. If you want to go back and add another field to an existing key, then click on
that key. In this case, PediTree will sort on the combined key with a space
between the two if they are present. If the first field is not present, then the sec-
ond field will start that key position, just as if it is the first field. This is useful,
for example, to sort on

birth.date christening.date death.date
if you want people sorted into roughly their life years.

PediTree inserts a comma between keys in the generated list, in order to ensure
that an empty key field will sort before other records with that key present. (e.g.
Smith,,1887).

4. Click OK and PediTree will make a new indexed list, temporarily called a
Viewlndex. ViewlIndex is the temporary name for an index when it is being cre-
ated. It will appear as the caption of the new index window until it is selected
again.

5. Finally, PediTree creates a new List display, showing the list using the picture
script called List for that record-type.

The standard indexes for an Elton55 database use these keys:-

List Record-type Key 1 Key 2 Key 3

1 Person surname forenames birth.date
2 Marriage husband.surname wife.forenames

3 Source date type refnum

4  Census surname forenames source.date
5 Census source.RIN refnum

Earlier database designs may omit List 5; those without a Census record-type
have Lists 1-3 only.
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Automatic Index Repair

If you ever have to leave PediTree without a normal exit, then lists and indexes in
particular will not be updated. This can result in the index sizes becoming une-
qual to the number of records left in your database.

PediTree detects this when you next choose the List dialogue, and attempts to
repair the indexes, if the discrepancy is less than 100. (It does not repair plans nor
filled lists). It reports a message like:

Index 1 should be 1152 (it shows it as 1130, say)
Do you want this fixed now?
Normally answering Yes will fix the index.

Create Descendants or Ancestors Plan
These options will create a Plan list from the current Person (as selected by a
click in a List display or a Family display).

A Choose Number of Generations dia- i
logue will be displayed. Enter or spin _
the number of generations. Note that ~ Descend 0 e oy 3 v oK
the spin box increase and decrease - X Cancel
arrow boxes maybe wrongly blank, but 7 heb |
will still work. [ FamilyDescent

|A|| descendants ﬂ
The box titled FamilyDescent will :

show initially ‘All descendants’.

If you leave this option, then all descendants in a Descendants plan or all ances-
tors in an Ancestors plan will be expanded with all the children until your choice
of generations has been reached or, in the case of intermarriage, that family mar-
riage has already been included.

If you click the arrow to the right of *All descendents’, then you can choose to
restrict the expansion of the plan to those family marriages that are on an existing
plan. The identifying letter of the selected plan (in lower case) will be added to
the new plan letter so that you know that this plan was restricted in this way.

Note: if you subsequently open this database in Pedigree for DOS, this second
letter will be lost, so you should make a note of this plan.

There are two suggested types of restricted plan. Both types restrict the generated
plan to families surrounding the line of descent between two individuals:

Restricted Descendants plan: a Descendants plan, restricted by an Ancestor
plan. This includes the all the children of the families on the line of descent.
First generate the Ancestors plan, starting from the lowest individual to be
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included, with enough generations to include the ancestor of interest. Then
select that ancestor and generate a Descendants plan with the same number of
generations, selecting the Ancestors plan in the FamilyDescent box.

Restricted Ancestors plan: an Ancestors plan, restricted by a Descendants
plan. This includes the individuals on the line of descent and their spouses
only. First generate a Descendants plan from the oldest individual, with
enough generations to include the descendant of interest. Then select that
descendant and generate an Ancestors plan with the same number of genera-
tions, selecting the Descendants plan in the FamilyDescent box.

Once you have made your selection, click OK. A new list display will open, cap-
tioned ‘Wait a Moment’ and the plan will be calculated to show the generation
and strip positions on a Tall or Wide tree. You will be given a choice of the level
of tree detail later, when you choose to display and print the tree. See chapter 11
for displaying and printing Trees.
Note: in an Ancestors plan, if the number of generations selected is higher
than the number of generations actually discovered, then the earliest
ancestor generation will be have a number greater than 1, e.g. 2,3 or
whatever. This will waste space at the start of any tree drawn. Itis
best to look at the actual nhumber of generations shown in the Choose
List dialogue, erase that plan, and recreate it with that number of gen-
erations, so that the earliest ancestor is 1.

Note: plans are not updated when relationships change. You must erase a
plan and recreate it after any change to parents, children or spouses.

Calculate Relationship

This function calculates the relationship between two individuals. It finds the
common ancestor(s), then displays them and the number of generations to each
individual.

To use the function, first mark one PEO=Philip “POG0
individual, using the pop-up menu
either in the Family display or the List
display. Next, select the second indi-
vidual by a click, in either display. T
Finally, choose List > Relationship from i) Samengicsisr s dbe ol Conss otha “Food
the main menu. After confirming your T L
choice, the result(s) will be displayed
as shown here.

List Dates

This will either search the whole database (from the main menu List > Dates list)
or just an existing list (from Choose List dialogue pop-up menu) and create a new
List display of all the fields in groups that are of type date (such as birth.date),

o]
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except in the changed group. Fields of type date in a record (such as Source.date)
are also excluded.

The dates are listed in the ISO YYYYMMDD format for correct sorting, with
field names and record identification (using the first picture script for that record-
type) appended. Date prefixes of before, equal , circa and after are shown as
<=?>. See Date comparisons in chapter 4 section B. Here is a sample list that
has been sorted:-

18690000=; occupation from of John WAUGH "P1684
18690000=; occupation to of Margaret McKay MOWAT ~P1520
18690219=; birth date of Isabella BRUCE ~P0009

18690426=; birth date of David WISHART ~P1933

18690500<; death date of William SINCLAIR ~P1526

A right click pops up the usual context menu to Save to file, Sort, etc. This list is
temporary and will not appear in the Choose List dialogue, nor is it saved between
sessions.

A useful chronological event dates list for part of your family can be made as fol-
lows:

Choose a family plan of descendants or ancestors using the Choose List dialogue,
right-click on this list and choose List dates. Right click in the new List display
and choose Sort to get it into order by date. This now lists all the events for
descendant, spouse and Marriage records in the order in which they happened.

List Places

This will either search the whole database (from the main menu List > Places list)
or just an existing list (from Choose List dialogue pop-up menu) and create a new
List display of all the fields that are in a Group and have the GEDCOM PLAC
tag. This is what you might see:-

Bower, CAI; marriage place of “M049 Robert BRUCE "P0154 & Catherine CORMACK
Bower; birth place of Matthew BRUCE ~P1566

Bower; christening place of Ronald BRUCE “P0156

Brent; occupation place of William Edgar KENNEDY (Edgar) “P0224

At present it only shows place-fields that occur inside a group. It does not show
residence place names, because they do not have a PLAC tag, although you could
change that temporarily if you wished.

A right click pops up a menu which includes Save to file, Sort and Place picklist.
It is intended to help you standardise your place names, by sorting them to iden-
tify oddities. Each line shows the place, the field in which it was found with the
record identified using the first picture script for that record-type.
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After sorting, pressing a letter-key will jump to the first place-name with that ini-
tial letter.

A click on an entry makes that record current for clicking Family or the Find in
List icon. It also shows the full record in the Detail Box.

This list is temporary and will not appear in the Choose List dialogue, nor is it
saved between sessions. But it can be used to make a Place-name pick-list.

Place-name Pick-list

Right click in the Places list for a popup menu with the above item. This will sort
the places list (if not already sorted) and compare each entry (up to the tab divider
of the place-name from the rest such as ‘birth place of Matthew BRUCE
AP1566”) with the next item in the list. If there are at least two place entries with
the same spelling, then that place will be written to a file called PLAC.LST in a
location that you specify, such as C:\pedigree. This location is remembered
by PediTree for use when editing place fields, in all sessions and databases. See
chapter 7 section B Place Fields.

If you want to select a different place list for some databases, then make the extra
PLAC.LST files in different folders, and use the main menu Windows > PickList
select.

It will ask ‘Do you want to find new file for PLAC.LST ?°

Answer Yes to find an existing file that you have created elsewhere, or No to use
the latest one created in this session. It remains selected until you choose another
one.

Merging Place-name Lists
You can use PVsort to merge several lists from different databases and remove
duplicates. In this example, /D removes duplicates:

Pvsort fileA+fileB+fileC PLAC.LST /D

where fileA fileB fileC may be filenames in different folders.

To expand this example further:-

Make a place list from each of the databases, and give each a different name, like
placel.lst, place2.Ist

and note which folder that each is in, if it is not just c:\pedigree

If you already have a c:\pedigree\plac.lst which you want to include, then make
sure that it is listed as one of the files that you want to merge separated by +
signs,
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In this example, we will include a database in C:\ken as well as two in
C:\pedigree.

Plac.Ist files are not automatically kept up to date with your changes to place
names, so every so often you may want to recreate them from your main data-
bases. If you include the old c:\pedigree\plac.Ist in your merge list, then all the
old entries will be kept, even if some places may have disappeared or been
amended. Use PediTree to recreate plac.Ist from one database, before merging
several files, if you don’t want this to happen.

So the example command is (all one line):

Pvsort c:\ken\plac.TIst+c:\pedigree\place2.lIst+c:\pedigree\plac.lst
c:\pedigree\plac.1st /d
(It doesn’t matter if this extends over one line on the screen, as here on the page;
only press Enter at the end.)

This will merge and sort the first three files and remove duplicate lines, before
rewriting: file \pedigree\plac.lIst

If you want to experiment further with PVsort, just type
PVsort ?

which will give some help screens. The supplied file Pvsort.doc contains full doc-
umentation of this utility.

Find Text

This function allows you to search all fields for a given piece of text. This is in
contrast to the Filtered search facility in lists that operates on specified fields

only. You can either search the records in an existing list (index, filtered list,

Ancestors plan or Descendants plan), or you can search all records of all types.

1. To search the records in an existing list, choose List > Choose... from the main
menu or click the Choose List button on the speed bar to bring up the List dia-
logue. Right-click on the required list and choose Find text... A Find dialogue will
appear. Go to step 3.

2. To search all records of all types, Fnd 2]
choose Llsf‘ > qud text... frgm the main adwhat [ Bt Nt
menu. A Find dialogue will appear, as S
shown here.

I~ Match case ol
3. Enter the text to be found in the Find e |

what: box. You may enter up to 60

characters. The case of the text is ignored (that is, pedigree will match pedi-
gree, Pedigree or PeDiGrEE) unless you tick the Match case box. To include
a newline character in the text to be found, use the | character.
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4. Click Find Next to perform the =10

| TEXT1 list
Search. If yOu haVe used the | CharaC— Land s) in Frederick LAD of Hesse-Cassel “P140

of Scatland > postiix in James IV STEWART of Scatland “P108

ter, you will be asked to confirm that | By el
you mean this as a newline character, ||l TEXT tems from list 1}

not | literally. A new Find list display
will appear with the results of the

search. This list shows up to 30 char- James V STEWART of Scotland “P107 [also at A4:E] j

acters from each field in which the text ||son of *M033 James v STEWART of Scotland “P108 & Margarer
“P109
was found, a >’ symbol, the name of

the field and the identity of the record,

m.and had one child: =l

as in the illustration.

5. You can click on entries in this list display to see the record in the Detail Box
below. There may be several entries for a single record if the text was found in
several different fields in that record.

6. Right-click on a list entry to see what additional functions are available. One
possibility will be Save list text, GED..., which will allow you to save the list as
text, in case you want to incorporate it into a document or use it in another way.

7. A Find list is not stored by PediTree, so will be lost if you close it (by clicking
the window close button) or if you leave the program.

Relationship Islands

A Relationship Island (or island for short) is a group of individuals all related
together by marriage — otherwise called blood relations. If you are recording the
history of one particular family, then the intention will be to identify all the
ancestors, descendants and siblings and link them together. The result should be a
single island. In practice, there may be some likely relatives mentioned in wills
or marriage documents for whom you have no information about relationships to
the rest of the family. Pending a research breakthrough, they will remain unat-
tached in your records, so will be in separate island(s). Any adopted children are
not blood relations — not related by marriage to members of the family — so will
also be separate islands.

More formally, PediTree uses Person and Marriage records to build families; an
island is all those Person records linked together by Marriage records. In this
context, Marriage records don’t necessarily imply a legal marriage, merely the
linkage between one or two parents and their children.

Using Islands

How can the Islands facility help you? For a start, it will show you how many
islands exist in your database. If you a researching a single family then you
might hope to have only one island; the actual number might be a surprise. This
analysis might help to uncover some forgotten records that need further work.

92



Chapter 8 Main Menu Choices and Functions

On the other hand, a database of a one-name study is likely to have many islands,
as it is very unlikely that all the collected individuals can be linked into a single
family.

Let’s look at an example. In PediTree,
you can generate an Islands display S T Y M
. . =) F ] Salection,
from your database by choosing List > g: 52 “"i — e
. 3 5 1 & 501
Islands+Web from the main menu. o 4 = — |
Here is the result for a family data- e i . tew
base. The list top left shows the a: o o
islands found in descending order of  |g\ I A
[m ]} 1 (] (T} M
the number of Person records. The O o0 e
. . O 1 0 104 EEDCDM Evperl,
first entry is selected (ticked), so the O IR || (o
. econd List fos Selected |sdland]z) =
lower list shows all the Person and o Tore EREE v FEET TS j [ e padnead:
. . Pipnadiosd T IONES “PO22E (27 May 1947)
Marriage records for that island. (I Koo ST ORI = |
S e i SO
have scrambled the names to protect B renpsern x|

IO Qsino JONES “FO232 19 0an 1972]

the privacy of the owner of this data-  |bawesem s o e A M | ome
base.) This first island has the major-
ity (99%) of the Person and Marriage records in this database, which looks pretty
good. Islands 2-5 are small groups (at least one of these contains children
adopted by the main family), the rest (22 total) are single individuals. By con-
trast, the Islands display for a sample one-name study database had 10,394
islands with only 6% of the records in the first (largest) island.

You can select as many islands as you wish by clicking on the check-boxes: the
lower list shows all the records in the selected islands. You can move the divider
between island-list and record-list, by dragging the division with the mouse. The
display top right summarises the selection, showing the number of islands and the
total Person and Marriage records. Three buttons provide the means to set (All),
Invert or Clear all the check-marks; Invert means change checked to not-checked
and vice versa.

The Record List in the Islands display has few facilities: clicking on an entry
makes this the current (Person or Marriage) record, which means you can use the
buttons on the speed-bar to find it in an index or display the relevant Family dis-
play. For more facilities, click the Make List button to produce a separate List dis-
play with Detail box. This List display is temporary, but has the usual context
(right-click) pop-up menu allowing you to Mark a person; Save the list as text;
Edit the record; Print the Detail box; Draw a Report.

Clicking the Web Output button brings up the Web Output Dialogue for the
island(s) currently selected.. See the Web Output section below for further
details.
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Export GEDCOM

Continuing the possibilities for a selection of one or more islands, you can export
the selection as a GEDCOM file. The choices here are to export

Version 4 Pedigree, or Version 5.5 (if your database design is suitable). You can
also choose whether to include linked records or not. If you choose to include
linked records, then the output will include, for example, Source and Census
records that are linked to the Person and Marriage records in the selected islands.
In addition, you will get any adopted children (Person records) that are linked to
Marriage records in the selected islands.

Once you have selected your options, then click the OK button in the GEDCOM
Export box. You will then get the usual Windows File Save dialogue so that you
can choose a filename and folder for the export.

Splitting a Database

One possible use for GEDCOM export of a selection of islands would be to split
a database. For example, you might want to export a database of your spouses’s
family only. In order to do this, it would be necessary to make the spouses’s fam-
ily into a separate island, rather being included in the whole database. Here’s one
way to do this:-

1 Bring the family of the spouse to be exported to the centre of the family dis-
play

2 Right-click and Mark the spouse whose family is to be exported.

3 In Edit (Update) mode, right-click and Detach this spouse.

4 Choose List > Islands and note that an extra island is now present. Select this
alone and confirm that it contains the spouse in question.

5 With this selection, Export GEDCOM, including linked records. This is the
wanted family.

6 Right-click on the empty spouse position in the Family display and Place
the marked spouse, thus restoring the temporarily-broken family.

Alternatively, after step 5, you might decide to delete the exported island, which
is another possibility, to be described below.

For example, after steps 1-4 above on the database that produced the first exam-
ple display, the top section of the island-list looks like the example on the next
page. You will see that the main island of 2855 Person records has been split into
two of 1977 & 878. The second one is the spouse’s family to be exported. You
could, of course, make two exports, one of each islands 1 & 2, both with linked
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records. This would provide two new | lslandt | #NDI| #FamM|  1stINDI |
separate databases for future work, if 1 1977 E57 1
that is what was wanted. O: 87s vz 229
Another possible use of GEDCOM Ei g 12 222;
export of selected islands would be to Os 5 ] 1557
provide an enquirer with the relevant | 3 1 1910
section of a one-name study. To do 0o- 1 1 151
this, you might need to find the island |[[J s 1 1 1672
that includes a particular individual. Ms 1 1 2R37

The Find Person button brings up a box

for entry of the RIN of a person in the database. By default, it is filled with the
RIN of the current Person record, so you can use PediTree’s normal techniques to
locate the person of interest and click on them before using the Find Person but-
ton. Once the RIN is entered, then a double-click or a press of the Enter key will
locate the relevant island and highlight it in the Island display. You have then
only to make sure this island is the only one checked and the selection will
include the required Person record with all its relatives. If the highlighted island
is checked, then the Person record found will be highlighted in the Record List.

Deleting Islands

The final option, mentioned previously, is to delete the records in selected
island(s). This powerful option could potentially damage your database if used
by accident, so you are strongly advised to have a current back-up before using it!
You have been warned! If you are in Edit (Update) mode and have one or more
islands selected, then the Delete button will be enabled; clicking it will start the
deletion process. You get two further opportunities to confirm that you really
want to delete the selected records. Click Yes to both and all the Person and Mar-
riage records in the selected islands will be deleted, as will any links to them from
other records.

An interesting use of this mass-deletion facility came to light during evaluation of
the Islands facility. A user had mistakenly imported a GEDCOM file into the
wrong database, without making a back-up first. As the import had not been
linked into existing records, it appeared as a number of separate islands that could
be identified and deleted. This removed the offending extra Person and Marriage
records, making recovery from the mistake much easier.

Web Output

It may be that you want to publish the results of your research on the World-wide
Web for others to see. The starting-point for this is to produce interlinked pages
in the form of files written in the HTML language. These pages must then be
uploaded to a suitable Web-site that is accessible to others. Details of this latter
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stage are beyond the scope of this manual, but the former stage can be performed
by PediTree.

PediTree produces four types of page: Person pages, Ascendant (or pedigree)
charts, Descendant charts and an Index page. The Index and Person pages are
always produced; you choose what charts to provide.

The Person pages together provide a complete list of all the individuals included,
in order by surname, forenames, date of birth or christening and RIN. Each page
has fifty primary entries (except the last page). Each primary entry has the per-
son’s full name, followed by some personal details if the person is not ‘alive’. In
this context, ‘alive’ means born after 1910 and having no death or burial date.
The personal details are provided by a picture script (HTMdates) that you can
change if you wish. Following that are (if any are present): a) a list of named
charts in which this individual appears; b) names of father and mother; ¢) names
of spouse(s), and a list of their joint children. All these names are links that can
be clicked to take one to the chart concerned or the primary entry on a Person
page. Each spouse’s name is followed by marriage and/or divorce details from
new picture script (HTMmarr).

The Index page — the starting point — has a list of all the Charts and all the Person
pages. The latter are identified by the first and last name on the page in question.
Again, all these lists are clickable links that take you to the chosen page.

As mentioned, there are two types of Chart available: Ascendant and Descendant.
The Ascendant Chart looks like a conventional pedigree, having boxes for indi-
viduals connected by lines. The boxes are colour-coded and are links to the Per-
son-page entries. Hovering the cursor over a box will display the full name and
additional details (the first line from the entry under them on the Person Page, if
they are not ‘alive”). The Descendant Charts have similar elements, but have a
very different layout.

This facility requires three special picture scripts; two have been mentioned. They
are: Person HTMdates; Person HTMname; Marriage HTMmarr, which are only
needed if you want to use the Web Output facility, which will complain (and
refuse to work) if they are not present. It also uses the standard picture script
Person.name.

The process starts from the Islands display, reached from the main menu by File >
Export Web Pages or List > Islands+Web. Here you can choose what part(s) of your
database to include, before clicking on the Web Output button. This brings up the

Web Output dialogue.
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Web Output Dialogue

The Web Output Dialogue provides L
facilities to set the details of the output. ﬁm—J e
Entries here set the title for Web pages, psvmm Pt N o ot
N A sk TELV “P1374 | Eopr——
publisher's name for copyright and the ez — =
output folder for the Web output. e - [Foedgertie0
Nvos TEUWY “PZ200 Display Generated Pages 7
Hioa On TELN “P21% Chwtz
Title for Web Pages: this title appears at [ s hSeertaan o
the top of every web page. Simply type Rﬁﬂ"ﬁzxs e
in your choice of title. s Tokurr PO -
[Thvuo TGLARIPH “POBI2
[Tive K TGMIVAIRD “P1930
sk TENIC “POS33
Publisher's Name for ;opynghf: Ifyou | s || Lo | i
want to have a copyright notice at the  [=rmm e e | o | _ve |

Rsk TGOS “P2201

bottom of every web page, then type
an appropriate name here. If this entry is left blank, then no copyright notice will
be displayed.

You must choose an Output Folder to receive the new Web output. The output
comprises a number of files that you will not wish to confuse with existing ones.
Moreover, all existing files of types *.htm, *.html or *.css are removed before
new ones are created. So it is important to choose an existing Web output folder
or a new empty one. You cannot type a

name into this entry, but must click on
the Browse button. This will display a

. . . Choose the Output Folder
folder tree in which you can navigate
to your chosen destination. You can
choose an existing folder, then click £t Padigree Dta =

OK. If this folder containg any files 503 Bywater Lees
other than of those types listed above, . - Cedric Hoptroff
you will receive a warning message. If 5
the contents contains files of types o e,
¢ conte M yP . {3 Denys CortrolGed
* exe or *.dat, then this is regarded as . B dLewin
an error and after an appropriate mes- - Dhide2ped
sage you will be asked to choose again.

To create a new empty folder, select a il - | _>|_I
parent folder, then click the New Folder iseerate |
button. This will create a new folder =
called (guess what) New Folder! Navi-
gate to this, click twice slowly (to make the name editable) and change it to your
chosen name. Finally click OK to select the new folder. Whatever choice you
make, the name will be displayed in the Output Folder box. Your choice is saved
with other settings when you generate or click on Save Settings.

oK I Cancel I

A
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You can choose whether to display newly-generated Web output by placing a tick
in the Display Generated Pages box.

The People list on the left is there to allow the choice of subjects for Charts that
are then listed on the right. The contents of this list is determined by the selec-
tions made in the Islands display from which this dialogue was produced. To set
up a new chart, find the subject person in the People list, then double-click on
their entry. This will produce a small additional display in which you can select
the type of chart — Ascendant (Pedigree) or Descendant — and the number of
generations to be included. A zero in this latter entry will allow all available gen-
erations to be shown. (The additional display is like that below, without the
Delete Chart button.) Click OK to confirm your settings, when the new chart will
appear in the Charts list. The entry in this list indicates the type, number of gener-
ations and the subject in a clearly-coded form.

To alter or delete a chart, double-click on its entry in the Charts list. This will pro-
duce a small additional display in

which you can change the type of chart Displap Generated Pages.
. Charts

or the number of generations to be

included. Alternatively, click the £:0 Upudioed JVEGD “POOD2

Al Qawozl TIFWAR “PO00T
D5 Gigow DIEEL - P00

Delete Chart button for the expected
result.

The Find Person button enables a
search in the People list by RIN or

name. To find a particular individual in = | F&Setting
. . . " Azcendant Chart oK
the People list, click on Find Person. = Dosceridart Chart |
There are two ways to search for an e
C e . Generations Limit
individual: by RIN; by surname and e T
forename. Delete Chart |

To search by RIN, enter the required
RIN and press Enter (or double-click); press Esc to abandon the find. If a valid
Person RIN is entered, then the individual will be highlighted in the People box
and the current RIN will be set to this person. An incorrect RIN will produce the
message No such Person.

To search by Name, enter the start of the surname, letter by letter, as far as neces-
sary to find the required name. For each letter keyed, the People list will scroll to
match. If you should key incorrectly, you can use the Backspace key to make a
correction. When you have found the required surname, then key a comma , fol-
lowed by the start of the forenames, as far as needed. Press Enter or Esc to finish
searching.
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This facility can be useful when selecting the subject for new Charts. You can
locate the individual in PediTree's Index display or Family display. A click there
makes the individual current. On return to the Web Output Dialogue, their RIN
will be preloaded in the Find Person box when that button is clicked.

The Save Settings and Load Settings buttons enable you to save all your settings on
this dialogue for future use, then recall them when needed. The settings are save
in files with the extension .WOP.

Click the Generate button to produce the new Web output; a progress indicator
will appear while this is being done and your settings are automatically saved to
file default.wop. On completion, this button is disabled. Changing one of the
chart settings (or simply double-clicking on a chart entry, then clicking OK) will
re-enable the Generate button for another try.

Viewing the Web Pages

If the relevant check-box is ticked, then on completion of generation, the Web
output will be displayed in your default Web browser. If subsequently you wish
to display the output, then a double-click on the file index.htm in the Output
Folder should have the same effect.

Pages generated by PediTree are standards-compliant and have been tested in a
number of popular browsers. However, due to their construction and size, the
Charts do not print well if they extend past one sheet of paper.

The colours and some aspects of the pages produced are determined by the style-
sheet PediTree.css that is copied into the Output folder. It is possible to make
alterations to the colour-scheme by changing this copy of the style-sheet, but you
will need an understanding of cascading style-sheets to do this. Some changes
will destroy the layout and operation of the pages, especially the charts. The risk
is yours entirely; do not change the original file in the same folder as Peditree
itself.

F Print Menu Choices

Setup Paper : use this option if you want to select a . : :
diffefent }I))rinter or paperpsize, ch};mge from Portrait Dptions Window  H
to Landscape and so on. See Set-up Paper in section Setup Paper...

G below. Fonts ...

Ancestors chart...
Dezcendants chart. ..
Cancel printing

Fonts : brings up a Style dialogue to see the printer,
the usable paper-size and to select fonts for printing
for the main lists, charts and reports. Some screen

fonts can be changed. See Fonts in section G below. Eeport designs...
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Use Setup Paper before changing fonts, because the selected printer may use spe-

cial fonts and paper sizes.

Ancestors chart :

Descendants chart : these two options lead to a Choose number of Generations
dialogue for an Ancestors or Descendants chart respectively. See chapter 9 for

more on these Charts.

Cancel printing : abandon a print run.

Report designs : brings up a summary dialogue with total numbers of types of

Reports and Tables. It is not used to
select a report for printing; instead, use
a List or Family display and right click
on a record to choose a Table or
Report.

The summary dialogue lists alphabeti-
cally within type of record, all the
types of Tables, Reports, Charts and
Trees. Each entry is preceded by a
record-type number (0 Person, 1 Mar-
riage, 2 Source etc) in order to
sequence the list. Click on a line to
show the layout parameters that are
already defined for that Table or
Report; a Layout dialogue for that

10 reports, 12 tables (limit of 20 sach)
0 Person achait Ancestors
0 Person dehart Descendants
0 Perzon report Detailed
0 Perzon report Individual
Person report Pedigree
0 Person report PersonPhato
0 Person table Concise
0 Perzon table CrossReference
0 Perzon table Detailed
0 Person table 1G1
0 Person lable objects
0 Perzon table Simple
0 Perzon tree WideT all

k|

1 Marriage report BothPhotos
1 Mariage: repoit Detailed

1 Martiage report Family

1 Marriage table CrossReference
1 Marriage table Family

2 Source report Census

2 Source report Letter

2 Source report SourcePhoto
2 Spurce table cenzuzes

2 Source table objects

2 Source table Sources

3 Census table CensusLine

Table or Report will appear. See chapters 10 and 11 for more information.

G Print Menu Functions
Set-up Paper

Check that the printer that you want to use is shown as the default printer, or

choose a specific printer for use.

Note: PediTree requires a Windows graphics printer; a generic or text-only

printer will not work.

Check the orientation selected, or change it — portrait or landscape. This will be
shown as a Toolbar button of the appropriate shape:

portrait | Bl or landscape 2.

Change the paper size, source or options for your printer. Printer name and paper
printable size will be shown in the caption for the Style dialogue.
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Tips

If you get a message like “printer index out of range”, then probably no printer is
selected. Use the Setup Paper menu item to select your printer or create a default
printer in Windows.

For printing banner trees on Epson 740 etc., when setting paper size in Print
Setup Properties (user specified), click Options and enter width as say 2100 (10 x
210mm A4 sheets) and similarly the length (n x 297), or whatever size you think
that the tree will take.

Some Epson Printers (SC460, 740, 760) have been found not to work with
PediTree until an up-to-date printer-driver has been downloaded from the
<www.Epson.com> web site.

You can manually achieve double-sided printing for Charts and Tables by select-
ing odds or evens only in the Printing dialogue that includes title and heading
changes. More information on this in chapter 9 section B.

Fonts
The dialogue caption shows printer and paper size (printable area) used. You may
have to scroll to see all the font e pre—

options. The defaults will only be used  [Fertusedia KRN

Main body Times New Homan o

o 0K

the first time that you install PediTree. |mogsndine [rmesNewroman 10 2%
Any changes made will be remem- e evmom 1o TotSpacg 3
bered for subsequent runs. Date n e el i
Page number [ Arial 10
. view List Sysh 1m0
Click on a row to change one of: hew Fomily eemio 0

Edit teaxt Sysem 1

Main body for the text in most of the
report. (default: Times New Roman
10 black)

Background for the text defined in report background and the colour for the
lines. However, the font size will be taken from the main body. If the font name is
different, then there may be overlap problems if the font widths vary a lot from
main body. (default: Times New Roman 10 blue)

Background Lines will be thickened if you spin the Line Width arrows to 3 or 4
(default: 2). Size 1 may not be clear on some printers. Zero will hide all lines.

Titles and Headings for the two lines at the top of every chart, report, and one
line on wide trees. see Date and Page number below. (default: Arial 12 black)

view DetailBox for the text shown when you click the small Detail Box at the
foot of List, Chart and Family displays. (default: Times New Roman 10 black)
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Date in title for the date in the top left hand corner of all printouts. Its format
will be the same as you have set in Options > dates. You can suppress it by
changing its colour to white! (default: Arial 8 black)

Page number for the page number in Tables, Charts and Trees (default: Arial 8
black)

view List for the list (not plan) the font can be changed from the default
System 10 black, to another, perhaps Courier if you rely on fixed spacing in the
columns.

view Family for the buttons showing the people in the Family View, (but not
marriage date & place) can be emboldened or changed in size. This may be use-
ful if they do not appear bold by default on your system. Terminal font is neces-
sary to show left and right triangles, but other fonts will force the display of < and
> after reopening this database. This font is also used for picture script editing.
(default: Terminal 9)

Edit text for the Text display, used to enter/edit long text fields (default
System 10)

The font size can be entered as a number lower than the list shown in the dialogue
box —if it is a TrueType font. Font settings have no effect on saved files of text
for charts or lists.

Text Spacing can be used to increase the spacing between lines in Tables, Charts
and Trees as displayed on the screen and in printed output. Zero (0) is the default,
which may cause the descenders (on letters like g p and y) to be lost. Numbers
greater than zero give additional spacing: the addition is the standard spacing
divided by the number. So 1 gives 1+1 = double line spacing; 2 gives 1 + 1/2 =
1.5 line spacing; 5 gives 1 + 1/5 = 1.2 line spacing, and so on.

H Options Menu Choices

The Options menu has the following items: other
options that affect the display are on the Window
menu.

[Ifalyel findow Help
Definitions. ..

Dates. ..
Definitions : brings up a List dialogue that allows

. Picture zcripts. .
you to inspect and change the Record, Group and

. i v RNz sh
Choice definitions for the open database. See Hii:k ZI:; -
chapter 2 section C for how this is done. = o
Truncation code=16
Dates : brings up the Options dialogue for several Settings

date (and other) settings.

Picture scripts : the picture scripts defined in this database can be viewed,
changed and tested. See chapter 4 section K for more information.
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RINs shown : toggle between showing RINs and not showing them; marked by
a tick when showing. This setting is remembered in the open database.

PediTree picture script output will always prefix RINs by the first letter of the
record type name, such as P for Person and M for Marriage. Whether this is
UPPER or lower case will depend on how you originally defined those record
types. You may change the picture scripts in PediTree to show your own refer-
ence numbers if showRINs =Y, but these cannot be used as hot links.

Hot link char : the character used as a hot link marker can be altered, using the
Options Dialogue, although the caret (%) symbol is recommended to avoid ambi-
guity. This setting is remembered by PediTree between sessions, not in each data-
base.

Truncation code : this character, used as an indication that more text exists, can
be altered using the Options Dialogue. This setting is remembered in the open
database and restored when that database is used again.

In Windows Times Roman Font, ASCII 16 appears as a square, not as a right fac-
ing triangular block (»). ASCII 62 is a >. In Tree preview diagrams the boxes
that are truncated are highlighted, to enable the box size to be adjusted.

Timing of changes

The changes to data formats, RINs etc. will only be applied after that information
is recalculated. In lists, some of the list will remain in the previous format until it
is re-fetched from the database, not just scrolled into view.

J Options Menu Functions

Options Dialogue

This dialogue can be reached either |
from the Options Menu or the Win- [ Se—— _
dows menu. The available settings dif- | TM ' 200

fer slightly, depending upon whethera | — s Persit -

. ~date Prefix 7 i
database is currently open or not. — _
Today for {Now aged} ::: :ef T S
Sets the basis for the calculation of L L Backup on closing

ages for display by PediTree’s picture

[ date Format ~use last GEDCOM folder,
scripts. It also sets the value of the var- [dmomww =] b r
iable today that can be used in picture oty . ——
scripts and filters. See chapter 4. _ 1500 55
The initial setting is Now=none, Troncation char=0 |16 3] | Hotliskehar=" [ 2]
which turns off the age calculation and | ' '
display. The drop-down list contains v ok | X concel | 7 hei |
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various 19th/20th century census dates and ends with the current (today’s) date.
Alternatively, you can type a date of your choice into the box. Click OK to con-
firm; the date set is displayed in the PediTree toolbar and is kept for the current
session only. Clicking on the date in the Toolbar brings up this dialogue, so that
you can change the date.

Date Prefixes

Change the abbreviation used for before, about/circa and after. This setting is
remembered in the open database and restored when that database is used again.
Click OK to confirm the change.

The normal prefixes are:

Full prefix Abbreviation GEDCOM ISO date suffix
(for filters/comparisons)

before bef. BEF <

exact =

after aft. AFT >

about cir. ABT ?

Date Formats

Click on the down arrow to select the format. This setting is remembered in the
open database and restored when that database is used again. Note the option to
show the day of the week. Click OK to confirm the change.

The list of formats is shown here with examples:

dd mmm yyyy 03 Jan 2003

dd-mmm-yyyy 03-Jan-2003

ddmmmyyyy 03Jan2003

yyyymmdd 20030103 ISO Format
yyyy 2003

yyyy-mm-dd 2003-01-03

ddd, d mmm yyyy Fri, 3 Jan 2003 *

d mmm yyyy 3 Jan 2003 *

* The last three settings are not compatible with Pedigree for DOS

The string is shown in the date edit box according to the rules below. The global
variable refers to your Windows Regional and Language settings. GEDCOM
export always uses dd MMM yyyy — 03 JAN 2003

d  Displays the day as a number without a leading zero (1-31).

dd Displays the day as a number with a leading zero (01-31).

ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by
the ShortDayNames global variable.
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The potential problem with showing days of the week is knowing which calendar
is appropriate. PediTree assumes the Gregorian calendar, valid after 14 Sep 1752

in the UK and colonies. Other countries changed over at various dates from 1582

to 1946. The Russian team was 12 days late for the 1908 Olympics, because they
still used the Julian calendar! Before 1752 the year started on March 25.

mmm Displays the month as an abbreviation (Jan-Dec) using the strings
given by the ShortMonthNames global variable.
yyyy Displays the year as a four-digit number (0000-9999).

Century
This setting determines how two-digit years are interpreted on entry. For exam-
ple, if this setting is 1900, then a year 53 will be interpreted as 1953.

List Paging
Lists are read in and converted using the List picture script in units that can be
changed here. The default is 100 lines.

Hints Persist

You can change the time in seconds that the yellow hints persist, by changing the
default of 3.

Tiled / Number of Windows

Limit the maximum number of display windows open at any one time. The
default is three windows, plus one for each record-type. If the Tiled box is
checked, then the open display-windows will always be tiled to fit into the dis-
play area, rather than simply cascaded and overlapping.

Back-up on Closing

If this box is ticked, then any open database that has been edited will be backed
up when it is closed, by exporting a GEDCOM file. If this box is not checked, or
if no editing has been performed, the back-up will not be offered.

Note: GEDCOM backs up the data, not the scripts and definitions. This is no
substitute for a complete back-up of the whole database folder.

Use Last GEDCOM Folder

If this option is checked, then PediTree will remember the last folder selected in
the Save GEDCOM dialogue (see chapter 12 section D) or Open File dialogue
(chapter 12 section E) and use it as the default for future GEDCOM Export and
Import operations. If unchecked, then the Save and Open dialogues use the cur-
rent (PediTree) folder as the default.

Always Edit

You can change the starting mode for databases between View and Edit mode by
checking or not in this box.
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K Window Menu Choices
Options affecting the display can be set

Wdindow Ws 8]
here, and some are remembered r—
between PediTree sessions. The -

choices on this menu are: ,
Cloge windows

Cascade : arrange all open displays in | ¥ Eaater shawn
cascaded layout, useful if you can’t see ¥ ‘oolBarshawn

all of a display because it gets too Lneree [zome

large, or just to tidy up. PediTree was il

designed in a screen mode of 800x600; Picklist select

in a lower resolution, the individual v Eints shawn

displays may be too large. Cascade or | RGN

Tile (below) can help in this circum- List paging=20 Male
stance. Mumber of windowz=3 Eemale

Edit headings

Tile : arrange all open displays in a T |

tiled layout. This choice toggles

between vertical and horizontal tiling (if it can) each time that you click on it.
Sometimes you will be able to see several small displays without overlap. See the
previous section for the always-tiled option setting.

Close windows : will close all displays, such as Family and Lists. Use List >
Choose to open new List displays, then Edit > Family to open a Family display, or
the corresponding Toolbar buttons.

Arrange Icons : when some or all displays are reduced to icons (see next choice),
this will arrange these neatly.

Minimise All : if the screen becomes too cluttered, this converts all open display-
windows to icons. You can then select just the displays that you want.

Picklist select: select a particular folder from which to load a new PLAC.LST
place pick-list.

The following three options toggle their settings on and off, with on indicated by
a tick against them in this menu:

Footer shown : show the footer status bar. You may want to switch it off to
make space.

Toolbar shown : show the Toolbar with its buttons.

Hints shown : show the little yellow hint box that follows the mouse. If these
hints get in the way, then you can switch them off; the same text will always
appear in the footer bar (if that is visible). You can change the hint background in
the colour menu item below. You can change the time in seconds that these hints
persist in the Options dialogue, reached from, for example, the List paging option
in this menu.
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Colours : This option leads to four sub-menu items. For each, you are presented
with a palette from which to choose your colour, then click OK to confirm:

hint background: the mouse-following hint box.

Male: change the colour in the family display of boxes for husband and
grandfathers.

Female: change the colour in the family display of boxes for wife and grand-
mothers.

These two changes only take effect after choosing another Person in the Fam-
ily display.

Edit Headings: the background colour of headings in Edit displays when in
Update (Edit) mode. These headings remain grey when in View mode.

Other screen colours are taken from your Windows system settings, which
you can change if you wish. To change the colour of the text in Reports,
Tables, Charts, Trees and Detail Boxes, use the Style dialogue produced by
Print > Fonts.

The following two options bring up the Options dialogue, from which they can be
set: See the comments about these in the previous section.
List Paging

Number of Windows
At the bottom of this menu is a list of currently-open display windows. The
number keys can select another open window from this list.

L Help Menu Choices

Press the function key F1 to get help on any menu or
window, even if no Help button is shown. In the on-line Bl

help, find out how to use it by pressing F1. You can add About copyright

your own comments to the on-line help if you want to: Contents

press F1 and then see under Customizing Help. Version

The choices in this help menu are: Hints and tips
current Bz

About copyright : shows basic PediTree version, copy-
right and contact information in a message-box. A Help
button leads to an introductory page of the on-line help. defug

diagnostics

Contents : brings up the main contents page of the on-line help.

Version : shows the program version number and a summary of changes from
the previous release. The Help button gives the on-line help version number and
a history of changes.

Hints and Tips : brings up some useful hints for when you first open a database.
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Current RINs : shows a list of Record-types (RT), each with their record-count,
the highest RIN used and the current RIN, together with a brief script summary of
the contents of that current record. The record-types are identified by a letter and
number, e.g. P 0 (Person); M 1 (Marriage; S 2 (source); C 3 (census); e 4 (empty
— space for a new record-type).

1I

RT count highest RIM current

P 000008 00008 00001 Alan ROE <PO01

M 100003 00003 00001 ~M001 Alan ROE ~P001 (bapt. 170ct1835- 14May 1910) & Susan SHARP ~P002 (c. 1840-27May1875)
5200004 00008 00001 ~S001pr

C 300004 00004 00001 ~CO01census 1871 alan ROE ~P001 head age 35 draper

& 400000 00000 00000

diagnostics : shows a list of warnings discovered in a session or of errors for
Pedigree Software use during development. You may be asked to look at this if
there are problems. Click on this list box to hide it. Right click inside it to save it
to a file which can then be printed using Windows notepad or your word proces-
sor. Any initial picture script syntax errors will be listed here. A diagnostic log of
the numbers of records for each type of record is shown after closing the data-
base.

debug : toggle on or off the logging of diagnostics (other than errors) to the diag-
nostics list. A tick will show when logging is on. When it is on, picture scripts
will be interspersed with the script names.

Diagnostic log example

The log is created on opening and closing a database, also in List places, GED-
COM error reports, or whenever an error in the program is encountered, option-
ally after debug is turned on. The log is cleared when debug is turned on.

Here is a normal example of a log with no problems.

PediTree v3.038 DB991212 04/03/00 17:55:59
d:\pedigree\ken712.ped last saved by 2.6J at 2198 updates
1961 Person

565 Marriage

185 Source

165 Census

Another example that includes the results of a Check Database operation is
shown earlier in this chapter, in section B File Menu Functions.
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Chapter 9 Charts and Printing

This chapter deals first with the Ancestors and Descendant Charts that PediTree
provides, then with topics concerned with printing them. These printing topics are
common to all forms of printer output, including the Tables, Reports and Trees to
be described in subsequent chapters.

A Ancestors and Descendant Charts

These two charts display either the ancestors or the descendants of an individual
in indented form.

To produce an Ancestors or Descend- ]
ants chart, first choose a person by
clicking in a Family display or List & Pose noesseen || ° B S
display of a Person list. Then from the ! : X Cancel
main menu, choose Print > Ancestors [ Indentation 5= 7 heb |
chart or Print > Descendants chart to I — FLTnE
bring up a Choose number of Genera- I [z 2| & fines oFF

tions dialogue. The Toolbar buttons
E for Ancestors Chart and 22 for Descendants Chart are convenient.

Set the number of generations that you want to include. The indentation, width
(250 maximum) and lines ON/OFF can be changed. These changes last for the
current PediTree session only. Ensure that the width is at least 20 + (indentation
X generations), otherwise there won’t be space for any detail.

If you want to send the chart in an email, make the width less than 72. For print-
ing, make the width higher than 80 if you want only the page width to restrict it,
depending on your font size.

The level of detail in the outline Chart (to be displayed first) can be selected by
clicking a tab at the top. Print preview detail can be chosen later. If you want to
change the level of detail in the outline after you have drawn it, then close the dis-
play window and start again.

Click the OK button and a new Chart Outline View display will appear, as on the
next page. The text displayed is determined by the brief, normal or detailed Ach-
art picture scripts in the database.

You may have several charts’ displays open at the same time. In these displays,
left and right arrow keys move generation levels. Ctrl+up or Ctrl+down will
move between descendant siblings or ancestor spouses, along the vertical lines.

An open folder showing some family can be shut, showing a shut briefcase to
show more of the siblings in one family. Double-click on a line showing a shut
briefcase will expand one level.
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—oix
v N A T
C 2 2. George VI “PD62 [1895-1952)m. to Queen Mother Elizabeth BOWES-LYON “P0O66 [-30Mar2002] and had 2 children: ﬂ

— & 1. Queen Elizabeth Il “PO67 [1926)m. 20Nov1947 in Westminster Abbey to Philip “P060son of “M018 Andrew of Gree:
& 1. Charles “P088 [14Nov1948 in Buckingham Palace]m. 29Jul1981 div.28Aug1996 to Lady Diana SPENCER “P091
B 1. William “PD92 [21Jun1982)
B 2. Prince Harry “P151 (15Sep1984)
[=B>. Anne “P0O83 [1950)m. [1 of 2) 14N che ' &
B 2.m. (2 of 2) 12Dec1992 to Tim LAY print chart
B 3. Prince Andrew “P152 [19Feb1960 Save charttext..
Edit M51
B 4, Edward “P090 Grid diplay
— (& 2. Margaret “PO68 [1930-09Feb2002)m.  eypand chart
B 1. David ARMSTRONG-JONES “P13;  okmes

DetaiBox Print
B 2. Lady Sarah ARMSTRONG-JONES dram Repart...

Captain Mark PHILLIPS “P129 [1948) and had 2 children:
r1955] no children
IMay1996 to Sarah FERGUSON “P153 [150ct1959] no chi

ARMSTRONG-JONES “P132 and had 2 children:

Lel |
MIN-MO51 =l
husband:Captain Mark PHILLIPS “P129

b.1948

m. [1 of 2] 14Nov1973 div. 1992

wife Anne “PDE3

b.1950

and had 2 children:

Peter PHILLIPS “P130, Zara PHILLIPS “P131
changed:24Jul2004 21:23

A single click on a descendant will display a Marriage Detail Box (or a Person
Detail Box if they have no spouse) and a single click on an ancestor will show a
Person Detail Box.

In Descendant charts, the Dchart brief, normal or detailed picture script is used to
show one line against the outline diagram symbol. When you click on a line, the
Detail Box will show either the Marriage or Person detailBox script output
depending on whether they have a Marriage record. The husband is shown first,
not necessarily the descendant as shown in the chart.

Only one line of text per descendant or ancestor is shown on the screen with some
short vertical symbols (|) representing newline characters. The full printout
shows all detail wrapped to the width of the page.

A right-click in the outline view will bring up a menu with the following options;
first left-click on a row of interest to select a person or marriage for Mark /d, Edit
Id or Grid display (/d is the RIN of the selected row):-

Mark Id (person leaf only): mark the chosen person for subsequent placing into
another position; their details will be displayed on the Toolbar.

eXpand chart : will reopen any closed branches and will create new ones for
one more generation level, each time that you use it. Check with the Volumes
option to see if no more generations can be added. For big charts, you will be
asked about every 400 lines to confirm you want to continue. There will be a
pause if you cancel as it draws a big chart of hundreds of lines.
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There is a limit of 16,000 leaves, but the width is insufficient for more than 40
generations! Double-click on any final leaves with a plus sign if you just want to
expand individual leaves.

Save document : save the full text (not just the on-screen outline line) of the
chart to a file. A Save File dialogue will allow you to choose the folder and
filename. The filename will be suffixed .TXT unless you choose IBMPC charac-
ters with a suffix of .PC8. The default is to save the outline as a .txt file with the
lines as + |- characters, instead of IBM box characters that need the MS Line-
Draw font.

The initial folder is that containing the database; change it to wherever you pre-
fer. The file will be formatted according to the options that you selected in the
chart dialogue with the indentation, width and lines ON/OFF.

If you open the resulting file in your word processor, you should select all the text
and choose a fixed-space font such as Courier, to avoid the vertical alignment of
indentation lines going haywire.

Other line : where there is an intermarriage, say between cousins, Descendants
charts will show ‘see other’ only against the second occurrence of the marriage,
to avoid repeating children. This may not be a later line, but could be a higher
generation level. Right click to get this option and then click it to cycle around
each of the repeated marriages in Descendants charts or people in Ancestors
charts.

Print chart : print the chart. See Printing below.
Edit Id : bring up an Edit display for the row selected by the last left click.

Grid display : bring up an Edit grid (horizontal) for the row selected by the last
left click.

Print Detail Box : print the contents shown below the chart outline in the Detail
Box, but not limited to its size on this screen. It uses any print setup or font that
you have set in Print menu using the heading and body font, not the screen detail
box.

Volumes : will give statistics on the number of generations and the number of
item lines in each generation.

draw Report : the chart outline will be replaced by a Report. See chapter 10, sec-
tion B for further details.

Preview and Print Charts
At the top of the Chart outline view display the picture script choices are shown
as tabs. Click one of them to preview the full detail that would be printed. The
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resulting print preview shows the same tabs, so you can easily preview differing
levels of detail.

The horizontal lines against each descendant and spouse can be coloured like tree

=0T
\Back )BRIEF {NORMAL JDETAILED /
25 Aug 2004 PediTree Royal03 brief chart Page 4|
4 generations of descendants of George VI *P062 (1895-1952) 1 j

F—George VI P52 (1895-195)
m. Queen Mother Elizabeth BOWES-LYON “P066 (-30Mar2002)
[—Queen Elizabeth IT “P047 (1926)
m. 20Nov1947 in Westminster Abbey Philip ~P060
—Charles “P088 (14Nov1048)
m. 207ull981 div.28Aug 1996 Lady Diana SPENCER P09 (1961-31Aug1297)
William “P092 (21Tun1982)
Prince Harry “P131 (135ep1984)
[—Anne "P08Y (1930)
m. (1 of 2) 14Nov1973 div.1992 Captain Mark PHILLIPS “P129 (1948)
Peter PHILLIPS “P130 (13Nov1977) ['\\5
Zara PHILLIPS “P131(15May1981)

—m. (2 of 2) 12Dec1992 Tim L AURENCE “P154 (01Marl833) Diagram
—Prince Andrew “P132 (10Feb1060) Back Esc
m. 23Tul1986 div.30May1996 Sarah FERGUSON “P133 (130ct1939) Print al
=—Edward “F020 -
—Margaret “P0§ (1930-09Feb2002) Brint page 1
m. div.1978 Anthony ARMSTRONG-JONES “P132 Layout... b
David ARMSTRONG-JONES "P133 (1961) T ,
Lady Sarah ARMSTRONG-JONES “P134 (1964) i,
- View page 1
Autharship rectangle...
Crientate
4 | » 4

lines. The PLAN LineDown picture script is used for each descendant, as
described in chapter 4 section D Tree Line Style changes.

The default print title and heading are shown at the top. They can be changed by
clicking at the top of the screen, then altering them in the resulting Printing dia-
logue.

Right-click in the preview to bring up a menu with the following choices:

Diagram :
Back Esc : return to the outline view

Print all... : for all pages of the Chart
Print page n : for the current page n, e.g. Print page 1.

See section B Printing below
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Layout... : brings up a Layout dialogue to change the Chart layout.
Save image : save the current page as an image in JPG format.
View page m : view the next page, e.g. View page 2

Authorship rectangle... : places a rectangle with your personal details at the
point at which you right-clicked. The text is taken from your PediTree registra-
tion file and is presented to you first in an editing window (as shown) for you to
make any required changes. Double-click in this window to place the rectangle.
To remove the rectangle, temporarily select another Table design tab, then return
to this one.

Orientate : brings up a Print Setup dialogue so that you can change the paper ori-
entation (or other settings).

B Printing

Whenever you choose to print a Chart, =lolx|
Table, Report or Tree, then. two com- o Page 2]
mon steps follow. These will now be  its of George VI AP062 (1895-1952) e
described.

Your name

First a standard Print dialogue appears. Yous hoviee
This allows you to select a printer and 053140197 T e
set its properties, if you haven’t done

so earlier. For example, you can
change the page orientation, but this )

P120 (1948)

Your name

will usually cause the preview to be Oes)  ||vour house

Your town
redrawn. lYDur postcode _

The dialogue shows the number of

pages to be printed. If you wish, you

can select one or more pages here.

Clicking Cancel will quit the printing operation.

On clicking OK, the PediTree Printing

: : ot 2| x
Dialogue will appear, showing title o —
and heading, with an option to print ome: Propetes.
odd, even or all pages. This enables Satus: Aeady
you to achieve double-sided printing, P e
if your printer doesn’t have this facil- Commert:
ity. Brint range LEr—

L. o Numberof copes:  [1 =]
When printing Trees, you can show Cpoges fomefi | || o
the row and page number in the top € Seleston _IIJ_ZH_aH "
_Cenca_|
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right corner by marking X in the check “‘F“_... PediTres Royaas persen Sinpie bl L| "
16!?.!“ Bst using forenames ,
box for Page Nos. — o ~«-;;;;-

If the title or heading is not to your lik-
ing, then you can select an old one
saved in PediTree by clicking on the right-hand down-arrow and selecting one of
those shown. You can also edit the title or heading.

If you delete the title or heading com- T — ~inix
pletely, then PediTree creates a default — resingfocTio s o s gsverions om chares s E

for Reports and Charts. Reselect the e ] =

top tab to restore a default heading for

Tables and Trees. However, if you

replace the title or heading with a SPACE BAR character or two, then the line
will be blank.

Click OK when satisfied, or Cancel to abandon printing. Once printing has
started, there is a risk of a program error when canceling a print. Put your printer
off-line, and let Windows detect this and give you the option to try again or can-
cel. Wait until the Printing dialogue has disappeared before continuing with
PediTree.
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Chapter 10 Tables and Reports

PediTree can produce two types of tabulated output: Tables and Reports. Tables
have multiple columns and display one or more records, with each record taking
as much vertical space as it needs; Reports have a fixed layout on the page for
one record at a time. In both cases, you start by having a copy drawn on the
screen; you can then view it and/or modify it before printing.

The title, body contents and background are able to use different fonts chosen
from the main menu Print > Fonts Style dialogue. Background lines and text may
be best in a different colour from the body contents.

A Draw Table

The production of a Table is started from a List display pop-up menu, not from
the main Print menu. On entry, the top of a Table is displayed. Tabs across the
top of the display show the names of Tables that can be printed for the type of list
that you selected. To go back to the original List display, click the tab for Back,
press the Esc key, or right click and choose Back.

+ List1 Indexed with 154 Person records =10] x|
\Back \Simple {CrossRefeience | Detated [ Concise |
25 Aug 2004 PediTree Royal03 Person Simple table Page |
154 Person list using forenames , =
EIN | Sumame Forenames Date of B/C | Place of B'C Parents
P135 ?
P082 Adelaide 1792
POTT Adelphus 1774 (George Il Sophia Charlotte
P01 Albert 1812
PO3E Albert Christian Helena
PO17 Albert Victor 1364 Edward VIL Alexandra
P146 Alexander 1823 Ludwig I, Wilhelmina
PO34 Alexander
P49 Alexander Henry Beatrice
PO16 Alexandra
PO33 Alfonso XIIT
PO06 Alfred o Albert,Victoria
P46 Alice LA Leopold Helena
PO34 Alice Back Esc Lows, Victoria
PO0S Alice Maud Mary print al... Albert,Victonia
P52 Andrew Philip Elizabeth II
P039 Andrew Erint page 1 ? —
P89 Anne Layout... Philin Flizabeth IT
p1SS Amme EETIETITE
P14 Anne T
P114 | Baleyn Anne B DWE - =
P132 | Ammstrong- Anthony table Grid save CSV
Jones Create new... save RTF
P118 Arthur v VIl Elizabeth
3 Arthur Arthur Louise Margaret
POOS Arthur Albert Victoria
PO84 Augusta Fredenck,Caroline
PS4 Augusta
POl Beatrice Albert Victoria
PO30 Carol I Ferdinand Marie
P139 Caroline
POTR Caroline
POS6 Caroline
P113 Catherine
P116 | Howard Catherine
P117 | Parr Catherine
PO3S Charles 14Nov1948 | Buckingham Palace | Philip Elizabeth II _,ﬂ
4] 12 4
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Click on the tab for the Table you wish to view. The display can be resized or
scrolled to see the rest of the page. You can view different pages by altering the
page number displayed top right and then clicking in the page-number box.

Right click to pop up a menu with the following choices:
Back Esc : to return to the list or family display

Print all : print all pages of the Table.

Print page n : for the current page n, e¢.g. Print page 1.

You may be warned to select Set-up if the width is greater than the current printer
page paper width. See chapter 9 section B for the printing procedure.

When you choose to print all pages, a list box will temporarily show the item
count of the first record on each page, which is useful to see how many are left on
the final page. The final page is then shown on the screen. You can cancel this
print (if you just want a page count) or specify the pages required. You can also
find the last page by clicking the page number to a high value.

Layout : brings up a Layout dialogue to change the Table layout. See Table
Design below.

Save image or text : the whole Table can be saved in various formats. See Save
as Text or Image below.

View page m : view the next page, e.g. View page 2

table Grid : This is a view of the whole list shown as a grid with columns, but no
horizontal ruling. As the whole list has to be drawn, it will take more time than
previewing the first page, but less time than previewing all pages. See Table Grid
below.

Create new... : create a new blank Table. Within this, right-click and choose Lay-
out to fill in the details.

Authorship rectangle : places a rectangle with your personal details at the point
at which you right-clicked. The text is taken from your PediTree registration file
and is presented to you first in an editing window for you to make any required
changes. Double-click in this window to place the rectangle. To remove the rec-
tangle, temporarily select another Table design, then return to this one.

Orientate : brings up a Print Setup dialogue so that you can change the paper ori-
entation (or other settings).
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Save as Text or Image

The Print Preview display for any type of Chart, Tree, Report, or Table can be
saved to a file as a graphic image in JPEG format (filetype .jpg). The display is
saved at screen resolution (typically 72 dpi), so may be disappointing if printed.

Tables can alternatively be saved in various text formats: you have a choice of
Tab delimited, CSV (Comma Separated Values) or RTF. Tab-delimited and CSV
are similar, the difference being how the text in the columns of the Table are sep-
arated: either by a tab character (Tab delimited) or by a comma (Comma Sepa-
rated Values). The former is suitable for import into a Word Processor, the latter
into a spread-sheet.

The first row in each case will contain the titles of the columns in the Table. Any
new line characters within a column will terminate the output from that column.
Because a column entry is limited to 255 characters, any longtext fields may be
cut short.

Rich Text Format (RTF) is an alternative for transfer to Microsoft Word, Word-
Pad, WordPerfect, OpenOffice or other word processors. It allows more textual
style features to be recorded, such as font names, sizes and colours, and uses the
table column features of a word processor. Further editing in your word processor
is easy. Some are better at importing this format than others; WordPad is particu-
larly poor; it does not support the title, date, page numbers and heading of the
table — just the columns, and it will not wrap cells that have more than one line or
wider than the cell.

If you choose to export RTF, a message box will ask if you want to open the new
RTF file in the word processor on your PC that is the default application for .RTF
files, usually Word. This application will open alongside PediTree, but you must
close it yourself when you have finished with that file. If you rewrite the same
filename later, it must have been closed.

If the left edge column line is invisible when you preview the table in the word
processor, slightly increase the left margin in its printer setup, or return to
PediTree and increase the left margin in Layout by 1.

1. To save, right-click on a Chart layout, or print preview and choose Save image
or Save image or text, whichever is available. In the second case, a sub-menu
will give you a choice of Save image, Save Tab delimited, Save CSV or save
RTF

2. A standard Save As dialogue will allow you to give a filename and select a
folder. Click Save to finish.
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Table Design

You can design a new Table, add, change or delete a column, change its right,
centre or default left justification. (Use right justification for dates and perhaps
names to align identical surnames.)

The width of the Table is based on the width of your paper, depending on
whether you have selected landscape or portrait orientation. The columns are
spaced out proportionately on the column widths specified in the Layout dia-
logue. As arough guide, if you have more than 100 characters across, use land-
scape mode or set the font size to 8 or less in the Style dialogue, obtained from the
main menu by Printer > Fonts.

Each table column has a space either side and one inter-column space, with a
final column space making the total width = (total width of columns) +
3*(number of columns) + 1. This total is shown at the top of the Layout grid. The
left and right margin are added to this before dividing up the width of your por-
trait or landscape paper into column widths. The proportionally-spaced text is
then fitted into this width and the number of lines of word-wrapping used to find
out if this cell will fit before hitting the bottom of the page.

Column sizes can be changed in the Layout dialogue, or in the Table view using
the left mouse button to drag the top of a column sideways and releasing it. It
only directly affects the column in which you use the pointer, but may alter the
apparent width of the other columns.

PediTree starts a new page with a new record so avoiding widows and orphaned
lines of text belonging to another page. However, if a record cannot fit a page,
the end of the record will be cut off.

Table Layout Changes

Always back-up your database before making changes, which cannot be undone.
The Layout dialogue lists all the col- m,_xw o |
umns of a Table with the start of the = S— PT:']”*' |.....m.:_.—m|
picture scripts that are used for each e N o
column. Clicking on the picture script 1 e

will show it in full in the normal Pic- T m“wﬁ m I
ture Scripts Editor, where it can be B [Pacod B 15 L bath prsentthen bt hace aleo che
changed. Er«m‘ R fetheclornamen [ mothe frenamer
The second line will show the name of etoams

the Table and the overall width calcu- _—

lated from the column settings.

Right click on the title line to get a pop-up menu (as shown) to append a new
Table column, or delete the whole table. Deleting a Table merely changes the
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name of the table to ‘erased’. It will then be deleted at the end of the session,
when you close the database or exit PediTree. However, before then the Table
could be rejuvenated by changing its name back to a valid one.

You can edit the table name to a unique (for this record type) fully alphabetic
name of up to 16 characters without spaces or numbers, then click OK.

Right click on the definition of a column to give a pop-up menu with the follow-
ing options:-

Append column n : add a new column at the right hand end of the Table (end of
the list).

Insert column » : insert a new column before the present one. New columns are
by default left-justified with a width of 20.

Delete column »n : remove the current column and move the others up.

After creating a new column, you will need to insert a column title, alter the posi-
tion (if required) and add a picture script.

Click OK to confirm the changes and view the result. You can adjust the Table
column widths by dragging and dropping in Table view mode, or by returning to
the layout dialogue and changing the width values.

To rearrange the order of columns in a Table, go to the Layout dialogue, hold
down the left mouse button on the left hand grey row name and drag it to the
required position. The dialogue will show that the row in the definition has
moved, but it will retain its old column number for now.

Rearrange other rows of the definition before clicking OK to redraw the Table.

Table Grid

This provides a view of the whole
Table shown as a grid with columns,
but no horizontal ruling. It is useful for
rapid browsing through the grid for
examining the data.

EgazzazegE: 3o

As the whole list has to be drawn, it
takes more time than previewing the
first page, but less time than preview-
ing all pages. All columns will be left
justified, ignoring design parameters
for centring or right justification.
Columnar lines can be moved but do
not affect the design column widths.
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The column titles/headings will remain in position, however far down the table
that you browse. You can lock left-hand columns to prevent scrolling, while you
move to see right hand columns. Left click (select) a cell in a normal column,
then right click and select lock column: the columns to the left of the selected cell
will be shaded and locked from scrolling, just as the heading/column title rows
are. In the illustration, the left-hand column has been so locked.

To return to the normal view, right-click and select View page n.

B Draw Report

The production of a Report is started from a List display or Family display pop-
up menu, not from the main Print menu. Reports of an individual record can be
printed, as can Reports for all the records in a list.

On entry, the top of a Report is dis- o
played. Tabs across the top of the dis- - Eeorgen
play show the names of Reports that e
can be printed for the type of record
that you selected. To go back to the

original Family or List display, click
the tab for Back, press the Esc key, or =
right click and choose Back. =

z

Click on the tab for the Report you
wish to view. The display can be
resized or scrolled to see the rest of the |, o]
Report.

Right click to pop up a menu with the following choices:
Back Esc : to return to the list or family display

Print all : print Reports for all records of the list; you will be warned of the total
number.

Print page 1 : for the current record (page).

You may be warned to select Set-up if x|
Topmugn 1© =l page wan [ 21 ? Hel | ok

the width is greater than the current

10 5][Pesson [name/posn [wideh [height st Ste/picture script i'l"ﬂ

printer page paper width. See chapter 9 * m & e
section B for the printing procedure. A | S e
5 21 [ I [ Title: "title]
Layout : change Report layout defini- b |en S 1 etm)
tions. (only left, right and top margins s MO e
can be altered; see illustration) TS R sl
(S 531 buth place
£l na ™ 3 bath notes
;L! 1413 2 1 chuisterang date L,;‘
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Save image : save this page as an image in JPG form.
View : to select the page under the cursor to View it and perhaps print all pages.
Authorship rectangle : as described previously.

If the Report (as defined in Pedigree for DOS) has a bottom area unlimited by a
background line that would go onto subsequent pages, PediTree will continue
printing it for several pages, not limited by the height of that area nor the page
height. It is not yet possible to preview these pages.

Report Design
At present, Report design must be done using Pedigree for DOS.

Images can be placed in one or more of the rectangular areas when you design the
Report. When pressing F5 (in Pedigree) to specify the picture script, it should be:

"ImageA" objects.file
(the caret symbol A is above key 6).

This will allow a path and filename to be followed to load a file as the image to
be displayed and printed. The image will be scaled to fit the box and positioned at
the left or top of the box depending on which dimension has to be reduced. You
may find that a squarish box is the best compromise unless you have standardised
the aspect ratio of your images. The ratio of character width to line height is
approximately 3:4 but this can vary with fonts and PediTree may adjust the height
to fit the paper size.
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..............

Chapter 11 Trees =

PediTree provides two forms of drop- |
line Tree: Wide Trees and Tall Trees. e
Wide Trees have the generations run-
ning from top to bottom of the page;
Tall Trees have the generations across
the page, which makes for a more
compact (but less conventional) layout.
Before you can draw and print either
type of Tree, you must make an i
Ancestors plan or Descendants plan.

See Create Descendants and Ancestors ...

Plan in chapter 8 section E for details.

Wide Tree

Once the appropriate plan is displayed
as a list, then you can choose Wide [ S

Tree or Tall Tree from the pop-up

menu in the List display. This produces a Tree Layout display with information to
help you fit the tree onto a minimum number of sheets of paper.

RN T | zi

il e

At the top is shown a message containing the maximum strips and generations
such as:

1 row of 3 pages wide , each page 5 generations of 7 strips wide

Green dashed lines will criss-cross the diagram to show where the page bounda-
ries would separate complete boxes, based on the printer page-size that you
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selected. (The pages shown on the diagram do not have the same aspect ratio as
the printed page.)

You can change between portrait and landscape orientation or change font size or
other layout parameters. PediTree will then recalculate how the plan will fit your
paper and re-display the layout.

Tabs at the top show the possible picture script names, with Normal selected ini-
tially. Click on another tab if you want to use a different script to display this
Tree. You do not have to create a different plan.

The rectangle containing the text about each person on the tree defaults to a maxi-
mum size of 25 large characters (like M or X) wide by 8 high (not including the
lines and spaces around the box). If the font used is proportionally spaced, then
there will be more than 25 characters in that space. The width, height and posi-
tion of text within these boxes may be changed from the Layout dialogue,
obtained from a pop-up menu. These settings will be remembered between
PediTree sessions.

The layout diagram will show the paper orientation, and width and height used in
the boxes. The width may be greater than your setting, because the program will
use any spare characters to fill the width of the paper, without increasing the
number of strips.

For Tall Trees, the position of the ancestors can be changed between left and right
in the Layout dialogue. The right setting is recommended for both Ancestor birth-
brief style and Descendants Trees, so that they can be turned sideways with
ancestor at the top and children left to right. (The Report design called ‘Pedigree’
is also in the style of a birth-brief.)

For Wide Trees, the layout diagram (as illustrated) will show all the tree, using
cyan to show boxes with numbers of lines of text less than the box height and
fuchsia for those that are too big. Each box contains a figure which is the number
of lines in that box, including sometimes a final blank new line. Number of trun-
cated boxes are shown at the top left of the window.

Hold the left button down on any box to view the text and the differences from
the defined box size show at the top. The lines that would be lost are shown
below *** TJost=>. The treeref (generation:strip) of that box will be shown at
the bottom. The selected person becomes your current person and marriage so
that you can use the main menus to display a new family or edit that selected RIN
if you spot an error.

Images can be shown on Wide Trees using the Brief picture script, if the box size
is deep enough (say 20 lines, or 6 lines free after the text is shown). They cannot
be shown on Tall Trees.
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The title and heading will appear only on page 1 of row 1, although all of row 1
pages will have both top space and heading space allocated, whilst all other rows
will have only top spaces set in the Layout dialogue.

A right-click brings up a menu with the following choices:

Diagram :
Back Esc : return to the List display

£ List Desciree B for 4 generations from George V1_~P062
T

Print all : for all pages of the Tree

Print row n, page m : for the current s —

page, e.g. Print row 1, page 1. o ah |

This will print all pages or the selected e S
page of the Tree, but you will probably |———— @=== | —-
prefer to see a print preview first. See
chapter 9 section B for information
about the printing procedure.

Layout : brings up the Layout dialogue to change the Tree layout. See below.
Save image : save the Layout diagram as an image in JPG format.

View row n, page m : see a print preview of this page

Authorship rectangle : (disabled)

Orientate : brings up a Print Setup dialogue so that you can change the paper ori-
entation (or other settings).

Choosing the View... option brings up a print preview of the chosen page of the
Tree. A right-click here produces a similar pop-up menu, with a few differences:-

Diagram : return to the Layout display
Save image : save this page of the Tree as an image in JPG format.

Authorship rectangle (row 1, page 1 only) : places a rectangle with your per-
sonal details at the point at which you right-clicked. The text is taken from your
PediTree registration file and is presented to you first in an editing window for
you to make any required changes. Double-click in this window to place the rec-
tangle, when the Layout diagram will re-appear. To remove the rectangle, tempo-
rarily select another picture script tab, then return to this one.
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: X
Layout Dialogue Topmasn [0 poge o ® 3 7 vew | J

This is illustrated opposite, for a Tall
Tree; a Wide Tree omits the Ancestor
Posn. box.

namefposn [ widih [hoight [Last @le/pictsan script |RE
Tall F 8

+
i spouse. vex=m and ioomanioge wior |

il pouse sex=m and beemasiage whes

i spouse sew=m and ioemasrriage. wies:

Ancestor Posn. Justify i box
Left and right margins can be changed B © ot o
using a spin control at the extreme left Do « o

and right of this dialogue. Margins are
allocated in spacing of body size char-
acters.

The top margin above the title is allocated in lines of blank heading size font.

Page width is displayed, but has little meaning in PediTree, which calculates it
from the font size and page width instead.

Click OK to save changes or Cancel to return to the display without making
changes.

Tree Warning Message

waming x|

' &x25 layout too big -can "t calculate gens, strips using hp deskjet 930c series page 1673w x 2321h pixels
Reduce using Print menu | Report designs.. | Person tree WideTall
then adjust width or height

In a Wide Tree, PediTree divides up the printer page into boxes - generations
high, and strips wide. If the Layout width and height is too big, or the printer
page has too few pixels wide or high, then it gives zero generations or strips. (The
example above was produced by using a large font-size on A5 paper.)

Reduce the font size from the print menu, or use the main menu Print > Reports >
Person tree WideTall to reduce the width or height before trying again.
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Chapter 12 GEDCOM

A Introduction

GEDCOM is the data interchange standard devised by the Church of Jesus Christ
and the Latter Day Saints (LDS) for transferring data between different programs
for genealogy. GEDCOM files represent the information being transferred in text
lines that are identified by a numeric level and a 3—4 letter tag. However, each
program uses its own combination of levels and tags, thus causing some difficulty
in transfer.

Pedigree Software’s original technical database design was based on the then-cur-
rent version of GEDCOM. Pedigree for DOS implemented its own extensions to
this standard to handle long text fields. PediTree can handle GEDCOM version 4
files, including Pedigree’s extensions, for perfect exchange between Pedigree
Software databases.

GEDCOM version 5.5 is now in most common use and has some features that
cannot be implemented directly in Pedigree Software’s databases. However, this
version can be exported by PediTree from databases that have certain additional
picture scripts, such as those based on Elton55. It can be imported into PediTree
after conversion using the utility program GedUtils. Version 5.5 can also be pro-
duced from GEDCOM 4 files using the utility Ped-FHS.exe.

B Sample of a GEDCOM 4 File

Here are two fragments from a GEDCOM file, with the Person record for Alan
Roe and his Marriage record (GEDCOM uses INDI for Person and FAM for Mar-
riage):-

0 @Il1@ INDI Start of Person Record: RIN P1

1 SEX M

1 NAME Alan /Roe/ Forenames /Surname/

1 FAMC @F3@ Link to parents’ marriage

1 FAMS @Fl@ Link to Alan’s marriage (M1)

1 CHR Christening (Event group)

2 DATE 17 oct 1835

2 PLAC Slindon, Sussex

2 NOTE Christening: source, parish register at West Sussex

Record office
DEAT Death (Event group)
DATE 14 may 1910
PLAC Brighton
EDUC Brighton Grammar school
occu Occupation group
TITL farmer
PLAC worthing
FROM 1862

@F1@ FAM Alan’s marriage record: RIN M1

O NNNR RENNR
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1 HusSB @I1l@ Link to Alan’s Person record

1 WIFE @I2@ Link to his wife’s Person record
1 CHIL @I3@ Links to 3 children

1 CHIL @Is@

1l CHIL @I4@

1 MARR Marriage (Event group)

2 DATE 17 Jun 1862

2 PLAC Slindon, Sussex

Each line starts with the level, followed by the tag. Each record starts at level 0,
with the @crossreference@ preceding the tag. Fields within the record are at
level 1, group fields at level 2. Links (GEDCOM calls them pointers) are
enclosed in @..@. The PediTree forenames and surname fields are combined into
one field with the tag NAME. The note in Christening has been wrapped above;
in the GEDCOM file it would be on one line. The shorthand way to refer to this
field by the GEDCOM tags would be INDI.CHR.NOTE (level-0 tag. level-1
tag.level-2 tag). In GEDCOM 4 you can have fields at level 3 with the tag CONT
that simply continue the preceding level-2 field.

C GEDCOM version 5.5

This standard changed some of the 3—4 letter tags that identify each field being
transferred; Pedigree Software used some non-standard tags anyway. It also
allows a deeper structure of the data with level numbers for source citations that
are higher than Pedigree’s database can store. This brings difficulties with
importing version 5.5 files, but these are now addressed by PediTree’s GED-
COM import facilities.

Export to other Family History Systems

PediTree provides GEDCOM 5.5 export by using picture scripts named GED-
COM in the Person, Marriage and Source records. These in turn use other capital-
ised named scripts for Census records and other data groups. The Elton55
database includes these scripts.

To convert your own database to Elton55 without problems, your database must
have been based on earlier Pedigree Software definitions called Families, Census
or Elton.

The GEDCOM 5.5 format has to be modified to satisfy other popular family his-
tory programs like Family Tree Maker (FTW) and Personal Ancestral File.
PediTree makes the following changes when exporting this version:

Prefixes in dates for occupations and residences are removed by PediTree.
The ‘from’ and ‘to” dates are exported in a single DATE BET tag without any
prefixes such as before, between and after.
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Quarter dates (Q1 Q2 Q3 Q4) are translated by PediTree into ABT FEB, ABT
MAY, ABT AUG, ABT NOV.

Links to RINs that are not in the export, especially if it is a partial export, are
not written to the file. This relies on the exact formatting of links such as:

2 SOUR @s-s001@

FTW and other programs may truncate text from fields like title, refnum and
education where it is too long. Dual dates may be rejected in months after
March, or years after 1752.

D GEDCOM Export

Export the Whole Database

For GEDCOM export of the whole database, choose File >Save As GEDCOM from
the main menu. If your database is based on Elton55, then you will be able to
choose the GEDCOM version to use:

GEDCOM 4 Pedigree for export to another Pedigree Software database.
GEDCOM 5.5 for export to other Family History Systems.

1. A standard Save As dialogue allows you to select the folder and give a
filename. You can choose to have PediTree remember the folder used for this
dialogue, rather than default to that containing your database folder: see chap-
ter 8 section J Options Dialogue. After making your choice, click on Save.

2. A message ‘Preserve RINs by mak- x|
i t fi letions?’ i
ll'lg empty I'CC.OI'dS or deletions?” is 0 Preserve RINs by making empty records for deletions?
displayed. Click Yes to keep the \]‘,)

empty records, No to omit them. On
subsequent import, RINs are allo-

cated sequentially from one; keep-
ing the empty records ensures that
the original RINs are preserved, otherwise records following a deletion will be
re-numbered. However, you will need to delete the empty records yourself
after importing the file.

Export a List

Alternatively, you may wish to export only part of your database, perhaps to send
relevant information to other people with unrelated branches omitted. PediTree
provides GEDCOM export of records in a list or plan, with related Person, Mar-
riage, Source and Census records included. For a Person list, the related records
may be parents, spouse(s) and adoptive parents’ Marriages; Sources for events,
occupations, residences; and Sources and Censuses directly linked to the Person.
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1 From a list, right-click and choose Save list text, GED... . You can then choose the
GEDCOM version, as described in the previous section.

2 A standard Save As dialogue allows you to select the folder and give a filename.
After making your choice, click on Save.

3 A message ‘Export all directly x|

linked records such as Sources?’ is

displayed. Click Yes to add linked j) Export all directly linked records such as Sources?
records to those in the list, No to
export the records in the list only.
For a Person, these may be parents,
spouses and adoptive parents’ Mar-
riages. For Marriages, these may be adopted children, and both spouses and
children; Sources for events, occupations and residences; and Sources and Cen-
suses linked directly from the Person. Exporting a plan will export all the peo-
ple and marriages in the plan, and their directly linked records mentioned
above. This may add another generation at the top and bottom of a plan.

Mo | Help |

To merge records from a number of different lists, you will need to use the facili-
ties provided by the utility program GedUltils version 7. In this case, choose
GEDCOM 4 Pedigree and export the records in the list only; GedUtils will add
the linked records. See the on-line help in GedUtils for further information.

E GEDCOM Import

GEDCOM import occurs in two stages. First, the file to be imported is read and
checked against the current database definition, to see that it matches. Secondly,
the actual import is performed, once any mismatches found in the first phase have
been resolved.

1 To start, choose File > Import > GEDCOM from the main menu.

2 A standard File Open dialogue will allow you to choose the folder and file to be
imported. You can choose to have PediTree remember the folder used for this
dialogue, rather than default to that containing your database folder: see Section
D above. The same folder is used for both exporting and importing GEDCOM
files.

The chosen file is read, with progress indication in the status line of the
PediTree display.

Note: there is a file named control.ged in every PediTree database folder.
Although this is in GEDCOM format, it contains the database definitions,
not the family information. Attempting to import this file will cause
chaos.

3 On completion, an Import display appears, as shown opposite, with a summary
of the file to be imported. There is a line for each record-type, showing the
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number of records, the resulting
RINSs if the import proceeds and the
number of unknown tags for that
record-type. It is possible to proceed
only if there are no unknown tags,
that is, tags not matched in the cur-
rent database definition. The Add
button is enabled only if there are no
unknowns and you are in Edit
(update) mode. The purpose of the
Save Actions and Load Actions but-
tons will be explained shortly.

GEDCOM Imy

Fecad Type

Cow.

port - LiechenSS.ged
Surenary | Fad | D1 | s0UR |

FAM
]
SOUR

£
6
105

|rins Urknowes
6100

NnNe 7
Mm 1

4 There is a separate tab for each

record-type that shows the details,

—_-

chosen by clicking on the tab label in
the usual way. There is a line for
each GEDCOM tag, with the tag
indented to show group-member-
ship. The data column indicates
whether this tag has no value (N),
has a value (V) or is a link (L) to
another record-type. The Count col-
umn shows the number of times this
tag occurs in the file. The Action
column depicts the way in which this
tag will be treated during import; see

Hdd I
Help I
9mm|
Finad complohe in (.05 seconds Load Actorst
Summary | FAM | INDI | sDUR]
Tag ata |Court [hetien =
DEAT N 107 desh
DATE v date
HOTE L FolesV
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SOUR (T source L
EDUC v 2 edhacaion V
FAML. L 2 paentsl
FAMS L 177 mesiagesl
HAME V205 dorenames, sumame =
HICK, v o8 rickname V' View data
HPFY v ox prefic ¥
HOTE A mtesV Edit Action
0L N 4 otcupaion
(=) v 42 [ occupston: eV Help
DATE v 4 femv
FROM Vo5 UNKNOWH
FLAC N 32 Ignone =

Fiead complete in 0,03 seconds

Actions below for more information.

5 After selecting a particular line by a click with the mouse, clicking the
View data button will display the information present in the records. Up to 50
entries are shown in a scrollable list, with the option to see more if required.
Text entries are truncated if too long to display. This view may help you to
decide what steps to take if the Action shown is UNKNOWN.

6 Clicking the Edit Action button brings up a dialogue that allows you to change
the Action(s) for this particular tag, as will be described. Alternatively, you
may wish to use some pre-defined Actions, which can be introduced by the
Load Actions button on the Summary tab.

7 Once all unknown Actions have been changed, then the Add button on the
Summary tab should be enabled. If not, you may need to change to the Edit
(update) mode, which you can do without leaving the Import display.
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8 Clicking the Add button will start the import of the file. If there already is
information in your database, you will be asked to confirm that you have a
back-up copy for safety.

Note: a failure during the import process may make your database unusable.
Be sure that you have a back-up copy before proceeding.

On confirmation, the import will proceed, with progress display as before. On
completion, the Summary tab will re-appear with a completion message and a
Finish button in place of the Add button.

9 Clicking the Finish button will close the Import display. Either List display(s)
of indexes or a Choose List dialogue will appear. If the completion message
mentioned errors, then the diagnostics display will appear to show them.

Date Processing

The GEDCOM tag DATE may be followed by a date range, such as

BET 1960 and 1977, which isn’t acceptable in PediTree date-type fields. Such
input is converted to two tags FROM and TO with one date in each. So you may
see all three tags DATE, FROM and TO in the record-type tab.

Actions

Actions describe how a particular tag will be treated on import. Each tag has 1-3
Actions associated with it; multiple Actions are shown separated by semicolons,
e.g. occupation; title V Here is a list of possible Actions, with their correspond-
ing representation in the record-type tabs:-

Ignore — this tag is ignored during import; representation Ignore

Copy data to new field — a new occurrence of the field is created and the infor-
mation with this tag is copied into it; representation, e.g. notes V

Copy text to new field — a new occurrence of the field is created and the given
text is copied into it; representation e.g. type "letter"

Start new group — a new occurrence of the group is created;
representation e.g. occupation

Start new record — this record-type tag is assigned to a given PediTree record-
type; representation, e.g. Census

Append data to existing field — the information from this tag is added to an
existing occurrence of the field, starting on a new line and prefixed by the
given text. If there is yet no field of this name, then one is created,;
representation, e.g. notes +''type" V

Unknown tag — tag not known, so action indeterminate;
representation UNKNOWN
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Name tag — the GEDCOM tag NAME holds both forenames and surname;
representation forenames, surname V

Some of these Actions will be automatically assigned when the GEDCOM file is
first read and the tags are compared to those in the current database. You can edit
the Action(s) (as mentioned in step 6 above) to remove Unknown entries and/or
change the way the file is imported.

Ed/tmg Actions
1 Click on the Edit Action button on a
record-type tab to bring up the Edit
Action dialogue. This example cor- .
responds to the line with the dotted oceupation. il
rectangle on the previous page,
which has two Actions.

Action Mode

Ignote
Copy Value to new field
Copy text to new field

Append Value to existing field

2 The individual Actions are shown in = Target Field

the List of Actions on the left. Other [occupation =
fields correspond to the highlighted Delete | Text

entry. |

3 Choose the Action mode from the
list. The available choices depend | oK | Cancel [ Help I
upon the context.

4 Where relevant, choose from the Target Field drop-down list. Again, the con-
tents of this list is context-related. If you are editing an Action for a record-
type (top line of the relevant tab), then this list will be labelled Record-types.

5 For Copy text ... or Append Value ..., enter the text or prefix in the Text box.

6 The Add and Delete buttons affect the List of Actions: respectively adding
another Action at the end of the list or deleting the chosen Action.

7 Click OK (or press Enter) to apply your edited Actions. If you change the
Actions for a group-head tag (such as OCCU in this example) or a record-head,
then the Actions for all subordinate tags will be changed to Ignore. So it is
best to start at the top of the record-type tab when editing Actions.

The example shown here is of editing one of two group-head tags (see the exam-
ple on page 113). In this situation, it is important that both group-head tags are
set to start the same group, as the record-type display doesn’t show which subor-
dinate tags follow which group-head.

After editing Actions on all tabs to remove Unknowns or otherwise, you may
wish to save your changes before proceeding. This may be done from the Sum-
mary tab, by clicking on the Save Actions button. A standard File Save dialogue
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will then allow you to choose a folder and filename for your actions. Actions are
saved with the file type .GIA (standing for GEDCOM Import Actions).

A number of files of Actions for particular imports are provided with PediTree.
See PediTree help for details.

Note: when you click the Add button, the current Actions are always saved in
file default.gia, overwriting any previous set. This file may be useful if
you report any problems with GEDCOM import to Pedigree Software.

F GedUtils Utility

GedUtils v7 provides a number of functions concerned with GEDCOM files,
especially the conversion of version 5.5 files for import into PediTree. GedUtils
uses a GEDCOM Conversion Parameter (.GCP) file to convert the old tags and
level structure into one that is suitable for a Pedigree Software database. These
GCP files can be tailored to suit import to Families, Census, Elton55 or any other
Pedigree Software database. The Fam55 database supplied with GedUtils, with
the G55toPed.GCP file, will enable import of virtually all tags in a file conform-
ing to the GEDCOM version 5.5 standard that is used by most major Genealogi-
cal Systems. Extracts from that Fam55 database could be imported to other
database designs, albeit with some data loss until more definitions are added.

One of GedUltils’s other functions is the analysis of the number and types of tags
in a GEDCOM file in order to assess whether any new definitions need to be
added to a database, or whether conversion is needed, as described above. It can
also combine a number of GEDCOM list exports into a single GEDCOM file.
See the on-line help for GedUtils for more information.
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Chapter 13 Appendices
A Shortcut keys

As an alternative to using a mouse/pointer, there are some functions that can be
performed from the keyboard. These shortcut keys vary depending on the type of
display. Generally, they are listed when you press F1 for help, but there are some
generic keys that you can try. See chapter 7 section D for keys used in the Edit
display.

Main menus - use Alt+ letter (e.g. Alt+F file)
menu items - press the letter that is underlined.
pop-up (right click) menu items - press the letter that is underlined.

In List windows, usually Ctrl will bring up the pop-up menu, from which a letter
will choose a menu item.

Home goes to the beginning and End to the end of the list.
Esc will usually close a display window.

Tab will usually move the cursor to another part (component) in a window, or
will move right between edit cells; Shift+tab will move left between cells.

Ctrl in list windows will pop-up a context menu (like right click).
Ctrl+tab will bring another window to the front.

F1 gives help on the current menu, item or window.

F4 toggles the Detail Box to full window and back. Esc closes it.
Ctrl+F4 closes the active window.

F8 from a list will choose that Person or Marriage for a new Family display, clos-
ing old ones.

F8 from the Family display will find that Person or Marriage in an index, creating
one if necessary.

F10 will toggle to select the first main menu (File) then left/right up/down can
select a menu item.

In some dialogues, like Choose No. of Generations, select RIN and the page
number on Print Preview, there is a spin button with up/down triangles that
respond to up/down cursor.

Dialogues generally - press the letter for a button if underlined

Open a database - up/ down, page up/down, Enter to select.
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Lists - up/down, page up/down, home/end.
Print previews for Trees, Charts, Tables, Reports, Detail Box:

Home or End go to left or right margin
Page up/down,
Ctrl+Home or Ctrl+End goes to extreme top or bottom

B Opening a Database 21
from a Windows Shortcut S —

Each Windows shortcut to PediTree

(on Desktop or in the Start menu) can e e
be arranged to open a database auto- -
. Targettype:  Application
matically.
Target location: PEDIGREE
1. Use Windows Explorer to find the Target: [C:\PEDIGREE\PEDITREE EXE Royall3ped
PediTree program file, press the
right mouse button and drag to the Tz [C-\PEDIGREE

Desktop. Release the button and

Shortcut key:  |Mone
choose Shortcut here. !

. Bun: I Nomal window j
2. Left-click (or press F2) and name
. Comment: I
the short-cut with your database
name. Find Target... | Change lcon... Advanced... |

3. Right-click, choose Properties, alter
the command line (target) to append
the path of the database you want to

open. 0K | Cancel | ey |

C PediTree Registration File

The file Pedigree.ENC is your Registration file, supplied when you order PediTree
(or Pedigree for DOS). To use PediTree to edit or print from databases of more
than 150 records, you must have been registered for PediTree, with a ‘w’ suffix to
your serial number or serial number >3200 and a date that is consistent with your
version of PediTree.

If you think that you are entitled to use PediTree but your opening name and
address does not contain a serial number like that, then from your latest Pedigree
Software disk, drag this file into your PediTree folder, or use the DOS command,

e.g.
XCOPY a:pedigree.enc c:\pedigree
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D Files used by PediTree

The following files in the main working folder (usually c:\pedigree) are essential
for PediTree to operate:

PediTree. EXE executable program

Ped32.DLL picture script support library

DB32.DLL database support library

Pedigree. ENC PediTree Registration file

PediTree. CHM on-line help dictionary

PediTree.css Style file for Web pages generated by the Web Output facility.

PedTree.INI stores PediTree option settings that are not particular to
one database, such as fonts, colours, hints and status-bar
settings, Chart width and lines on/off, Tree width, height,
justification and ancestor position. The last five database
names used are stored here.

PVsort. COM a version of RPsort by Robert Pirko which can be used for
merging place pick-lists.

PVsort. DOC Documentation for PVsort.
Optional files:

PLAC.LST This is a place pick-list, which can be created from your
own places by using List > Place picklist.

* CSA CSV Import Action files saved by the user.

* GIA GEDCOM Import Action files, supplied with PediTree

and/or saved by the user.
* WOP Web Output Parameter files saved by the user.

Each database has its own folder, with filetype .PED, .PDG, .PDH, .PDJ, .PDM.
These folders hold three files for each type of record. Those for the Person
record-type are:-

Person.DAT the data stored in a compact form
Person.IND an index by RIN into Person.DAT
Person.SPC a list of spaces free to place new or amended records.

Space in the .DAT file is allocated in chunks. The size of these chunks deter-
mines the maximum file size and is set by the database filetype, as follows:-

Filetype Chunk size Maximum file size (.DAT)
.PED 16 bytes 1Mb

.PDG 48 bytes 3Mb

.PDH 64 bytes 4Mb

.PDJ 96 bytes 6Mb ) Not accessible to
.PDM 144 bytes OMb ) Pedigree for DOS
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Each field takes two bytes, plus what you type, except dates that always take
three bytes. Empty fields take no space at all. Each record takes one or more
chunks, enough to accommodate all the information. On average, therefore, half
a chunk of space will be unused in each record. So it is sensible to use the small-
est chunk-size that will accommodate your information.

Two special files in each database:

Control.GED the data dictionary of records, groups and fields and their rela-
tionship structure with picture scripts, report, tables, chart and
tree layouts.

Note: this file does not contain any family information, so should not be
imported into a PediTree database (by GEDCOM import).

Lists. DAT  The RINSs for all current lists in the database.
Databases Supplied

Elton55 is an example database to exploit PediTree features in a way that should
not upset Pedigree for DOS. It can be the basis for your own databases. Elton was
an older version that lacks the option to export GEDCOM 5.5.

Elton55.exe is an application for recreating Elton55.

Royal03is an example database, for the tutorial in the Getting Started Guide v2,
which contains an example of the royal family. It does not contain Source and
Census records, and so should not be used for making a New DB for your own
family.

Royal03.exe is an application for recreating Royal03.

E Soundex

These notes are copied from
http://www.archives.gov/research _room/genealogy/census/soundex.html

Soundex is a coded surname (last name) index based on the way a surname

sounds rather than the way it is spelled. Surnames that sound the same, but are

spelled differently, like SMITH and SMYTH, have the same code and are filed
together. The soundex coding system was developed so that you can find a sur-
name even though it may have been recorded under various spellings.

Every soundex code consists of a letter and three numbers, such as W-252
(hyphen shown here for clarity). The letter is always the first letter of the sur-
name. The numbers are assigned to the remaining letters of the surname accord-
ing to the soundex coding guide below. Zeroes are added at the end if necessary
to produce a four-character code. Additional letters are disregarded.

Examples:
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Washington is coded W-252 (W, 2 for the S, 5 for the N, 2 for the G, remain-
ing letters disregarded).
Lee is coded L-000 (L, 000 added).

Soundex Coding Guide

Number Represents the Letters

1 B,F,P,V
2 CG,JKQSXZ
3 DT

4 L

5 MN

6 R

Disregard the letters A, E, I, O, U, H, W, and Y.
Additional Soundex Coding Rules

Names With Double Letters: if the surname has any double letters, they should
be treated as one letter. For example:

Gutierrez is coded G-362 (G, 3 for the T, 6 for the first R, second R ignored,
2 for the Z).

Names with Letters Side-by-Side that have the Same Soundex Code Number:
if the surname has different letters side-by-side that have the same number in the
soundex coding guide, they should be treated as one letter. Examples:

Pfister  is coded as P-236 (P, F ignored, 2 for the S, 3 for the T, 6 for the
R).

Jackson is coded as J-250 (J, 2 for the C, K ignored, S ignored, 5 for the N,
0 added).

Tymczak is coded as T-522 (T, 5 for the M, 2 for the C, Z ignored, 2 for the
K). Since the vowel ‘A’ separates the Z and K, the K is coded.

Names with Prefixes (PediTree requires spacing like De Gaulle): if a surname
has a prefix, such as Van, Con, De, Di, La, or Le, code both with and without the
prefix because the surname might be listed under either code. Note, however, that
Mc and Mac are not considered prefixes.

For example, VanDeusen might be coded two ways:
V-532 (V, 5 for N, 3 for D, 2 for S)
or in PediTree if spelt Van Deusen

D-250 (D, 2 for the S, 5 for the N, 0 added).
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Consonant Separators: if a vowel (A, E, I, O, U) separates two consonants that
have the same Soundex code, the consonant to the right of the vowel is coded.
Example:

Tymezak is coded as T-522 (T, 5 for the M, 2 for the C, Z ignored (see ‘Side-
by-Side’ rule above), 2 for the K). Since the vowel ‘A’ separates
the Z and K, the K is coded.

If “H’ or “W’ separate two consonants that have the same Soundex code, the con-
sonant to the right of the vowel is not coded. Example:

Ashceraft is coded A-261 (A, 2 for the S, C ignored, 6 for the R, 1 for the F).
It is not coded A-226.

PediTree’s Use of Soundex
PediTree can use Soundex in two ways.

1. Prefix a field name with § symbol to use it as index or sort key or show the
code in a picture script - $surname gives A261 for Ashcraft

2. Use the comparison ‘like’ to compare the Soundex codes of two variables
without prefixing either - surname like “Smith”

F Limits in PediTree and Pedigree
0-20 children in a family (per Marriage)
1 or 2 spouses in a Marriage
0-10 Marriages per Person

40 generations in a tree, with 5000 people nodes in a plan (but no limit in the
database)

8000 strips in a Tall Tree
20 Databases (families.PED) in a folder for Pedigree (PediTree unlimited)

In Pedigree for DOS, use Change Directory from the file menu to go to another
folder, which can contain a further 20 databases. Database names cannot be more
than 8 characters (letters, numbers, -).

255 characters in a line of

data.TXT (comma separated values)

CONTROL.GED (filters, pictures, report width)

family. GED (GEDCOM input/output file)

printer.PRN (only 30 characters in a Pedigree printer sequence, 25 in

seq. desc, 15 sequences, 20 synonyms)

7 Record-types
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32,767 records per file. DAT (each file contains one type of record)

1 Mb/file for .PED databases

3 Mb/file for .PDG databases

4 Mb/file for .PDH databases

6 Mb/file for .PDJ databases (not Pedigree)
9 Mb/file for .PDM databases (not Pedigree)

50 Fields for each record-type

15 letters in a field name
10 fields in a group
255 characters in a text field
4090 characters in a longtext field
dates between 100 AD and 2100 AD
21 max. characters in a date edit, e.g. bef. 11 Mar 1699/1700
8 choice types ; PediTree /Pedigree have a limit of
17 different choice words (like M,F for sex) for each of the 8 choice types.

35 picture scripts for each record type or group

12 letters in picture script name
5 characters in a separator in Pedigree, but up to 12 in PediTree.
6 edit panels in a database

60 characters in a print title, heading
20 Tables (total for all record types)

30 characters in column heading
15 columns

20 Reports (total for all record types)

20 Lists of records or tree plan positions (26 temporarily in PediTree)

G Messages

Information messages x|
These are either simple informatory boxes OB i e

or slight errors that you should be aware of
and possibly take some action. Here is an
example.

Other possible messages are:-

Bad date 29/2/1823 in Person 1234 Pedigree allowed the entry of 29th February
in non-leap years. This is the most likely cause of this error where the date is
shown in this Windows default form.
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No family known for PIN <number> A Descendants chart or plan cannot be
made unless this Person has a partner.

No parents known for PIN <number> An Ancestors plan or chart cannot be
made unless this Person’s parents are recorded.

Warning messages

These are generally not so serious as to [ GGG x|
abandon your session. Press F1 when y\  Some pictre sopt erors were found, _
I Use Options (Alt-+0) Pictures to correct them, and save them on dosing DB

they occur to get help. Don’t worry if
the cursor is still an hour glass - just
click it. For example:

1w |

Some picture script errors were found the user has probably omitted or made a
mistake in one or more picture scripts in a group, record, table, report, chart or
tree. Go to Options > Picture scripts where the errors will be listed. Each error
will have the record name, type of script, name of report and column or area or
script name.

<number> result resources reset in <picture script> an error has caused
PediTree to reset its complex hierarchical stack of results from picture scripts
and fetching fields from the database. This should not occur, but if frequent,
please inform Pedigree Software with a note of where it happened.

<here> <word> unrecognised type in <name>

<here> <word> unrecognised field in <name>

<here> <word> unrecognised picture script for <name> at the point in the
program called <here>, a <word> in a picture script has not been recognised as a
Field Type or field name or picture script in a <name> of group or record. You
must correct it to make the picture script work. Use one of the names listed in the
definitions of the group or record.

<here>:Too many dotted variables = <word.word> at the point in the program
called <here>, too many words (more than seven) have been joined together by
full stops to make a hierarchical field name within a group and record and linked
records.

List Dialogue -No records, so no list to display yet an index has been created
ready to receive records.

List Dialogue - Delete list <number> this is just for you to confirm which list is
to be deleted. All displays using this list will be closed.

List Dialogue-Incomplete key <number> this key number must not end with a
group or record link and a full stop. Choose an elementary field.
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Invalid in findRIN in trying to find a record, PediTree thinks that the record is
not in the proper internal format. Try exporting the database in Pedigree into a
GEDCOM file to see if there is a corrupted record. If so, then send a copy of the
database to Pedigree Software with a note of which record gave this message. If
sending by e-mail, ask first if the message will be more than 200Kb.

List Dialogue -Have you closed the DOS window? in large databases, the exter-
nal file sort uses a DOS window to run pvsort.com. Please close it, so that
PediTree can continue.

Cannot insert a line this is likely to be caused if you have Diagnostics ON for
too long. Report it to Pedigree Software

When opening or closing a database, a message box may report inconsistent
index sizes in a list, compared with the number of records of that type, such as

Index 4 =97, should be 99
Index 5 =97, should be 99
Do you want this fixed now?

Answer Y for yes to allow PediTree to try to correct the index(es).

Error messages
Geperally this type of message box is showr} when a Pedinl x|
serious error has occurred which may result in loss of
recent data that you have entered in this session with _

. . .. File not found.
PediTree. If you have any other Windows applications

which are open, close them to save their results, before
returning to PediTree.

Please note whether the failure was in PediView.exe,
PediTree.exe or in Ped32.DLL or DB32.DLL. If no heading then it is likely to be
a DLL. Ifyou can repeat the fault, do not click the error box before clicking the
main help menu item Help > diagnostics and save the log to a file for emailing to
Pedigree Software.

You may continue cautiously, but first (if you can) finish all other open applica-
tions. You will have to click a blank part of the window in order to clear the hour-
glass cursor. Then click a line to cause a new Detail box display so that PediTree
can clear its result resources.

Maximum file size exceeded one of the Person, Marriage... .DAT files has
exceeded the size limit (1Mb limit for .ped databases or a higher limit for another
type). See Diagnostics for the starting sizes in this session.

You need to move to a larger size-format, so proceed as follows:-
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1. Back-up this database, then reopen it, and use File > GEDCOM Export > GED-
COM 4.

2. Use File > New DB and choose a bigger size format.

3. Switch to Edit mode, then File >GEDCOM Import to import the GEDCOM file
exported in step 1.

4. Check that no errors have occurred and that the new database appears to con-
tain all your information. Keep the old one until you are satisfied.

Pedigree.ENC user registration is invalid PediTree checks that your serial
number, name and address are in a valid encoded file that should not be tampered
with.

Cannot find Pedigree.ENC user registration PediTree will look for this file in
the starting folder. See section C above.

illegal Fpos <number>Xrectypes

RecLength <number> not equal <number> final field

No picture for Fetch

<here> NameToken ft = <number>

<here>:CondType =<words> at the point in the program called <here>, a sym-
bol has not been recognised. Make a note of this message to inform Pedigree
Software.

GetBuffer. RIN 98 inconsistent for record type 4, RIN 99 this means that a
Census record (type 4) RIN 99 is corrupt. Pedigree Software’s Database Utilities
program can be used to correct the error, by erasing the faulty record.

Alternatively, they ask you to send your database for correction. Never send your
database, by email or otherwise, without first asking for advice.

Run-time error codes
Certain errors at run time cause the program to display an error message and may
terminate:

Run-time error nnn at XXXXXXXxX

where nnn is the run-time error number, and xxxxxxxx is the run-time error
address..

The run-time errors are divided into three categories:

Input/Output errors, numbered 100 through 149
fatal errors, numbered 200 through 255
Operating system errors
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Most of these will be beyond your control, except possibly for a few input/output
erTors: -

100 Disk read error I ———— ,,.,,mwﬂ
101 Disk write error hardware ) e

problems, or disk full. Use .

scandisk to check.
105 File not open for output. Could be open in another program, or Read-

only (possibly copied from a CDROM). See the Getting Started Guide
for a method of removing the read-only attribute

Shown in Pedigree as DOS error 5.
H PediTree Shortcomings

Pedigree still has to be used to overcome the following shortcomings of PediTree
(as at March 2011).

Printed Reports
Report areas sizes and background cannot be altered in PediTree yet. Picture
scripts can be changed.

J Differences from Pedigree for DOS

PediTree has been designed to be as compatible as possible with Pedigree for
DOS, but there are differences in order to take advantage of Windows facilities
and upgrade the Pedigree language features.

Little attempt has been made to retain keyboard compatibility because of the fun-
damental nature of the change to mouse operation. The following are the main
differences:

Lines of Descent
This is not implemented in the same way, but in two different ways.

If you just want the spouses in direct ancestry, then make a descendants plan for
maximum generations for the ancestor that you would have marked in Pedigree

line of descent. Find the person that you would have used as the descendant for
the line in the plan list, noting their plan letter and generation number.

Make an ancestors plan with the FamilyDescent selecting the plan letter and gen-
erations noted. If there is more than one line of descent, then each will be shown
with the blood line in red.

If you want the siblings in all the families in the descent, then make a full ances-
tors plan for the descendant with maximum number of generations. Find the
ancestor in the plan list, noting their plan letter and generation. Subtract this gen-
eration from the base number shown at the top of the ancestor plan or with a
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colon : in the choose list Then make a descendants plan with this number of gen-
erations using the letter chosen in the Family Descent combi-box.

RINs prefixed

PediTree will always prefix RINs by the first letter of the record type name such
as P for Person and M for Marriage The number will be padded out to the maxi-
mum size for that type of record with leading zeroes. Remember to extend
Report area sizes to cope with a RIN field of 6 characters.

EDIT Panels and PLAN Picture Script Names

PediTree prefixes edit panel names by EDIT and Plan picture script names by
PLAN. As the overall size of name must not exceed 15, these names must not
exceed 11 letters.

Editing Mode
PediTree has to be put into Edit mode.

F9 or Ctrl+S replace F10 to save. This saves all changes since the last save, not
just those in one record.

Esc to Undo, also undoes all changes since the last committed save.

Sorting a List
Note that Pedigree does not create a new list whereas PediTree does (Pedigree
sorts the one selected.)

Differences from Pedigree Trees
Multiple marriages are shown with double lines joining each repeated descendant
to highlight the subsequent marriages and families.

In Ancestor trees, where a spouse is not known, PediTree plans will omit the
spouse line completely. Pedigree plans will show the same spouse repeated.

PediTree will use proportionally-spaced fonts to fit more characters in a line than
the nominally-specified width.

PediTree will try to use the full page width/height by equally spacing out boxes
within the paper size, instead of leaving space at the edge of the page.

The colour and width of lines above and below people can be changed with Tree
Line Style changes.

In Tall Trees, each row/strip of boxes must be kept on one page and will not be
split over pages like Pedigree. These lines go halfway across boxes and will not
continue if there are no more descendants or ancestors.
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Picture Script Features
The main changes will reject ‘contain’ instead of ‘contains’ and too many ‘end’
statements.

Although they are accepted, (Round brackets) cannot be used to denote associa-
tion of AND or OR conditions in condition statements.

PediTree has added some features to the picture script usage without affecting
Pedigree for DOS, where they should have no visible effect on results:-

‘childNumber’ for Person and ‘marriageNumber’ for Marriage can be used in any
screen display, report or chart.

For example insert at the beginning of Person partners picture script,

nn

childnumber ".
and the children will be numbered.

Marriage number will be shown for the last person found (normally one of the
spouses) in the particular Marriage being shown.

Other differences from Pedigree [ square brackets must contain a variable ]

There is one feature that Pedigree accepts, but I don’t intend to accept in
PediTree.

The use of [ square brackets ] is intended to ensure that "literally fixed text" is
only shown if there is some variable field present in the same brackets like

[|"b." normal(birth) ]
PediTree will not produce any output unless there is some field to print.

[ if birth present then |" b." end] will not produce anything even if birth is
present because there was no variable data to be printed from within the brackets.

[ if birth present then | " b." birth.date end] would be OK, but the ‘if birth
present’ and ‘end’ are redundant. Even if there was another field present in birth,
such as place, the text would not be shown unless the field birth.date was present.

Foreign Characters

Foreign characters with accent symbols above or below were accepted in the
DOS version of Pedigree but will be shown differently in PediTree Windows
ANSI fonts. On the whole they will be treated just like any other alphabetic char-
acters, but as yet, there is no provision for consistent displays with DOS IBM PC
characters nor with GEDCOM files. This applies equally to £ symbols or other
ASCII values above 128 or below 32.
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K Advantages over Pedigree for DOS

Established users of Pedigree for DOS have asked what benefits PediTree has
over the tried and trusted Pedigree. Most of the good Pedigree features are incor-
porated, but here are some of the extra facilities.

Printing

1. Printing using Windows-only printers.

2. Small fonts to get trees, tables and charts on fewer pages. Odd/even page
printing.

3. Choice of fonts and colours, with background lines or blood lines in a different
colour.

4. Printing of photographs incorporated into reports and trees.

Picture Scripts
1. Testing of individual scripts and diagnostics to show where they are used in the
resulting text.

2. Childnumber shown in Detail Boxes and reports.

3. Ages calculated at a point in time or at an individual's events. Day of the week
format option.

Record and File Linking
1. Hypertext jumping to linked records using “RINs.

2. Much quicker following of links (hypertext or in edit/grids):
e.g. from Person-Source-Census-Person.

3. Two-way updating of links (Person-Census, Census-Source)

4. Hypertext links to image file displays and sound.

5. Optional date & time stamping of records updated.

Saving Information
1. GEDCOM Export in version 5.5.

2. Tables can be saved in tab-delimited, CSV and RTF formats.
Multiple Windows and Lists

1. Many concurrent windows open to compare data from the same or different
record type.

2. Switching windows concurrently open to review lists, data detail whilst pre-
viewing a print.

3. Statistics on number of people at each chart generation.
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4. Lists open at current record.

5. Indexes made on the first field present in one key with several fields, such as
birth.date christening.date death.date

6. Selected list of chronological individuals’ events, occupations and residences.

7. Complete, or selected, alphabetical listing of place names mentioned on events
as above, making a de-duplicated pick-list for use when editing.

Print Previews
1. WYSIWYG page displays to show exactly what would appear on each page of
trees, charts and tables.

2. Selective page reprinting of trees, charts and tables.
3. Overall wide and tall tree preview diagram.

4. Prevention of widowed and orphaned parts of records at the foot and top of
tables.

Trees
1. Double lines connecting multiple marriages

2. Tree Line Style changes for blood lines of your ancestors or dashed lines for
illegitimate children.

3. Family descent and ascent trees limited by another plan, usually a blood line,
to show only siblings of ancestors, not all collateral lines.

Editing

1. Global search for text in any text field, or restricted to records in a list.

2. Global find and replace text in any text field, or restricted to records in a list
3. Rearrange the sequence of children in a family, using drag and drop.

4. Warning of incorrect birth/christening sequence.

5. Pick place names from your own pick-list. Pick-lists for Choice fields.

Definition changes
1. Rearrange order of fields in an empty database.

2. Insert a new field in an empty database.
3. Default brief and detailBox picture scripts.
4. New Jumbo and Massive database types with 6 or 9 Mb file sizes.
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Action, See: GEDCOM, import ac-
tion
add
child, 52
field, 61
marriage, 52
person, 51
record, 58, 82
adoption, 23
age now, 42
age then, 42
Ancestors chart, 109
create, 100
Ancestors plan, 87
create, 83
restricted, 88
authorship rectangle, 113, 116, 124
back-up
database, 105
GEDCOM, 81
Census record, 14
using, 26
Changed group, 14, 29
changing
choice-type words, 19
field names, 18
group-type names, 18
record-type names, 18
common law, 23
CSV, 73
file, 73
import, 73
import, using, 75
database, 8, 11
back-up, 81
check, 71, 76
check dates, 72, 77
check files linked, 72, 77
check free space, 77
close, 71
create new, 73
definitions list, 16, 102
field types, 12
fields, 12
mandatory fields, 16

Index

more than one, 20
move to another size-format, 142
new, 72, 73
open, 72
open from Windows shortcut, 135
quit, 71
save as GEDCOM, 71
save definitions, 71
single, 20
splitting, 94
storage, 15
database design
Census, 15
changing, 16
Elton55, 11
Fam55, 15
Families, 15
Royal03, 11
date check
tutorial, 78
dates
check, 77
editing, 63
definitions
database, 16
delete
field, 62
marriage, 52
person, 52
record, 58
Descendants chart, 109
create, 100
Descendants plan, 87
create, 83
restricted, 87
detach person, 51
Detail Box, 53
filenames, 53
hot links, 53
zoom, 53
diagnostics
log, 108
log on/off, 108
edit
+ mark, 60
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¢ mark, 60
choice-field, 63
context menu, 61
dates, 63
Detail grid, 68
Edit display, 60
Edit panel change, 66
Edit panels, 65
field editing, 61
GEDCOM import actions, 132
keyboard use, 67
links, 65
longtext, 63
object file field, 64
place, 64
record, 82
Record grid, 67
replace text, 68
save, 61
text, 63
Text display, 62
Edit
validation, 63
Edit mode, 82
Event group, 14
date, 27
notes, 27
place, 27
using, 27
exit PediTree, 72
expressions
complex comparisons, 38
date comparisons, 38
simple comparisons, 36
useful filters, 39

family
select new, 82
start new, 83

Family display, 49
multiple marriages, 50
field
append, 61
names, 12, 14
repeated, 13, 62
field type
choice, 13
date, 13
group, 13

link, 13
longtext, 13
text, 13
files
default.gia, 133
PediTree, 136
find
current record in index, 84
text, 91
fonts, 101
GEDCOM, 126
automatic back-up, 81, 105
export list, 128
export whole database, 128
import, 129
import action, 130
import action unknown, 130
import dates, 131
import display, 129
sample version 4 file, 126
tag, 12
use last folder, 105
version 5.5, 127
GedUtils utility, 133
Getting Started Guide, 8
help, 10
hot link, 45, 53
character, 103
images
in Report, 121
in wide Trees, 123
index
automatic repair, 87
check ordering, 77
create, 85
new, 83
out of date, 83
standard ones, 86
insert
field, 61
Islands
deleting, 95
relationship, 92
using, 92
Kennedy, Murray, 10
keyboard
editing with, 67
keyboard short-cuts, 134



link field, 13

edit, 65
place, 62

list

choose, 83, 84
dates, 83, 88
erase, 83
places, 83, 89

List display, 54

Ancestors plan, 54
dates, 55
Descendants plan, 54
draw Report, 57
draw Table, 58

draw Tree, 57

filled list, 54

filter, 57, 58

find, 56

index, 54

places, 54

save as text or GEDCOM, 56

Index

Pedigree Software, 10
Pedigree Users Group, 10
PediTree
advantages over Pedigree for DOS,
147
databases supplied, 137
differences from Pedigree for DOS,
144
files, 136
installation, 8
limits, 139
registration file, 135
shortcomings, 144
PedSpecs, 48
Person record, 12
using, 20
pick file, 62
pick-list, 62
place-name, 90
picture script, 30
# (field count), 32

sort, 57

text (Find or Replace), 55
mark person, 51, 55
Marriage record, 12

using, 22
messages

error, 142

information, 140

warning, 141
move

child, 52

marriage, 52
MS-DOS prompt, 72
Object group, 14, 28
Occupation group, 14, 28
options

always edit, 105

century, 105

date formats, 104

date prefixes, 104

dialogue, 103

display, 106

hints persist, 105

list paging, 105

number of windows, 105

tiled, 105

today for {now aged}, 103

$ (Soundex), 32
BORN, 35

call (), 32
changing, 102
child, 35
components, 31
conditional phrase, 32
descendant, 31
detailBox, 35
editor, 45
errors, 47
familyMar, 35
field-names, 31
GEDCOM, 35
if-statement, 32
LineDown, 40
LineUp, 40
links, 35, 44
list, 35

literal text, 32
marked, 35
parent, 35
reserved names, 35
separator, 33
spaces, 33
spouse, 31
treemarriage, 31
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validate, 63 RTF
variables, 33 save Table as, 117
| (new line), 32 save changes, 61
picture script variable short-cut keys, 134
childnumber, 34 Soundex, 137
descendant, 34 in picture script, 32
father, 34 Source record, 14
generation, 34 for letters, 25
marriagenumber, 34 using, 24
mother, 34 Sources
showrins, 34 multiple citation, 25
spouse, 34 swiping, 53
spouses, 34 Table
strip, 34 authorship rectangle, 116
today, 33 create new, 116
treemarriage, 34 design, 118
treeref, 34 draw, 58, 115
place grid, 116, 119
person, 52 layout changes, 118
pick-list, 90 save as image or text, 117
select pick-list, 106 tag, See: GEDCOM, tag
printing, 113 text
a window, 72 display, 62
Detail Box, 51, 57 edit, 63
print dialogue, 113 find, 84, 91
printing dialogue, 113 repeat, 62
set up paper, 100 replace, 68
tips, 101 toolbar, 9
record button, 54, 71, 72, 82, 84, 100, 106,
insert, 58 109
Record-type date, 104
Census, 14 Tree
limits, 140 layout dialogue, 125
Marriage, 12 tall, 122
Person, 12 warning message, 125
Source, 14 wide, 122
Records and RINs, 12 truncation character, 103
relationship calculator, 83, 88 tutorials, 8
Report types of record, 11
design, 121 typography, 9
report variables, See: picture script, variables
designs summary, 100 View mode, 82
Report Web output, 95
draw, 120 charts, 96
Residence group, 14, 28 dialogue, 97
RINs, 12 person pages, 96
show current, 108 viewing, 99

shown or not, 103

152



	Contents
	Chapter 1  Introduction
	About this Manual
	Reading this Manual
	Getting Help
	Contacting Pedigree Software
	Pedigree Users Group


	Chapter 2 Family History Databases
	Introduction
	Types of Record
	Records and RINs
	Fields
	Field Types
	Group Fields
	Storage

	Database Designs
	Changing Database Designs
	Definitions List Dialogue
	Changing Record-type Names
	Changing Group-type Names
	Changing Field Names and Tags
	Changing Choice-type Words


	Chapter 3 Using the Databases
	User Databases
	Using the Elton55 Design
	Person Record
	Marriage Record
	Source Record
	Using Source Records
	Multiple Source Citations from Group Fields
	Census Record
	Event Group
	Occupation Group
	Residence Group
	Object Group
	Changed Group


	Chapter 4  Picture Scripts and Expressions
	Picture Scripts
	Picture Script Components
	Variables
	Reserved Picture Script Names

	Conditional Expressions
	Simple Comparisons
	Complex comparisons - AND OR NOT
	Date Comparisons

	Useful Filters
	Person or Marriage Lists
	Person Lists
	Marriage Lists
	Source Lists

	Tree Line-style Changes
	Age Picture Scripts
	Age Now
	Age Then

	Links picture script
	Person Links
	Marriage Links
	Source Links
	Census Links

	Hot Links
	Picture Script Editor
	Picture Script Errors
	Picture Script Name Changes or Additions
	PedSpecs Utility Program

	Chapter 5  Family Display and Detail Box
	Using the Family Display
	Several Marriages

	Family Pop-up menu
	Edit Mode

	Family Updating when in Edit mode
	Detail Box
	Hot Links


	Chapter 6  List Display
	Types of List
	List Pop-up Menu
	Filtered Searches
	Filter Examples


	Chapter 7  Editing Records
	Edit Display
	Field Editing
	Edit Display Pop-up Menu
	Text Display
	Validation

	Editing Specific Field Types
	Choice Fields
	Text
	Long Text
	Dates
	Object File Field
	Place Fields
	Link Fields

	Edit Panels
	Change Edit Panels Dialogue

	Using the Keyboard
	Record Grid
	Detail Grid

	Replace Text

	Chapter 8 Main Menu Choices and Functions
	File Menu Choices
	File Menu Functions
	Open a Database
	New Database
	CSV Import
	Check Database
	Check Files Linked
	Date Check Facility
	GEDCOM Back-up

	Edit Menu Choices
	List Menu Choices
	List Menu Functions
	Choose List Dialogue
	Index Create
	Automatic Index Repair
	Create Descendants or Ancestors Plan
	Calculate Relationship
	List Dates
	List Places
	Place-name Pick-list
	Merging Place-name Lists
	Find Text
	Relationship Islands
	Web Output

	Print Menu Choices
	Print Menu Functions
	Set-up Paper
	Fonts

	Options Menu Choices
	Timing of changes

	Options Menu Functions
	Options Dialogue

	Window Menu Choices
	Help Menu Choices
	Diagnostic log example


	Chapter 9  Charts and Printing
	Ancestors and Descendant Charts
	Preview and Print  Charts

	Printing

	Chapter 10  Tables and Reports
	Draw Table
	Save as Text or Image
	Table Design
	Table Layout Changes
	Table Grid

	Draw Report
	Report Design


	Chapter 11  Trees
	Layout Dialogue

	Chapter 12  GEDCOM
	Introduction
	Sample of a GEDCOM 4 File
	GEDCOM version 5.5
	Export to other Family History Systems

	GEDCOM Export
	Export the Whole Database
	Export a List

	GEDCOM Import
	Date Processing
	Actions
	Editing Actions

	GedUtils Utility

	Chapter 13  Appendices
	Shortcut keys
	Opening a Database from a Windows Shortcut
	PediTree Registration File
	Files used by PediTree
	Databases Supplied

	Soundex
	Soundex Coding Guide
	PediTree's Use of Soundex

	Limits in PediTree and Pedigree
	Messages
	Information messages
	Warning messages
	Error messages
	Run-time error codes

	PediTree Shortcomings
	Printed Reports

	Differences from Pedigree for DOS
	Lines of Descent
	RINs prefixed
	EDIT Panels and PLAN Picture Script Names
	Editing Mode
	Sorting a List
	Differences from Pedigree Trees
	Picture Script Features
	Foreign Characters

	Advantages over Pedigree for DOS
	Printing
	Picture Scripts
	Record and File Linking
	Saving Information
	Multiple Windows and Lists
	Print Previews
	Trees
	Editing
	Definition changes


	Index

